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6.9.5. It does not apply to earlier software versions. Due to continuing product innovation, specifications in this 
manual are subject to change without notice.

† Mac-Lab, CardioLab, Centricity, CardioICE, DASH, Innova, Solar, TRAM, TRAMNet, TRAM-RAC and Vivid are 
all trademarks of GE Healthcare companies.

†† All third party trademarks are the property of their respective owner.

Micropace digital stimulators are sold by GE Healthcare for Micropace EP Inc.

GE Healthcare, a division of General Electric Company

GE and the GE Monogram are trademarks of General Electric Company.

The document number and revision appear on the bottom of each page. The following table outlines the changes 
applied with each revision.

Revision Date Comment

A 15 August 2012 Internal release.

B 22 August 2012 Initial public release.

C 21 January 2013 Updated with serviceability improvements.

D 2 April 2013 Updated to distinguish between US and non-US system compliance.

E 7 May 2013 Updated to include installation and troubleshooting procedures for the Matrox Quad video 
board.

F 18 November 2013 Updated to include information for new speakers.

G 20 June 2014 Updated to include information for EIZO monitors and new desk part numbers. Updated part 
numbers for RoHS compliance.

H 30 July 2014 Updated to include new IEB power cord compliance information and part numbers.
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Introduction
Manual Information

Purpose

This manual contains the instructions necessary to operate and service the Mac-Lab/CardioLab 
and/or Centricity Cardiology INW system safely in accordance with its function and intended use. 
These instructions include but are not limited to:

 Describing fundamental controls and indicators

 Operating procedures

 Connecting and disconnecting detachable parts and accessories

 Troubleshooting and service procedures

Product References

The name of the product described in this manual is Mac-Lab/CardioLab. It will also be referred to 
as “the system” throughout this manual.

Intended Audience

This manual is written for trained GE Healthcare Field Service Engineers and hospital Biomedical 
Technicians who use, maintain, troubleshoot, and service the Mac-Lab/CardioLab system. Service 
professionals are expected to have a working knowledge of appropriate medical, electrical, and 
mechanical procedures, practices and terminology used in the service of the equipment.

Operators

 Operators can record and calculate cardiovascular data from pediatric or adult patients as they 
undergo cardiac catheterization. Cardiovascular data may be manually entered or acquired via 
interfaced GE Healthcare TRAM/PDM modules or other interfaced systems.

 The Mac-Lab/CardioLab operator requires training to become familiar with the capabilities and 
operations of the Mac-Lab/CardioLab system. The following training options are available:

 Classroom training at GE Healthcare Institute in Milwaukee, WI

 On-site customer training

 Video training via weblink
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System Administrator

 Coordinating the overall Mac-Lab/CardioLab system is the responsibility of the System 
Administrator. This person has access to additional system supervisory functions, including 
operational setup parameters, system backup functions, for example.

 The System Administrator is also responsible for monitoring and reporting system hardware 
and software problems using the procedures described in the Mac-Lab or CardioLab operator 
manual.

 The Mac-Lab/CardioLab System Administrator should be familiar with the Windows desktop 
and be fully trained on the Mac-Lab/CardioLab features and configuration settings.

NOTE: A System Administrative password is required to perform any of the previous 
administrative functions. 

 The Mac-Lab/CardioLab System Administrator requires training to become familiar with the 
capabilities and operations of the Mac-Lab/CardioLab system. The following training options 
are available:

 Classroom training at GE Healthcare Institute in Milwaukee, WI

 On-site customer training

Field Service Engineer

Diagnosing and correcting problems with the Mac-Lab/CardioLab system must be done by a 
trained GE Healthcare Field Service Engineer. Please refer system problems not covered in this 
manual to GE Healthcare Product Support.

Indications for Use

Types Of Systems

The following system names are used:

 Mac-Lab is a Hemodynamic Recording System.

 CardioLab is an Electrophysiology Recording System built on a common platform with 
Mac-Lab.

 ComboLab is a single system that contains the features of both the Mac-Lab and the 
CardioLab systems.

 SpecialsLab is a system with a subset of the features available on the Mac-Lab.
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Mac-Lab System

The Mac-Lab System is intended for acquiring, filtering, digitizing, amplifying, measuring and 
calculating, displaying, recording and monitoring of clinical data from adult and pediatric patients. 
Clinical data may include: ECG waveforms, heart rate, pulse oximetry (SpO2), respiration rate, 
CO2 (EtCO2), temperature, hemodynamic measures (for example, valve gradients and areas, 
cardiac output, shunts, Fractional Flow Reserve (FFR), invasive and noninvasive blood pressure). 
Physiology parameters such as diastolic, systolic, and mean pressures, and heart rate may be 
derived from the signal data, displayed and recorded. The data may be entered manually or 
acquired via interfaced devices and/or information systems and may be used for report generation.

Procedural information and optional anatomical and physiological imaging and data devices may 
be interfaced (for example, X-ray, ultrasound, patient monitors and information systems). The 
Mac-Lab System can display, store and annotate images previously acquired and stored by other 
systems. Data may be provided to other systems via multiple formats (for example, HL7, DICOM, 
Analog outputs). Data may be received from other devices via multiple formats (for example, 
DICOM, Analog inputs).

Optional accessories for hardware and software may include research tools to be used exclusively 
outside patient care settings. The purpose of the research tools is to assist researchers or 
clinicians in developing algorithms.

The Mac-Lab System does not have alarms, does not generate energy delivered to the patient, 
does not administer drugs and does not perform any life-supporting or life-sustaining functions. 
The Mac-Lab System is not intended for use on unattended patients, or in situations where 
diagnostic arrhythmia detection is required.

The Mac-Lab System provides the ability to transmit patient data for storage, analysis and viewing 
at distributed locations within a clinical facility via network connectivity. The Mac-Lab System may 
also function as a stand-alone device. The Mac-Lab System is used in a variety of hospital and 
clinical settings including interventional laboratories (for example, cardiac catheterization and 
radiology), operating room environments, and pre and post areas all under the direct supervision 
of licensed healthcare practitioners who are responsible for interpreting the data.

CardioLab System

The CardioLab System is intended for acquiring, filtering, digitizing, amplifying, measuring and 
calculating, displaying, recording and monitoring of clinical data from adult and pediatric patients. 
Clinical data may include: ECG waveforms, intracardiac signals, stimulus data, ablation data, 
pulse oximetry (SpO2), respiration rate, CO2 (EtCO2), temperature, and invasive and noninvasive 
blood pressure. Physiological parameters such as diastolic, systolic, and mean pressures, heart 
rate, and cycle length may be derived from the signal data, displayed and recorded. The data may 
be entered manually or acquired via interfaced devices and/or information systems and may be 
used for report generation.

Procedural information and optional anatomical and physiological imaging and data devices may 
be interfaced [for example, X-ray, ultrasound, mapping systems, ablation generators (for example, 
RF and cryogenic), simulators, patient monitors and information systems]. The CardioLab System 
can display, store and annotate images previously acquired and stored by other systems. Data 
may be provided to other systems via multiple formats (for example, HL7, DICOM, Analog 
outputs). Data may be received from other devices via multiple formats (for example, DICOM, 
Analog inputs).
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Optional accessories for hardware and software may include research tools to be used exclusively 
outside patient care settings. The purpose of the research tools is to assist researchers or 
clinicians in developing algorithms.

Optional accessories for hardware and software may also include a waveform simulator to be 
used exclusively outside patient care settings. The waveform simulator may be used for training, 
demonstration without a patient attached, and as a troubleshooting tool in the CardioLab System.

The CardioLab System does not have alarms, does not generate energy delivered to the patient, 
does not administer drugs and does not perform any life-supporting or life-sustaining functions. 
The CardioLab System is not intended for use on unattended patients, or in situations where 
diagnostic arrhythmia detection is required.

The CardioLab System provides the ability to transmit patient data for storage, analysis and 
viewing at distributed locations within a clinical facility via network connectivity. The CardioLab 
System may also function as a stand-alone device. The CardioLab System is used in a variety of 
hospital and clinical settings including interventional laboratories (for example, electrophysiology 
and cardiac catheterization), operating room environments, and pre and post areas all under the 
direct supervision of licensed healthcare practitioners who are responsible for interpreting the 
data.

ComboLab System

The ComboLab System is the combination of both the Mac-Lab and CardioLab Systems. The 
ComboLab System allows the user to run either the Mac-Lab System or the CardioLab System, 
although only one system may be used at a time. The ComboLab System executes the same 
software and runs on the same hardware in the same environments as the Mac-Lab and 
CardioLab Systems.

SpecialsLab System

The SpecialsLab System executes the same software and runs on the same hardware in the same 
environment as the Mac-Lab System. Products designated as a SpecialsLab System support 
fewer options than the Mac-Lab system.

Compliance

Non-US Mac-Lab/CardioLab systems comply with the following standards:

 IEC/EN 60601-1 3rd ed Medical Electrical Equipment, Part 1 General Requirements for Basic 
Safety and Essential Performance

 IEC/EN 60601-1 2nd ed Medical Electrical Equipment, Part 1 General Requirements for 
Safety

 IEC/EN 60601-1-1 Safety requirements for medical electrical systems

 IEC/EN 60601-1-2 Electromagnetic compatibility - Requirements and tests

 IEC/EN 60601-1-4 Programmable electrical medical systems

NOTE: Upgrade systems may not comply with IEC/EN 60601-1 3rd ed.
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US-only Mac-Lab/CardioLab systems comply with the following standards:

 IEC/EN 60601-1 2nd ed Medical Electrical Equipment, Part 1 General Requirements for 
Safety

 IEC/EN 60601-1-1 Safety requirements for medical electrical systems

 IEC/EN 60601-1-2 Electromagnetic compatibility - Requirements and tests

 IEC/EN 60601-1-4 Programmable electrical medical systems

Classification

This system is classified according to IEC 60601-1 as follows:
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IEB Class I N/A

Ordinary

 Not Suitable Continuous

CardioLab II Plus Amplifier:
Class I

 

CF Defib Proof ECG, IBP, IC ECG, Auxiliary

PDM Base Station Class I N/A

IPX1

PDM

ECG, IBP, SpO2, Temp, CO

NBP
Class II

CF Defib Proof

BF Defib Proof

TRAM-RAC Class I N/A

TRAM module:

Class II  CF Defib Proof

 BF Defib Proof
Ordinary

ECG, IBP, SpO2, Temp, CO

NBP

Capnostat Mainstream CO2 module N/A  BF

CapnoFlex CO2 module N/A  BF

Vivid Remote Trackball N/A N/A
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Introduction
Conventions

The following conventions are used throughout this manual.

Illustrations and Names

All illustrations in this manual are provided as examples only. They may not necessarily reflect the 
setup or the data on your system.

In this manual, all names appearing in examples and illustrations are fictitious. The use of any real 
person's name is purely coincidental.

Related Documents

Bold Indicates keys on the keyboard, text to be entered or hardware items such as buttons or switches 
on the equipment.

Italics Indicates software terms that identify menu items, buttons or options in various windows.

[Key1] + [Key2] Indicates a keyboard operation. A (+) sign between the names of two keys means press and hold 
the first key while pressing the second key once.

For example, “Press Ctrl + Esc” means to press and hold down the Ctrl key while pressing the Esc 
key.

Enter Press the “Enter” or “Return” key on the keyboard. Do not type “enter”.

Part Number Document

2063076-017 Invasive Workbench Operator’s Manual

2063076-001 Mac-Lab Operator’s Manual

2063076-002 CardioLab Operator’s Manual

2063076-003 Centricity Cardiology INW Operator’s Manual

2063076-004 Mac-Lab/CardioLab Security Guide

2063076-007 Mac-Lab/CardioLab/Centricity Cardiology INW Pre-Installation Manual

2063076-301 Mac-Lab Operator’s Manual - US-Only

2063076-302 CardioLab Operator’s Manual - US-Only

2063076-303 Centricity Cardiology INW Operator’s Manual - US-Only
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Safety Information

Read through the following safety information before putting the system into use. Disregarding 
information on safety is considered abnormal use.

The terms danger, warning and caution are used throughout this manual to point out hazards and 
to designate a degree or level of seriousness. 

Definitions

Hazard is defined as a source of potential injury to a person.

DANGER: IMMINENT DEATH OR SERIOUS INJURY

Danger messages indicate an imminently hazardous situation which, if not 
avoided, will result in death or serious injury.

WARNING: POTENTIAL DEATH OR SERIOUS INJURY

Warning messages indicate a potentially hazardous situation which, if not 
avoided, may result in death or serious injury.

CAUTION: POTENTIAL INJURY OR EQUIPMENT DAMAGE

Caution messages indicate a potentially hazardous situation which, if not 
avoided, may result in minor to moderate injury or equipment damage.

NOTE: Notes provide additional user information.

Prescription Device

CAUTION: SALE OF DEVICE

U.S. federal law restricts this device to sale by or on the order of a physician.
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General

WARNING: UNSUPERVISED USE

This device is intended for use under the direct supervision of a licensed 
health care practitioner.

WARNING: This system is designed to comply with the applicable IEC/EN 60601-1 series 
safety standards when connected and powered as specified. Connecting 
additional devices, parts or accessories that are not recommended by GE 
Healthcare could lead to a reduced level of safety. Refer to the Service Manual 
for equipment connection and service information. Contact GE Healthcare if 
questions arise.

WARNING: Before connecting supported interfaced devices to the system, ensure that the 
devices meet the requirements of the applicable IEC 60601 series safety 
standards and the system configuration meets the requirements of the IEC 
60601-1-1 medical electrical systems standard.

Applicable Messages

DANGER: EXPLOSION HAZARD

Using this equipment in the presence of flammable gasses (including 
anesthetics and oxygen) may cause an explosion or fire. Always use this 
equipment in a well ventilated area away from the presence of potentially 
flammable gasses.

WARNING: The use of unspecified accessories, transducers and cables may result in 
increased emissions or decreased immunity of the system.

WARNING: Use caution when cleaning the environment near equipment. Fluid ingress may 
damage devices or compromise electrical safety.
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WARNING: Modify equipment only as authorized by the manufacturer. After modifications, 
appropriate inspection and testing must be conducted to ensure continued 
safe use of the equipment.

WARNING: ELECTRICAL HAZARDS

Connect equipment only as specified in the cabling diagrams. Failure to do so 
may lead to increased electrical safety risk.

WARNING: ELECTRICAL HAZARD

Power equipment only as specified. Do not connect equipment to extension 
cords or multiple socket outlets.

WARNING: EQUIPMENT FAILURE

System components should not be used adjacent to or stacked with other 
equipment. If adjacent or stacked use is necessary, the system should be 
observed to verify normal operation in the configuration in which it will be 
used.

WARNING: EQUIPMENT HAZARD

Route cables through floor or ceiling conduit wherever possible. Ensure the 
fiber optic cable is protected from potential sources of damage.

WARNING: EQUIPMENT HAZARD

Do not attempt to service the UPS or replace the battery. Doing so could result 
in equipment damage. Contact qualified GE Service personnel for service or 
replacement.

WARNING: EXPLOSION HAZARD

Do not incinerate the UPS battery or store at high temperatures.
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WARNING: FALLING EQUIPMENT

Do not place the PDM more than 147 cm (58 in) from the floor when mounting 
on an IV pole with a base less than 58 cm (23 in) in diameter. This may cause 
the IV pole to tip over.

WARNING: FALLING EQUIPMENT

Monitor suspension systems other than the Mavig GD60 Series have not been 
validated for remote monitors.

WARNING: INACCURATE TIME

Changing the system time during a study may cause the event log not to reflect 
the events as they actually happened. An apparent lag time may be introduced, 
events may appear out of order or medication values could be affected. Do not 
change the system time during a study. Confirm that the times between the 
acquisition system and the clients are the same prior to system use.

WARNING: SYSTEM INSTABILITY 

DO NOT load any software or patches other than those specified by GE 
Healthcare onto the system. Doing so may result in system instability or 
failure.

WARNING: SHOCK HAZARD

Do not power unspecified devices from the system equipment outlets.

WARNING: SHOCK HAZARD

If liquids or foreign materials have entered a device, take it out of service and 
have it checked by qualified service personnel to verify safety and functionality 
before it is used again. Ingress of foreign substances may result in shock, fire, 
excess leakage current, or device failure.
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WARNING: SHOCK HAZARD

To ensure patient safety, all equipment connected to the system must be 
powered from an isolated power source.

WARNING: SHOCK HAZARD

To reduce the risk of electric shock or damage to equipment, the equipment 
must only be connected to a properly installed power outlet with protective 
ground contacts.

WARNING: SHOCK HAZARD

To reduce the risk of shock and equipment damage, use safe working practices 
when servicing electrical equipment.

WARNING: SHOCK HAZARD

Damaged cables and loose connections present a shock hazard and could 
cause signal noise or impaired device operation. Ensure all cables are in good 
condition and securely connected before powering on equipment. Replace 
damaged cables immediately.

WARNING: SHOCK HAZARD

Use caution when cleaning the environment near equipment. Fluid ingress may 
damage devices or compromise electrical safety.

WARNING: SHOCK HAZARD

Do not connect analog input or analog output cables to patient-isolated 
equipment interfaces. This could compromise patient safety.

WARNING: SHOCK HAZARD

The Patient (sink) Leakage Current test causes high voltages on the test body. 
Do not touch conductive regions of the safety analyzer.
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WARNING: SHOCK HAZARD

To fully isolate the equipment from mains power, disconnect the power cord 
from the mains supply.

WARNING: SHOCK HAZARD

To reduce the risk of ingress of water into the equipment, do not mount the 
PDM in a vertical position with the patient cables facing up or down. 

WARNING: SHOCK HAZARD

The CardioLab II Plus amplifier defibrillation protection is only guaranteed 
when approved accessories are used. Do not use unspecified accessories.

WARNING: SYSTEM INSTABILITY

Do not install or use unvalidated anti-virus software (including unvalidated 
versions). Doing so may result in system instability or failure. Use only 
validated anti-virus software in the appropriate language version.

WARNING: SYSTEM INSTABILITY

Do not install any third party software onto the system, unless specified by 
GEHealthcare. Doing so may result in system instability or failure.

WARNING: TIPPING HAZARD

Do not attempt to transport the Mobile Workstand while the wheels are locked.

WARNING: TRIPPING HAZARD

Keep cables away from accessible walkways. Failure to do so may present a 
tripping hazard and could result in cable damage. 
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CAUTION: EQUIPMENT DAMAGE

Swivel tension nut on the Mobile Workstand must be torqued to a minimum of 
20 in-lbs [2.3 N-m].

CAUTION: EQUIPMENT DAMAGE

Tilt tension screws on the Mobile Workstand must be torqued to a minimum of 
35 in-lbs [4.0 N-m].

CAUTION: EQUIPMENT DAMAGE

Do not use benzene, thinner, ammonia, or any other volatile substances to 
clean the monitor or the screen. These chemicals may damage the cabinet 
finish as well as the screen.

CAUTION: EQUIPMENT DAMAGE

Do not use OA cleaner as it will cause deterioration or discolor the LCD 
surface.

CAUTION: LOSS OF FUNCTION

Do not edit or change the original dcf files. They may be needed in the future. 
Always create a copy of the original dcf file to work on.

CAUTION: SYSTEM FAILURE 

To ensure an adequate system power supply, GE Healthcare recommends 
using a dedicated circuit to power the IEB.

CAUTION: SYSTEM INSTABILITY

All networked systems at a location must be on the same version of Mac-Lab/ 
CardioLab software. Failure to do so may result in slowed performance, data 
corruption, or system instability.
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Responsibility of the Manufacturer

GE Healthcare is responsible for the effects of safety, reliability and performance only if:

 Assembly operations, extensions, readjustments, modifications or repairs are carried out by 
persons authorized by GE Healthcare.

 The electrical installation of the relevant room complies with the requirements of the 
appropriate regulations.

 The equipment is used in accordance with the instructions for use.

Responsibility of the User

General

Keep this manual with the equipment at all times. Periodically review this manual for information 
regarding system operation. If further assistance is required, contact GE Healthcare.

Anti-Virus Software

The following should be noted regarding the use of anti-virus software. Refer to the Mac-Lab/ 
CardioLab Security Guide (PN 2063076-004) for further information.

 Anti-virus software is not provided with the Mac-Lab/CardioLab system and it is the customer’s 
responsibility to acquire, install and maintain.

 The customer is responsible for updating anti-virus definition files.

 If a virus is found, contact the facility System Administrator and GE Technical Support.

 The anti-virus software used must be one that has been validated by GE Healthcare.

 The language version of the anti-virus software must match the operating system language.

Product Vulnerability and Security Patches

Customers are responsible to stay informed on the Mac-Lab/CardioLab product vulnerability 
status and the installation of validated security patches for the Mac-Lab/CardioLab systems. Refer 
to the Mac-Lab/CardioLab Security Guide (PN 2063076-004) for further information.

Preventative Maintenance

It is the responsibility of the user to properly maintain the system equipment. Refer to Maintenance 
on page 3-1 in this manual and the accompanying service manual for further information.

Failure on the part of the responsible individual, hospital or institution using this equipment to 
implement a satisfactory maintenance schedule may cause undue equipment failure and possible 
health hazards.

Regular maintenance, irrespective of usage, is essential to ensure that the Mac-Lab/CardioLab 
system will always be functional when required. In the event that service is needed for the 
equipment, contact your GE Healthcare service representative.
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Service

Refer equipment servicing to GE Healthcare authorized service personnel only. Any unauthorized 
attempt to repair equipment under warranty voids that warranty.

Any unauthorized attempt to install third-party software on a system under warranty, voids that 
warranty.

It is the user’s responsibility to report the need for service to GE Healthcare or to one of their 
authorized agents.

Equipment Symbols

Equipment Symbols Descriptions

PCT (GOST-R) Mark

Compliance with applicable requirements for Russia.

Underwriters Laboratories, Inc.

Non-US Systems:

Medical – general medical equipment as to electrical shock, fire and mechanical hazards only 
in accordance with UL60601-1, CAN/CSA C22.2 No. 601.1, ANSI/AAMI ES60601-1 (2005, 
3rd ed.), AND CAN/CSA-C22.2 No. 60601-1 (2008).

US-Only Systems:

Classified by Underwriters Laboratories Inc. with respect to electric shock, fire, mechanical 
and other specified hazards, only in accordance with UL 2601-1, CAN/CSA C22.2 No. 601.1, 
IEC 60601-1 and IEC 60601-1-1.

WEEE

Indicates that the waste of electrical and electronic equipment must not be disposed as 
unsorted municipal waste and must be collected separately. Please contact an authorized 
representative of the manufacturer for information concerning the decommissioning of your 
equipment.

WEEE

The separate collection symbol is affixed to a battery, or its packaging, to advise you that the 
battery must be recycled or disposed of in accordance with local or country laws. The letters 
below the separate collection symbol indicate whether certain elements (Pb=Lead, 
Cd=Cadmium, Hg=Mercury) are contained in the battery. To minimize potential effects on the 
environment and human health, it is important that all devices with batteries are properly 
recycled or disposed.

Information on the potential effects on the environment and human health of the substances 
used in batteries is available at this url:
http://www.gehealthcare.com/euen/weee-recycling/index.html

Fuse
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Equipotential Ground Point

A nonessential electrical connection which may be used to connect the chassis to other 
equipment to achieve the same potential.

Standby

Mains Power Switch

1 is on. 0 is off.

Insert SD

Indicates that the computer has an SD drive located near this symbol.

Insert SD Here

Type CF Equipment that is Defibrillator Proof

Type CF Applied Part: Isolated (floating) applied part suitable for intentional external and 
internal application to the patient excluding direct cardiac application. The “paddles” outside 
the box indicate that the part is defibrillator proof.

(Medical Standard Definition:) F-Type applied part (floating/isolated) complying with the 
specified requirements of IEC 60601-1/UL 2601-1/CSA 601.1 Medical Standards provide a 
higher degree of protection against electric shock than that provided by Type B applied parts.

Type BF Equipment that is Defibrillator Proof

Type BF Applied Part that is defibrillator proof: Isolated (floating) applied part suitable for 
intentional external and internal application to the patient excluding direct cardiac application. 
“Paddles outside the box indicate the applied part is defibrillator proof.

(Medical Standard Definition:) F-Type applied part (floating/isolated) complying with the 
specified requirements of IEC 60601-1/UL 2601-1/CSA 601.1 Medical Standards provide a 
higher degree of protection against electric shock than that provided by Type B applied parts.

Atmospheric Pressure Limits

Temperature Limits

Equipment Symbols Descriptions
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Humidity Limits 

IPX1 Protected against potentially harmful effects of vertically falling water drops.

Consult accompanying documents.

Caution

NOTE: Per IEC 60601-1 2nd ed, the description of this symbol is “Attention, consult 
ACCOMPANYING DOCUMENTS”.

Mandatory Action: Follow Instructions For Use 

Read and understand the operator's manual before using the device or product.

As a mandatory action sign, this symbol is identified by a blue background and white symbol.

WARNING

General warning sign.

This symbol is identified by a yellow background, black triangular band, and a black symbol.

Input Symbol

Identifies the device manufacturer and manufacturing date.

Identifies the product’s catalog, or orderable part number.

Identifies the unit’s serial number.

Battery

Equipment Symbols Descriptions
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Communication

ePort Connection

Power

Network Connection/Interface

Serial Connection/Interface

USB Connection Interface

WARNING: SHOCK HAZARD

Remove power cord from the mains source by grasping the plug. Do not pull on the cable. 
This may cause cable damage, which could result in loss of protective earthing or exposure to 
mains voltage.

Zero All

Equipment Symbols Descriptions
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Equipment Overview
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Equipment Overview
Serial Number Identification

Every Mac-Lab/SpecialsLab system has a unique serial number for identification. The serial 
number appears on the product labels which are located (while facing the product):

 Acquisition Computer — on the right side 

 Review Workstation — on the top 

 Centricity Cardiology INW Server — on the front

 Integrated Electronics Box (IEB) — on the back

 PDM — on the bottom

 PDM Base Station — on the back

 TRAM-RAC — on the right side

 TRAM — on the back

 CardioLab II Plus Amplifier — on the back

 CO2 Module — on the right side

Identification Tag

Item Name Description

1 Manufacture Date Date of manufacture in YYYY-MM format.

2 Part Number of Product GE Healthcare part number for product.

3 Product Code Description Identifier for type of product.

4 Serial Number and 
Barcode

Unique serial number for identification. 
Encoded as a barcode below the displayed number.

5 Manufacturer Information Name and address of device manufacturer.

GE MEDICAL SYSTEMS INFORMATION TECHNOLOGIES, INC., 8200 WEST TOWER AVE., MILWAUKEE, WISCONSIN USA

1
2 3

4

5
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Equipment Overview
Typical Acquisition System Configuration

This system may consist of either Mac-Lab (hemodynamic), CardioLab (electrophysiologic) or 
ComboLab (both systems).

NOTE: This document illustrates the HP z600 computer cabling connections only. Refer to 
version 6.8.1 service manuals for HP xw8400 computer cabling connections.

The system may be standalone or connected to a network. Network installations include a 
Centricity Cardiology INW server. In this manual, INW refers to Centricity Cardiology INW. It may 
be connected to an optional CVIS server.

The system may also include a CardioLab II Plus Amplifier, also referred to as CLab II Plus.

The following block diagram shows a typical setup.
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Equipment Overview
Control Room Components

 Acquisition Computer: The Acquisition Computer provides the ability to record the patient's 
real time waveform data. It uses Windows and has the following drives:

 DVD-Drive: used for installation and service of the computer.

 SD Drive: used to store backup copies of patient procedure data.

 External Blu-ray drive (optional): used to copy procedure data from DVD-RAM media to 
SD media.

 Monitors: Two monitors are standard to display Real-Time and Review windows. An optional 
third monitor displays images acquired from the X-ray and ultrasound system.

 Integrated Electronics Box (IEB): The IEB provides isolated power to system components 
and distributes video and communication signals to the control and procedure rooms.

 Uninterrupted Power Supply (UPS): The UPS provides emergency power to the acquisition 
computer in the event of a power outage. It will sustain power to the computer for a minimum 
of 20 seconds. It does not power the monitors during an outage.

NOTE: The UPS is external to the IEB and provides uninterrupted power to the HP computer. 
The monitors and other peripherals will not remain on if power is lost.

 Analog Output Box (optional): Distributes the ECG or Intracardiac signals from the Amplifier 
to other equipment.

 Printer: Used to print snapshots, images and reports during or after a procedure.

 Barcode scanner (optional): Used to scan in supplies and medication used in a procedure.

 CARTO Mapping System (optional) - CardioLab or ComboLab systems only: Provides 
3D electroanatomical cardiac maps to the CardioLab.

 Cardiac Stimulator (optional) - CardioLab or ComboLab systems only: Provides direct 
cardiac stimulation to assist the physician during a CardioLab case.

 Vivid System Remote Trackball (optional): Provides the ability to control the GE Vivid 
Ultrasound System from the control room.

 Desk (optional): Provides a workspace for control room components.
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Equipment Overview
Procedure Room Components

 Monitors: One remote monitor is standard and is software switchable between Real-Time and 
Review windows. A second monitor is optional.

 Remote Speakers: Provide output for ECG QRS tone and optional audible indicators in the 
procedure room. 

 TRAMNet or PDM: The TRAMNet or PDM acquires invasive pressure and ECG signal data 
for Mac-Lab systems. It also acquires patient vital data such as respiration rate, noninvasive 
blood pressure, SpO2 and temperature for both Mac-Lab and CardioLab systems. The 
TRAMNet consists of a Remote Acquisition Case (RAC 4A) and a Transport Remote 
Acquisition Module (TRAM). The PDM is powered by the PDM Base Station unit.

 CardioLab II Plus Amplifier - CardioLab or ComboLab systems only: The Amplifier 
gathers intracardiac and surface ECG data for both the CardioLab and ComboLab systems.

 Catheter Input Modules - CardioLab or ComboLab systems only: Used for connecting 
intracardiac catheters to the CardioLab II Plus Amplifier.

 RF Filter Box - CardioLab or ComboLab systems only: Filters RF noise from intracardiac 
signals acquired by an ablation device.

 CO2 Module (optional): The CO2 module plugs into the RAC 4A and displays the patient's 
respiration data on the Mac-Lab System.

 Remote Operators Terminal (RMOT) (optional): The RMOT consists of two monitors, a 
keyboard and a mouse remotely connected to the Acquisition system to provide remote 
control of the Acquisition computer in the procedure room.

 Large Display Monitor (LDM) (optional): The LDM is a large widescreen flat-panel LCD 
monitor used for simultaneous display of several image sources, including the Acquisition 
system.

 Analog Output Box (optional): Distributes heart rate and blood pressure signals from the 
TRAMNet and Amplifier to other equipment.

 CARTO System (Patient Interface Unit) (optional) - CardioLab or ComboLab systems 
only: The CARTO PIU gathers data for the CARTO system.

 Ablation Device (optional) - CardioLab or ComboLab systems only: An RF ablation 
device that burns heart tissue or cryogenic device that freezes the tissue controlled by the 
physician or technician.

 Force Sense Device (optional): A device which measures the amount of pressure between 
the tip of an ablation catheter and the tissue with which it is in contact.

 Vivid System (optional): A digital imaging GE Ultrasound system. 

 Nurse’s Review Workstation (optional): The Nurse’s Workstation is a system used in the 
procedure room during a study. Provides the operator with the ability to participate in an active 
study and perform actions such as document administered medications and supplies 
consumed.
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Equipment Overview
IT Control Room Components

 Network Switch: Provides connection between network components and segments.

 Centricity Cardiology INW Server: Provides the ability to review patient data during and after 
data acquisition and allows for a centralized point of data access.

 Monitor (temporary): Displays screens during server installation only. Removed after 
server installation is complete.

 Keyboard (temporary): Provides an input for commands and text entries during server 
installation only. Removed after server installation is complete.

 CVIS Server: Provides a central location to manage data regarding staff, supplies, inventory, 
patient scheduling, patient information and statistical reports.

 Monitor (temporary): Displays screens during server installation only. Removed after 
server installation is complete.

 Keyboard (temporary): Provides an input for commands and text entries during server 
installation only. Removed after server installation is complete.

Network Connections

CVIS Server

INW Server

Review
WorkstationMac-Lab CardioLab

Hospital
Enterprise

OR

INW Backup Device
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Equipment Overview
Review Workstations

Mac-Lab/CardioLab software can run on hardware provided by GE (Review Workstation) or on 
hardware provided by the hospital (Software Only Review Workstation).

Nurse's Workstation Components

The Nurse's Workstation is a system used in the procedure room during a study.

 GE Client Workstation: Provides the operator with the ability to participate in an active study 
and perform actions such as document administered medications and supplies consumed.

 Isolation Transformer: Provides isolated power for components.

 Monitor: Used to display the Review window. One monitor is standard.

 Barcode Scanner (optional): Used to scan in supplies and medications used in a procedure.

Remote Review Workstation Components

The Remote Review Workstation is a system installed in the physician’s office or an area outside 
the laboratory. 

 GE Client Workstation: Used to review previously acquired procedure data and generate 
reports.

 Isolation Transformer: Provides isolated power for components.

 Monitor: Used to display the Review window. One monitor is standard.

 Printer (optional): Used to print snapshots, images and reports after a procedure.

Pre/Post Review Workstation Components

The Pre/Post Review Workstation is a Review Workstation typically located in a Holding Area for 
the entry of basic patient demographics, clinical data and patient events prior to, or after, the 
patient's entry into the Laboratory.

 GE Client Workstation: Used before and after the procedure to record patient information.

 DASH/Solar Monitor: Connected to the Pre/Post Workstation to acquire patient vitals during 
pre or post procedure monitoring.

 Monitor: Used to display the Review window. One monitor is standard.

 Isolation Transformer: Provides isolated power for the Pre/Post Workstation.

 Mobile Workstand (optional): Provides portable support for Pre/Post Workstation 
components.

 Barcode Scanner (optional): Used to scan in supplies and medications used in a procedure.
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Equipment Overview
Supported Peripheral Devices

The following peripheral devices are support for use on Mac-Lab/CardioLab/Centricity Cardiology 
INW system:

 DASH: 3000/4000/5000

 Solar: 8000i and 8000M connected with a TRAM or PDM

 Vivid: i/q

 FFR (Mac-Lab only): Radi PressureWire Aeris and Volcano SmartMap Pressure Instrument

 Ablation (CardioLab only): 

 Atakr II (Model: 4803) RF (Radio frequency) ablation device

 EPT-1000 (Model: 800T) RF ablation device

 Stockert RF ablation device

 IBI 1500T (Software version: v1.25) RF ablation device

 HAT 300S RF ablation device

 CryoCath (Model: Gen3) cryo-ablation device

 JLLCABL-IT RF ablation device

 Maestro 3000

 Force device availability varies by region, please see your sales representative.

 Cardiac Stimulator (CardioLab only): MicroPace EPS 320, Bloom Stimulator

 Mapping System (CardioLab only): CARTO XP v10 or CARTO 3

 X-ray systems: refer to the product's DICOM conformance statement on the following GE 
Healthcare website: 
http://www.gehealthcare.com/usen/interoperability/dicom/products/cvinfosys_dicom.html
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Equipment Overview
System Hardware

WARNING: SHOCK HAZARD

To reduce the risk of shock and equipment damage, use safe working practices 
when servicing electrical equipment.

Acquisition System Components

HP Computer

The HP computer used for Acquisition systems has the following components:

 Primary Hard Drive with two partitions

 C: Application partition

 D: Data partition

 SD drive with front access (Drive E:)

 Used on all new HP z600 and older z600s with upgrade

NOTE: The drive used to store backups of application studies is determined by the file paths set 
under System Settings in the main application menu.

 DVD-RAM drive (Drive F:)

 Used on HP z600 with upgrade

NOTE: The drive used to store backups of application studies is determined by the file paths set 
under System Settings in the main application menu.

 DVD drive (Drive F:)

 Used on new HP z600 and some z600s with upgrade

 SD drive with internal access (Drive G:)

 Used on HP z600 with upgrade

 Used on new HP z600

NOTE: The drive used for GE Service to store upgrade/migration data as well as backed up 
system settings.
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Equipment Overview
 Four standard expansion cards (plus optional cards)

 HP z600: Matrox M9140 video board provides video out for the Real-Time (Video 1), 
Review (Video 2) and optional (Video 3) monitors.

 TRAMNet to Ethernet Adapter board for communication with the TRAM in the RAC 4A.

 PCI Communication board provides Amplifier Communication, Analog and Digital I/O and 
Switched video (the video out from the IEB).

 Dual NIC Adapter board provides Network connection.

 Optional on HP z600: Matrox Solios x4 PCIe (eCL) board used to capture images from 
Vivid system for CardioICE support. 

 Optional on older HP z600 with upgrade: Matrox Odyssey eA board used to capture 
images from an X-Ray or other imaging system.

 Optional on new HP z600: Matrox Odyssey Helios board used to capture images from an 
X-Ray or other imaging system.
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Equipment Overview
External Components and Connections for the HP z600

Label Part Number Description

1 2028599-002 DVD-RAM Drive (used on some HP z600 with upgrade)

2054838-001 DVD Drive (used on new HP z600 and some HP z600 with upgrade 
only)

2057730-001 ADA Drive (used on HP z600 with upgrade)

2 2050067-001 SD Drive

3 N/A Power Switch

4 N/A LEDs, USB, Firewire and Audio connections

5 N/A Backplane I/O panel

6 N/A Board Slots

7 N/A AC Power

Not Shown 2026539-001 HP USB 2-Button Optical Mouse with Wheel

Not Shown Various Keyboard (dependent on language)

2

3

4

5

7

6

1
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Equipment Overview
DVD-RAM Drive

The DVD-RAM drive (used with older HP z600 with upgrade) can also read/write to CDs. The 
recommended disks have a capacity of approximately 4.7 GB per side.

NOTE: The drive used to store backups of application studies is determined by the file paths set 
under System Settings in the main application menu.

SATA-to-IDE Converter - HP z600 Only

The DVD-RAM drive is connected using a SATA-to-IDE converter.

Item Description

1 DVD-RAM Drive Jumpers

2 IDE Connector

3 Power Connector

1 2 3

Item Description

1 SATA Connection

2 4-pin Connection

Not Shown IDE Connection (on back of device)

1
2
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Equipment Overview
DVD Drive – New HP z600 Only

The DVD drive (used on new HP z600) requires no jumper settings prior to installation.

ADA Drive

The ADA drive (used with some older HP z600 with upgrade) can also read/write to CDs. The 
recommended disks (DVD-RAM) have a capacity of approximately 4.7 GB per side. The same 
media used in the DVD-RAM drive can be used in the ADA drive.

NOTE: The drive used to store backups of application studies is determined by the file paths set 
under System Settings in the main application menu.

SD Drive

The SD drive (used on all HP z600 and older HP xw8400 with upgrade) requires no jumper 
settings prior to installation. The SD drive contains two SD card slots: one external access slot 
(front of computer) for facility personnel use and one internal access slot for use by GE service 
personnel.

NOTE: The drive used to store backups of application studies is determined by the file paths set 
under System Settings in the main application menu.

External Blu-ray Drive – Optional

The external Blu-ray drive (optional) is used to copy procedure data from DVD-RAM media to SD 
media.

NOTE: The drive is determined by the file paths set under System Settings in the main 
application menu.
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Equipment Overview
HP z600 Installed Boards

HP z600 Dual NIC Adapter Board

 Part Number: 2047766-001

 Subcomponents of Dual NIC bracket:

 Dual NIC Assembly Part Number: 2057429-001

 Serial Connector Part Number: 2036936-017 (RoHS) 2057430-001 (non-RoHS)

 Location: Slot 1

 Function: Network connection card, ablation connection card.

 I/O: Two network connection jacks, one serial port (for connection to ablation devices)

Uses internal serial connection from motherboard:

1

2

3

4

5

6
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Equipment Overview
Matrox M9140 Quad Video Board

 Part Number: 2049434-001

 Location: Slot 2

 Function: Video out for Monitor 1, Monitor 2 and Monitor 3 (optional) 

 I/O: One proprietary connector. Provides four DVI/VGA output ports through a custom 
connector.

1

2

3

4

5

6
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Equipment Overview
HP z600 Matrox Helios Video Board (Optional)

 Part Number: 2052113-001

 Location: Slot 3

 Function: Image capture for X-Ray or other imaging systems. Used on CardioICE and 
CardioImage Acquisition systems only.

 I/O: Two DVI connectors

HP z600 Matrox Odyssey eA Video Board (Optional)

 Part Number: 2049435-001

 Location: Slot 3 (existing Z600 computers)

 Function: Image capture for X-Ray or other imaging systems. Used on CardioICE and 
CardioImage Acquisition systems only.

 I/O: Two DVI connectors

1

2

3

4

5

6

1 

2 

3 

4 

5 

6 
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Equipment Overview
Matrox Solios Video Board (Optional)

 Part Number: 2031725-001

 Location: Slot 4

 Function: Video in from Vivid. Used on CardioICE Acquisition systems only.

 I/O: Two DVI Connectors (only one is used)

HP z600 TRAMNet to Ethernet Adapter Board

 Part Number: 2009937-004 (RoHS) or 2009937-003 (non-RoHS)

 Location: Slot 5

 Function: Provides communication with the TRAM in the RAC 4A and converts signals from 
the TRAM to the ethernet. 

 I/O: Network Interface Port and 9-Pin D connector

1

2

3

4

5

6

1

2

3

4

5

6
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Equipment Overview
HP z600 PCI Communication Board

 Part Number: 2014935-003 (RoHS) or 2014935-002 (non-RoHS)

 Location: Slot 6

 Functions:

 Communicates with the CLab II Plus Amplifier via the fiber optic connectors

 Analog and Digital communication with the IEB via the D-Connector

 Provides the video switching signal for the Switched Video output on the IEB via the D-
Connector

 I/O: D-Connector to IEB, Fiber Optic Jacks to the Amplifier

1

2

3

4

5

6
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Equipment Overview
Integrated Electronics Box (IEB)

The IEB provides power to local system components and signal pass through video and 
communications. Three versions of the IEB are available to handle different line voltages: 100, 120 
and 240 VAC.

The IEB consists of the following components:

 Video Multiplexer (VID MUX) board to distribute video signals from the video cards in the 
Acquisition system to the monitors.

 DB Connect board to provide signal pass through for other system components.

 Isolation transformer:

 Conforms to IEC 60601-1

 2.0 kVA medical grade high-isolation transformation

 Provides either 120 VAC (for 100 and 120 VAC systems) or 240 VAC. The primary and 
secondary windings are wired in parallel for 120 VAC and in series for 240 VAC.

CAUTION: CONNECTIONS

If the transformer must be disconnected for any reason, ensure the 
connections are correct.

 UPS (either 100, 120, or 240 VAC) and Power Distribution panel provide conditioned power to 
local system components.

NOTE: The UPS is external to the IEB and provides uninterrupted power to the Acquisition 
system. The monitors and other peripherials will not remain on if power is lost.

Depending on which IEB is installed, a modem and modem power supply for dial-up 
communication may be present. The power supply accepts any line voltage and converts 
it into 9 VDC.
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Equipment Overview
External Components and Connections

Both the Main Power switch on the front of the IEB and the Thermal Overload circuit breaker on 
the back must be on for the system to power up.

Item Part Number
Non-RoHS Part 

Number
Description

1 2003681-004 2003681-003 VID MUX Board

2 2003680-002 2003680-001 DB Connect Board

3 N/A N/A Power Connections. The bottom right connector is for the 
Acquisition system and the four vertical connectors on the right and 
left are for peripheral equipment.

4 N/A N/A Thermal Overcurrent Circuit Breaker. This breaker protects all 
internal components and external devices connected to the IEB.

5 N/A N/A Main Power Switch. This switch controls power to all internal 
components and external devices except the Acquisition system.
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Equipment Overview
Video Multiplexer (VID/MUX) Board

The VID MUX board amplifies (±5V 1.25A) from the internal IEB DC power supply (refer to Internal 
Components and Connections on page 2-24) and distributes the video signals from the HP 
Computer (refer to HP z600 Video Connections on page 2-54).

Item Description

1 Switched video out (Video 1 or 2). This is used when the facility has only one remote monitor. To switch 
monitors:

 Mac-Lab: Go to the main menu and select Windows > Physician Video.

 CardioLab: Use the dropdown box just under the main menu.

2 Video 1 (Real-Time) out to local monitor (bottom) and remote monitor (top)

3 Video 2 (Review) out to local monitor (bottom) and remote monitor (top)

4 Video 3 (CardioImage) out to local monitor (bottom) and remote monitor (top)

5 (L to R) Video 1, Video 2, Video 3 in from Acquisition system Matrox Quad Video board for Vid 1, Vid 2 and 
Vid 3
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Equipment Overview
DB Connect Board

WARNING: SHOCK HAZARD

Do not connect analog input or analog output cables to patient-isolated 
equipment interfaces. This could compromise patient safety.

Refer to the following cabling diagrams:

 Communications Connections on page 2-55

 TRAM/Amplifier Connections on page 2-56

Item Description

1 Analog I/O Communication: Connects to the Acquisition system PCI Communication board.

2 Analog In: From another system (for example, Fluoro and so on)

3 Connection to the Analog Output Box

4 Analog Out (for example, Stimulator, Vivid and so on).

5 I/O TRAM (includes 16.5 VDC power)

6 Output to Acquisition system TRAMNet to Ethernet to Adapter board
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Equipment Overview
Power Connections

Refer to the cabling diagram, Power Connections on page 2-53.

Item Description

1 and 5 AC out to local equipment (6A at 120 VACmax; 3A at 240 VACmax)

2 Thermal Overcurrent circuit breaker. Protects all internal components and external devices connected to 
the IEB.

3 AC main power in (15A at 120 VACmax; 7A at 240 VACmax)

4 AC power out to UPS (2A at 120 VACmax; 1A at 240 VACmax).
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Equipment Overview
Internal Components and Connections

Item Part Number
Non-RoHS Part 

Number
Description

1 2003681-004
2003680-002

2003681-003
2003680-001

VID/MUX Board Assembly
DB Connect (I/O) Board Assembly

2 2013535-001 Power Supply: Provides + 5 VDC 1.25A for the VID/MUX board and 
+16.5 VDC for the RAC-4A.
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Equipment Overview
Uninterruptible Power Supply (UPS)

The UPS is designed to maintain power to the Acquisition system during a power outage for up to 
20 seconds.

NOTE: The UPS is external to the IEB and provides uninterrupted power to the Acquisition 
system. The monitors and other peripherials will not remain on if power is lost.

Part Number
Non-RoHS Part 

Number
Description

2034077-002 2034077-001 UPS Powercom, 120V, 50/60 Hz, 1500 VA, BNT

2034078-002 2034078-001 UPS Powercom, 230V, 50/60 Hz, 1500 VA, BNT

2034079-002 2034079-001 UPS Powercom, 100V, 50/60 Hz, 1500 VA, BNT
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Equipment Overview
Review Workstation

There are several configuration options for use of the Review Workstations in a networked system 
environment.

 Nursing Workstation: A system used in the procedure room during a study. 

 Remote Review Workstation: A system installed in the physician’s office or an area outside 
the laboratory.

 Pre/Post Procedure Workstation: Typically located in a Holding Area for the entry of basic 
patient demographics, clinical data and patient events prior to, or after, the patient's entry into 
the Laboratory. 

NOTE: Automatic vitals logging is also available with the optional DASH and Solar monitor 
interface.

NOTE: When used in a patient care area, the hardware must meet IEC60601-1. This can be 
achieved through the use of a medical grade computer, separate isolation transformer or 
other means as determined by appropriate hospital personal.

The Review Workstation has the following components:

 Primary Hard Drive with two partitions:

 C: Application partition

 D: Data partition

 DVD drive (E:)

NOTE: On the Review Workstation, this drive is used to service the system.

 Secondary Hard Drive (G:)
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Equipment Overview
External Components and Connections for the Review Workstation

Item Part Number Description

1 N/A Power and Reset Switches

2 N/A DVD Drive

3 N/A USB and Audio Connections (behind covers)

4 N/A AC Power

5 Various Keyboard (dependent on language)

6 N/A Com Port for DASH/Solar Connection

7 N/A Video Input

8 N/A USB 2-Button Optical Mouse with Wheel

9 N/A RJ-45 Port to Network

1

2

3

4

7
8  

5

9

6
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Equipment Overview
Mobile Workstand

Refer to the instructions included with the mobile workstand for details on how to place the GE 
hardware on an assembled GE mobile workstand (PN 2008203-001).

Item Part Number Description

1 N/A DASH Monitor

2 N/A Mouse or Barcode Scanner Location

3 N/A Keyboard Location

4 2063576-001
2053147-001
2048962-001

Review Workstation Computer

5 2004195-001 Isolation Transformer

6 2079070-002 LCD Monitor

4

1

5

6

232
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Equipment Overview
Monitors

The standard Acquisition system comes with two monitors and may have a third optional monitor. 
The monitors include:

 A Real-Time monitor to display active patient information. It is usually located on the left.

 A Review monitor to display saved patient study information.

 An optional Image monitor (used with the CardioImage option) displays live or frozen video 
images.

A single remote monitor is standard and receives input from the switched video out (Video 1 or 2) 
jack on the IEB (see External Components and Connections on page 2-20).

 To switch video for the Mac-Lab go to the main menu and select Windows > Physician 
Video.

 To switch video for the CardioLab use the drop-down box just under the main menu.
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Patient Data Module (PDM)

PDM acts as an amplifier for the Mac-Lab system and is responsible for patient data acquisition. It 
is connected to the PDM Base Station unit which powers the PDM and is placed in the procedure 
room near the patient table. The PDM rests in a dock that can be mounted to a bed rail, a pole, or 
a stand which also holds the PDM Base Station.

PDM has the following patient data input features:

 Electrocardiogram (ECG): Green connector (5 or 10 leads)

 Thermal Dilution Cardiac Output (TDCO) or Temperature: Brown connector

 Invasive Blood Pressure (IBP): Red connectors

 Pulse Oximetry (SpO2): Blue Connector

 Non-Invasive Blood Pressure (NIBP): Black Connector

 Analog Out and Defib/Sync: White connector

PDM does not support CO2 data acquisition.

The PDM can monitor up to four invasive blood pressures when two Y-adapter cables are used. 
Plugging one Y-adapter cable into the P1/P3 connector on the PDM allows two separate invasive 
blood pressures to be monitored from that connector, for a total of three pressures. Plugging a 
second Y-adapter cable into the P2/P4 connector on the PDM allows two separate invasive blood 
pressures to be monitored from that connector, for a total of four pressures.

NOTE: The labeling on the Y-adaptor cable (IP1 and IP2) corresponds to the first and second 
pressures listed below the connector on the PDM. For example, if a Y-adaptor cable is 
plugged into the P1/P3 connector on the PDM, the IP1 represents P1 and the IP2 
represents P3.

NOTE: The PDM waveform defibrillation recovery time is ten seconds.

Refer to Appendix E for information about the PDM battery and for a list of accessories approved 
for use with the PDM. Refer to the documentation included with the PDM module for additional 
information. Revisions up to 2.1 are supported.

Ensure that the cables are compatible with the PDM, including that the SpO2 cable matches the 
SpO2 sensor type.
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WARNING: SHOCK HAZARD

Defibrillator protection is only guaranteed when approved accessories are 
used. Do not use unspecified accessories.

Analog Out and Defib/Sync

The white connector on the PDM may be used to provide Analog Output or Defib/Sync signals to 
external devices.

 Analog Out: This supplies either an ECG or an invasive pressure signal to another device. 
Refer to Analog Output Box on page 2-46 for details.

 Defib/Sync: This provides the ECG synchronization signal for an external defibrillator, 
intraaortic balloon pump or ventilator. The sync signal is generated using the currently 
selected ECG analog output lead. Use the Defib/Sync Interface cable (PN 2017842-001) to 
access this output.

An optional splitter (PN 2024565-002 (RoHS) or 2024565-001 (non-RoHS) may be used to 
provide both Analog Out and Defib/Sync signals simultaneously.
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PDM Base Station

The PDM Base Station powers the PDM and routes Ethernet signals between the Acquisition 
system and the PDM. The PDM and Base Station are located in the procedure room near the 
procedure table.

A green power light indicates the Base Station is attached to AC power and is turned on.

Item Description

1 To Acquisition System Workstation

2 To PDM

3 AC power 100-240VAC 50/60Hz

1 2 3
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PDM and Base Station Mounting Options

The PDM Base Station can be mounted to a stand where the PDM is also docked.

NOTE: The green light on the front of the PDM Base Station is quite bright. It is suggested that 
the PDM Base Station is installed facing away from the physician, toward the foot or the 
far side of the bed.

The PDM Base Station may also rest with its feet on the floor, connected to the PDM by a longer 
cable. In this setup, the PDM dock is attached to the pole/rail clamp, which clamps onto a bed rail 
or pole. The pole/rail clamp is attached and detached by adjusting the clamp knob. Ensure the 
knob is fully tightened when clamping to bed rails and poles.
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WARNING: TRIPPING HAZARD

Keep cables away from accessible walkways. Failure to do so may present a 
tripping hazard and could result in cable damage. 

WARNING: FALLING EQUIPMENT

Do not place the PDM more than 147 cm (58 in) from the floor when mounting 
on an IV pole with a base less than 58 cm (23 in) in diameter. This may cause 
the IV pole to tip over.

WARNING: SHOCK HAZARD

To reduce the risk of ingress of water into the equipment, do not mount the 
PDM in a vertical position with the patient cables facing up or down. 
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TRAMNet

The TRAMNet consists of a Remote Acquisition Case (RAC-4A) and one TRAM module. The 
TRAMNet is located in the procedure room near the procedure table. 

The TRAM module receives patient inputs and then transmits signal data to the IEB and other 
equipment through the Analog Output Box (refer to the cabling diagrams in TRAM/Amplifier 
Connections on page 2-56).

TRAM Module Inputs:

 Electrocardiogram (ECG) - green connector (5 or 10 leads)

 Thermal Dilution Cardiac Output (TDCO) - brown connector

 Invasive Blood Pressure (IBP) - 3 red connectors

 Non-Invasive Blood Pressure (NIBP) - black connector

 Pulse Oximetry (SpO2) - blue connector

Item Description

1 TRAM Module

2 To Analog Out Box

3 To IEB TRAM Connector
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Outputs: Analog output connector.

The following TRAM modules are supported:

 250SL

 400 SL, 450SL, 451, 451M, 451N, 451N5

 650SL

The following software versions are supported:

 7A, 7B, 7C, 7D, 7E, 7F, 7H

 8A, 8B, 8C, 8D

 9A, 9B

 10A, 10B

 11A, 11B, 11C

Refer to the documentation included with the TRAM module for additional information on 
equipment and compatible accessories.

RAC 4A

The RAC 4A is the housing device for the TRAM and is mounted in the procedure room near the 
procedure table. The RAC 4A can be placed on the floor or mounted to the table vertically or 
horizontally and should be protected from fluids.

Refer to the documentation included with the TRAM module for additional information on 
equipment and compatible accessories.

WARNING: SHOCK HAZARD

Use caution when cleaning the environment near equipment. Fluid ingress may 
damage devices or compromise electrical safety.

CardioLab II Plus Amplifier

The CardioLab II Plus Amplifier is designed to amplify various types of cardiac signals that are 
acquired from a patient and transmit them back to the CardioLab system. These signals include 12 
Lead ECG, intracardiac and pressure signals. 
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Equipment Overview
Front View

Front View 64/32 Channels - CardioLab II Plus Amplifier

Item Description

1 Catheter Inputs: Up to three catheter inputs will each accept a 32 pole catheter input module. Use the 
CardioLab II Plus Catheter Input Modules (part number 301-00202-08) with the CardioLab II Plus Amplifier.

2 Power Indicators: The power indicator is on as long as the CardioLab II Plus Amplifier is turned on.

3 Communication Indicators: Three communication indicators show the status of the communication 
between the acquisition computer and the CardioLab II Plus Amplifier.

 When the XMT indicator is on, the CardioLab II Plus Amplifier is transmitting data to the acquisition 
computer. The XMT indicator should remain on as long as the power indicator is on.

 When the RCV CMD indicator is on, the CardioLab II Plus Amplifier is receiving data from the acquisition 
computer. The RCV CMD indicator will turn on as long as an instruction is being received by the 
amplifier.

 When the RCV ERR indictor is on, the CardioLab II Plus Amplifier may not be receiving data from the 
acquisition computer in a valid format or there may be a problem with the fiber optic cable.

4 Auxiliary Inputs: The auxiliary input will accept the Auxiliary Input Cable (part number 301-00205-08).

5 Stimulator Input: The stimulator input will accept a stimulator input cable. Use the 3 ft, 15 ft or 30 ft 
Touchproof Stimulator Cables (part numbers, 301-00204-03, 301-00204-15, 301-00204-30, respectively) 
with the CardioLab II Plus Amplifier. 

6 ECG Inputs: The ECG input connector will accept a 10 lead ECG input cable.

7 Pressure Inputs: Four pressure inputs will each accept a pressure transducer that is calibrated to 5uV/V/
mmHg. See the Accessory Parts List for GE Healthcare Systems Information Technologies recommended 
pressure transducers.
2-38 Mac-Lab/CardioLab/Centricity Cardiology INW Service Manual 2063076-010H EN 



Equipment Overview
Front View 128/96 Channels - CardioLab II Plus Amplifier

Item Description

1 Catheter Inputs: Up to seven catheter inputs will each accept a 32 pole catheter input module. Use the 
CardioLab II Plus Catheter Input Modules (part number 301-00202-08) with the CardioLab II Plus Amplifier.

2 Power Indicator: The power indicator is on as long as the CardioLab II Plus Amplifier is turned on.

3 Communication Indicators: Three communication indicators show the status of the communication 
between the acquisition computer and the CardioLab II Plus Amplifier.

 When the XMT indicator is on, the CardioLab II Plus Amplifier is transmitting data to the acquisition 
computer. The XMT indicator should remain on as long as the power indicator is on.

 When the RCV CMD indicator is on, the CardioLab II Plus Amplifier is receiving data from the acquisition 
computer. The RCV CMD indicator will turn on as long as an instruction is being received by the 
amplifier.

 When the RCV ERR indictor is on, the CardioLab II Plus Amplifier may not be receiving data from the 
acquisition computer in a valid format or there may be a problem with the fiber optic cable.

4 Auxiliary Inputs: The auxiliary input will accept the Auxiliary Input Cable (part number 301-00205-08).

5 Stimulator Inputs: The stimulator input will accept a stimulator input cable. Use the 3 ft, 15 ft or 30 ft 
Touchproof Stimulator Cables (part numbers, 301-00204-03, 301-00204-15, 301-00204-30, respectively) 
with the CardioLab II Plus Amplifier. 

6 ECG Input: The ECG input connector will accept a 10 lead ECG input cable.

7 Pressure Inputs: Four pressure inputs will each accept a pressure transducer that is calibrated to 5uV/V/
mmHg. See the Accessory Parts List for GE Healthcare Systems Information Technologies recommended 
pressure transducers.

1

4

3

7

6

5

2
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Back View of Amplifier – Generic

Back View - CardioLab II Plus Amplifier

Item Description

1 FDDI Connection to Computer: This connector will accept a FDDI type fiber optic cable. The fiber optic 
cable allows for two-way communication between the amplifier and the CardioLab system.

2 Power Input: The GE-supplied power cord connects to the Power Input.

3 Equipotentiality Terminal: The Equipotentiality Terminal is connected to earth ground 
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CardioLab II Plus Catheter Input Module

The equivalent to the Stimulus Inputs 1-4 on the Stimulator Input Cable are labeled on the 
CardioLab II Plus Amplifier as Stimulus Inputs A1, A2, B1 and B2. 

The four stimulus inputs on the Stimulator Input Cable connect to the stimulator. 

Each Catheter Input Module is broken down into two groups of 16 poles each. For example, Block 
A is broken into A (1-16) and A (17-32). 

Each pacing channel, requires one positive and one negative pole. In order to maximize the 
number of pacing channels, only one positive and one negative designation should be made for 
each group. 

For detailed instructions on how to designate pacing channels and enable pacing for particular 
sites, refer to the on-line help in the software application. 
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Accessory Parts List

Accessories for use with the CardioLab II Plus Amplifier are listed in the following table.

Input Type Accessories

ECG Conmed ECG Input Cable - 10 ft, AHA, 2003419-001

Conmed ECG Input Cable - 10 ft, IEC, 2061692-001

Conmed ECG Input Cable - 15 ft, AHA, 2003420-001

Conmed ECG Input Cable - 15 ft, IEC, 2061693-001

Conmed Leadwires - 3 ft, AHA, 2003421-001

Conmed Leadwires - 3 ft, IEC, 2003422-001

Conmed Leadwires - 3 ft, AHA, radiotranslucent, 2003423-001

Conmed Leadwires - 3 ft, IEC, radiotranslucent, 2061696-001

Conmed Leadwires - 6 ft, AHA, 2003425-001

Conmed Leadwires - 6 ft, IEC, 2061694-001

Conmed Leadwires - 6 ft, AHA, radiotranslucent, 2003424-001

Conmed Leadwires - 6 ft, IEC, radiotranslucent, 2003426-001
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*IBP accessories not sold by GE Healthcare. Transducers are 5uV/V/mmHg.

NOTE: The amplifier waveform defibrillation recovery time is five seconds.

WARNING: SHOCK HAZARD

The CardioLab II Plus amplifier defibrillation protection is only guaranteed 
when approved accessories are used. Do not use unspecified accessories.

Invasive Blood 
Pressure*

Cable: Fogg Systems 0253-2256 

Transducer: Medex NOVATRANS II MX860

Cable: Fogg Systems 0310-2256 

Transducer: Merit Med Systems MERITRANS 100 or 210

Cable: Fogg Systems 0333-2256 

Transducer: Medex TranStar MX950

Cable: Fogg Systems 0386-2256 

Transducer: Medex LogiCal MX960

Cable: Fogg Systems 0389-2256 

Transducer: BD DTX Plus

Cable: Fogg Systems 0391-2256 

Transducer: BD P23XL-1 (684000)

Cable: Fogg Systems 0395-2256 

Transducer: Edwards Lifesciences TruWave PX-600

Cable: Fogg Systems 0408-2256 

Transducer: ICU medical TRANSPAC IV

Cable: Fogg Systems 0431-2256 

Transducer: Namic PERCEPTOR Manifold [w/Integral Transducer]

Cable: Fogg Systems 0432-2256 

Transducer: Namic PERCEPTOR DT

Intracardiac ECG Catheter Input Module, 301-00202-08

Auxiliary Input Cable, 301-00205-08

Stimulator Stimulator Input Cable - 3 ft, 301-00204-03

Stimulator Input Cable - 15 ft, 301-00204-15

Stimulator Input Cable - 30 ft, 301-00204-30

Ablation Recording Stim Extender Cable - 3 ft, 2083472-001

Input Type Accessories
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CARTO System (Patient Interface Unit)

NOTE: For specific information related to the operation, troubleshooting, or repair of the CARTO 
System, refer to the OEM documentation. For information about the CardioLab/CARTO 
System interface, refer to the CardioLab Operator manual.

Item Description

1 CARTO XP PIU Output to Amplifier

Item Description

1 CARTO 3 PIU Output to Amplifier

1
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The CARTO System acquires and displays electroanatomical 3D images of heart chambers. This 
information is displayed on the CARTO System and can be exported into the CardioLab 
application.

Two connections are required: one from the CARTO System Patient Interface Unit to the 
CardioLab II Plus Amplifier and another from the CARTO System computer to the Acquisition 
system. Refer to the cabling diagram in CARTO XP System Connections on page 2-63 or CARTO 
3 System Connections on page 2-64 for specific information.

To quickly view the status of the interface, check the CARTO System icon at the bottom-right of the 
Real-Time window (a heart against a grid). The color changes, depending on the system state:

 Gray: Disconnected

 Blue: Standby

 Green: Passive Interface

 Yellow: Active Interface
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Analog Output Box

WARNING: SHOCK HAZARD

Do not connect analog input or analog output cables to patient-isolated 
equipment interfaces. This could compromise patient safety.

The analog output box distributes heart rate and blood pressure signals to multiple outputs (refer 
to the connection diagrams in TRAM/Amplifier Connections on page 2-56 and PDM/Amplifier 
Connections on page 2-57). This may be done to synch auxiliary equipment or display the 
information on a scope or other device.

Patient information comes from either the TRAMNet/PDM or the Amplifier (through the IEB) and is 
output through the output jacks on the top of the box:

 Channels 2-4 and 13-16 are switchable between the TRAMNet (Mac-Lab) and CardioLab II 
Plus Amplifier (CardioLab).

 The remaining channels are used exclusively by CardioLab.

 Channels 1-12 may be distributed to up to 4 other devices using the selector switch.

 Channel 2 is used by the PDM for ECG and Channel 13 is used by the PDM for invasive blood 
pressure.

Item Description

1 Input from TRAMNet or PDM

2 Input from Amplifier through the IEB
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Network Components

 Centricity Cardiology INW Server provides

 Network repository for patient studies

 Acquisition system and Review Workstation access to patient studies

 CVIS Server provides

 Central list management for staff, supplies and so on.

 Patient scheduling

 Patient information

 Inventory Management

 Statistical Reports

Servers

Centricity Cardiology INW G8 Server

The G8 server has the following specifications:

 Intel Xeon E5-2620 (2.00GHz/6-core/15MB/7.2GT-s QPI/95W, DDR3-1333)

 Two tiers: 

 Low: Three 450GB Drives 

 High: Six 900GB Drives

 Separate C: and D: drives (see the following chart):

 The C: drive is RAID 1

 The D: drive is RAID 5

R R A A I I D D 1 1 
( ( C C – – D D r r i i v v e e ) ) 

RRAAIIDD 15
((CD––DDrriivvee))

Mirror

Parity 

Parity 

Parity 

Parity 

Parity 

Parity 

Disk 1 Disk 2 Disk 3 Disk 4 Disk 5 Disk 6 Disk 7 Disk 8
2063076-010H EN Mac-Lab/CardioLab/Centricity Cardiology INW Service Manual 2-47



Equipment Overview
Centricity Cardiology INW G6 Server

The G6 server has the following specifications:

 Intel Xeon E5504, Quad-Core, 2.00 GHz, 4MB L3 Cache, 80W

 Two tiers: 

 Low: Three 300GB Drives (existing G6 Low servers have three 146GB drives)

 High: Six 300GB Drives

 Separate C: and D: drives (see the following chart):

 The C: drive is RAID 1

 The D: drive is RAID 5

Item Description

1 CD/DVD Drive

2 Power Switch, USB Connectors

3 Hard Drives

1 2 3

RRAAIIDD 11++00
((CC––DDrriivvee))

Mirror

DDiisskk 11 DDiisskk 22 DDiisskk 33 DDiisskk 88DDiisskk 77DDiisskk 66DDiisskk 55DDiisskk 44

Parity

Parity

Parity

Parity

Parity

Parity
2-48 Mac-Lab/CardioLab/Centricity Cardiology INW Service Manual 2063076-010H EN 



Equipment Overview
Item Description

1 CD/DVD Drive

2 Tape Drive (Some existing G6 servers, but not functional for v6.9.5. 

3 Power Switch, USB Connectors, External Monitor Connection

4 Hard Drives

Picture Name Description

HP Network Interface Card  Part Number: 2050659-001

 Function: Network Interface Card

 Location: Slot 4, 5

1 2

4

3
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Centricity Cardiology INW G5 Server

The G5 server has the following specifications:

 Intel Dual-Core Xeon 5120/1.86 GHz (1066 MHz) with 4MB Level 2 cache (2MB per core)

 Two tiers: 

 Low: Three 72 GB drives

 High: Eight 146 GB drives

 Separate C: and D: drives (see the following chart):

 The C: drive is RAID 1 mirrored 

 The D: drive is RAID 5 mirrored
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Item Description

1 Hard Drive

2 CD/DVD Drive

3 Floppy Disk Drive

4 Tape Drive (Will be present in servers, but not functional for v6.9.5. 

Picture Name Description

HP Smart Array P/400  Part Number: 2036800-038

 Function: Hard Drive RAID Controller

 Location: Slot 4, 5

1 2

3

4
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Cabling and Connections

WARNING: SHOCK HAZARD

To reduce the risk of shock and equipment damage, use safe working practices 
when servicing electrical equipment.

HP z600 Computer I/O Backplane Connections

Item Part Number Description

1 N/A PS2 Connection for Keyboard

2 N/A USB Barcode Scanner Cable

3 HP 237241-001 USB Port for Mouse

4 N/A RJ-45 Port to Network

5 N/A To Speakers

6 2025965-002 USB Port for Printer (cable to use depends on the printer)

z600 Computer
I/O Backplane

1

2

3

4

6

5
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Power Connections

NOTE: The following diagram shows the backplane of the HP z600 Acquisition system. The HP 
xw8400 uses the same connection diagram, with the exception that the Acquisition 
system connection is located at the center of the HP xw8400 backplane.

CAUTION: SYSTEM FAILURE 

To ensure an adequate system power supply, GE Healthcare recommends 
using a dedicated circuit to power the IEB.

Item Part Number Description Length

1
700775-002
700774-001

120 VAC main power in
230 VAC main power in

8 ft

2
405535-013
80274-006

2003927-001

AC power to Acquisition CPU (100V)
AC power to Acquisition CPU (120V)
AC power to HP Acquisition (230V)

6 ft
6 ft
8 ft

3
2003927-001
403689-010

AC to Local Equipment — Monitors, Printers, speakers and external 
Blu-Ray Drives
AC to Remote Monitors

8 ft
100 ft

4 2003927-001 AC power to UPS 8 ft

HP z600
 Computer
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HP z600 Video Connections

Item Part Number
Non-RoHS Part 

Number
Description Length

1 2003928-001 Real-Time display (Video 1) in to IEB 5 ft

2 2003928-001 Review display (Video 2) in to IEB 5 ft

3 2003928-001 Cardio Image display (Video 3) in to IEB 5 ft

4 2003928-001
or

2081540-001

Out to Local Cardio Image Monitor (Video 3) 5 ft
or
6 ft

5 2003928-001
or

2081540-001

Out to Local Review Monitor (Video 2) 5 ft
or
6 ft

6 2003928-001
or

2081540-001

Out to Local Real-Time monitor (Video 1) 5 ft
or
6 ft

7 2003442-003 2003442-001 Out to remote monitor (switched Video 1 or Video 2) 100 ft

8 2003442-003 2003442-001 Out to optional remote monitors (Video 1, 2, or 3) 100 ft

9a 2018060-002 2018060-001 Image capture. DVI to 5-BNC female connector cable 
plugs into either DVI plug. Only one BNC connection is 
used to connect to the image input from another system 
(9b)

9b 2003411-002 2003411-001 BNC Cable to optional imaging system 50 ft

10 N/A Matrox Quad Video Adaptor Cable (Included with Video 
Board)

7

6 4
5

8

9b

9a

2

HP z600
 Computer

Analog IEB

3

1

10
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Communications Connections

Item Part Number
Non-RoHS Part 

Number
Description Length

1 418335-002 Network Connection 10 ft

2 2018835-001

2003408-002
2042981-001
2035570-001
2042214-001

RF Ablation Device Interface. HP z600 Acquisition 
system shown.

Serial Cable
Optical Isolator
Serial Cable for CryoCath Interface
Serial Cable for RF Ablation Interface

N/A

50 ft
N/A
2 m
6 ft

3 2003587-002 2003587-001 PCI Communications (DB-44) 2.5 ft

4 2003410-001 BNC coax. Analog In (from Fluoro and so on) 30 ft

5 2003410-001 Analog Out (typically to Stimulator) 30 ft

HP z600
 Acquisition System

IEB

3

4

2

1
5
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TRAM/Amplifier Connections

WARNING: SHOCK HAZARD

Do not connect analog input or analog output cables to patient-isolated 
equipment interfaces. This could compromise patient safety.

Item Part Number Description Length

1 * 2011129-001 TRAMNet to ethernet cable 1 ft

2 * 2016133-001 Acquisition system/IEB TRAMNet cable 3 ft

3a 417335-xxx Adapter cable to TRAM. Part number varies by length ordered (-001 to -007) Varies

3b * 2016134-001 15-pin to 9-pin adapter cable 1 ft

4 417335-002 TRAM-RAC to Analog Output Box cable 51 ft

417335-003 TRAM-RAC to Analog Output Box cable 70 ft

5 2007579-001 IEB to Analog Output Box cable 15 ft

6 2003434-001 Amplifier to Acquisition system fiber optic cable 75 ft

* These cables are contained in TRAMNet Cabling Kit (PN 2018683-001)

Acquisition 
System 

3a 

4 

6 

5 

3b 

2 

1

Amplifier 

TRAM-RAC 

Analog  
Output Box 

IEB 

Patient 
Data 

Patient 
Data 

Analog 
Data 
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PDM/Amplifier Connections

WARNING: SHOCK HAZARD

Do not connect analog input or analog output cables to patient-isolated 
equipment interfaces. This could compromise patient safety.

Item Part Number Description Length

1 418335-008 Ethernet cable from PDM Base Station to Acquisition System 100 ft

2 2062755-001 CABLE, PDM TO ANOUT BOX 15 ft

2062755-002 CABLE, PDM TO ANOUT BOX 50 ft

2062755-003 CABLE, PDM TO ANOUT BOX 75 ft

2062755-004 CABLE, PDM TO ANOUT BOX 100 ft

3 2007579-001 IEB to Analog Output Box cable 15 ft

4 2003434-001 Amplifier to Acquisition system fiber optic cable 75 ft

5 2017098-001 ePort PDM to Host 5 ft

2017098-003 ePort PDM to Host 15 ft

2017098-007 ePort PDM to Host 45 ft

2017098-009 ePort PDM to Host 12.5 in

Acquisition 
System 

2

5

4

3

3b 

1

Amplifier

PDM

PDM Base Station

Analog  
Output Box 

IEB

Patient 
Data 

Patient
Data

Analog 
Data 
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Amplifier/Stimulator Connections

Typical Setup (with MicroPace)

Item Part Number
Non-RoHS Part 

Number
Description Length

1 2003411-002 2003411-001 BNC Cable. Connects back of MicroPace (ECG 1 Input) 
to back of IEB (Analog Out 1).

50 ft

2 N/A Large Cable with D-Connectors. Connects back of 
MicroPace (Auxiliary Port) to side of Catheter 
Connection Box.

N/A

3 N/A Small Cable. Connects front of MicroPace (Green 
Connection Port or in emergencies Red Connection 
Port) to side of Catheter Connection Box.

N/A

4 301-00204-03
301-00204-15
301-00204-30

Red or Black leads connect to front of Catheter 
Connection Box to Amplifier Stimulator Input.

3 ft
15 ft
30 ft

5 2003434-001 Fiber Optic Cable 75 ft

6 2003587-002 2003587-001 DB44 Connect Cable 2.5 ft

7 2003408-002 Serial Cable 50 ft

8 301-00202-08 Catheter Input Module 8 ft

IEB
Acquisition

MicroPace
Stimulator

MicroPace
CPU

Amplifier

RF
Generator

1
9

6

2
4

5

Catheter
Connection

Box

External
ECG Auxiliary

Reference

3

7

8
Catheter

Input
Module

Personality
Module
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Typical Setup (with Bloom)

Item Part Number
Non-RoHS Part 

Number
Description Length

1 2003410-001 BNC Cable. Connects Bloom to back of IEB 30 ft

2 N/A Large Cable with Square Connectors. Connects back of 
Bloom to back of Patient Isolation Box.

N/A

3 N/A Small Cable. Connects front of Patient Isolation Box to 
side of Catheter Connection Box.

N/A

4 301-00204-03
301-00204-15
301-00204-30

Red or Black leads connect to front of Catheter 
Connection Box to Amplifier Stimulator Input.

3 ft
15 ft
30 ft

5 2003434-001 Fiber Optic Cable 75 ft

6 2003587-002 2003587-001 DB44 Connect Cable 2.5 ft

7 2003408-002 Serial Cable 50 ft

8 301-00202-08 Catheter Input Module 8 ft

IEBAcquisition

Bloom

Patient
Isolation

Box

Amplifier

RF
Generator

Battery Battery

16

2

4

5

Catheter
Connection

Box

External
ECG Auxiliary

Reference

3

7

8
Catheter

Input
Module

Personality
Module
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Equipment Setup

Item Part Number Description

C and 
C1

N/A Bloom (This is a typical example. Specific equipment may vary by location). Connects to 
the IEB (not shown) via the External Input BNC jack on the back (C1) and the Patient 
Isolation Box (D) via a large cable with square connectors. (See next section for detail.)

D N/A Patient Isolation Box. Rear connection to Bloom (C1) via large cable with square 
connectors. Front connection to Catheter Connection Box (E). Front panel provides 
access to internal batteries.

E N/A Catheter Connection Box. Side connection to the Patient Isolation Box (D) front 
connector. Red and Black leads connect from the front to the Amplifier (F) Stim Input.

F 2003232-00X NOTE: For 2003232-00X, X = 1, 2, 3, or 4.

Amplifier connected to 

 (1) External ECG connection

 (2) Catheter Input Module

 (3) Auxiliary Reference Cable

 (4) Catheter Connection Box

G 301-00202-08 Catheter Input Module. Catheter leads (not shown) plug into the block end. Connector on 
other end plugs into the Amplifier (4) Cardiac Input (Labeled A, B, C and so on).

1 N/A Bloom connection to IEB (BNC cable not shown).

2 N/A Bloom connection to Patient Isolation Box.

3 N/A Patient Isolation Box to Catheter Input Module Cable.

4 301-00204-03 Catheter Connection Box to Amplifier Cable.

5 2003425-001 External ECG Connections. Colored leads connect to patient. Connector on other end 
connects into the Amplifier (4) ECG Input. 

6 301-00205-08 Auxiliary Reference Cable. Plugs into the Amplifier (4) Auxiliary Input.

7 2003420-001 ECG Trunk Cable.
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Bloom (Connection Detail)

Item Description

1 External Input: BNC connection to the IEB (cable not shown).

2 J20: Connection to Patient Isolation Box (large square connector).
2063076-010H EN Mac-Lab/CardioLab/Centricity Cardiology INW Service Manual 2-61



Equipment Overview
Audio

3 

2 
6 

5 

Local 
Left 

Speaker 

Local 
Right 

Speaker 

Remote 
Left 

Speaker 

Remote 
Right 

Speaker 

IEB 

4 
4 

to 60601-1
Certified 
Power 
Supply 

5 

z600

1

Item Part Number Description

1 2018218-001 Y-connector (Connects to green jack on HP. One side to local speakers, the other to remote speakers.)

HP z600 green speaker jack is located just above PCI card slots.

2 2018219-001 Audio Isolator

3 2078970-001 Speaker Set

4 2078970-001 Speaker Power Supply (included with speakers)

5 2003927-001

2003625-001

IEC (m) to IEC (f) Power Cord (8 ft)

NEMA to IEC Converter Cable (1 ft)

WARNING 
SHOCK HAZARD — Remote speakers must be powered by a 60601-1 certified power supply.

6 2011108-002 Speaker cable (50 ft)
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CARTO XP System Connections

NOTE: Not all CARTO XP System equipment or connections are shown. Refer to the CARTO XP 
System Installation Manual for additional information.

 

Item Part Number Description

1 2018217-001 CARTO XP System Crossover Network Cable (25 ft)

For HP z600, use the right-hand port on the NIC Adapter Board.

2 2015944-001 ECG Quick Connect Cable (ECG OUT connector on the PIU to the ECG connector on 
the Amplifier)

3 2024507-001 CardioLab II Plus to CARTO IC/Stim Cable

Acquisition 
 System 

1 2 

ECG OUT 

CARTO XP System  
Computer 

Amplifier 

Catheter 
Input 

Module 

CARTO XP System Patient 
Interface Unit 

3 

z600
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CARTO 3 System Connections

The CARTO 3 System may be connected in one of two ways:

 Configuration 1 (refer to the following figure) to acquire:

 HIS, RVA and HRA signals with the Catheter Input Module.

 Surface ECG via the CARTO 3 system using the ECG connectivity cable.

NOTE: Not all CARTO 3 System equipment or connections are shown. Refer to the CARTO 3 
System Installation Manual for additional information.

Item Part Number Description

1 301-00202-08 Catheter Input Module

2 2003232-00X CardioLab II Plus Amplifier

3 N/A ECG Connectivity Cable (Biosense Webster CA-5400-19)

4 N/A CARTO 3 PIU

NOTE: For 2003232-00X, X = 1, 2, 3, or 4.

3

1 2

4
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 Configuration 2 (refer to the following figure) to acquire:

 HIS, RVA and HRA signals, Navistar Cath (mapping), Coronary Sinus, or other signals via 
the CARTO 3 system using the IECG connectivity cable.

 Surface ECG via the CARTO 3 system using the ECG connectivity cable.

NOTE: The CardioLab II Plus Amplifier remains connected to all body surface leads even if the 
CARTO 3 PIU is turned off.

NOTE: Not all CARTO 3 System equipment or connections are shown. Refer to the CARTO 3 
System Installation Manual for additional information.

Item Part Number Description

1 N/A IECG Connectivity Cable (Biosense Webster CA-5400-21)

2 2003232-00X CardioLab II Plus Amplifier

3 301-00202-08 Catheter Input Module

4 N/A ECG Connectivity Cable (Biosense Webster CA-5400-19)

5 N/A Stimulation Cables, 3m (Biosense Webster J-B-PACINT-AUX / CA-4041-03)

6 N/A CARTO 3 PIU Front

7 N/A CARTO 3 PIU Back

NOTE: For 2003232-00X, X = 1, 2, 3, or 4.

4

1 2

7

3

6

5

5
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Item Manufacturer Part Number Description

1 GE 2018217-001 CAT5 Crossover Cable (25 ft).

Acquisition
 System

1

CARTO System 
Computer
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Vivid Connections - CardioLab

WARNING: SHOCK HAZARD

Do not connect analog input or analog output cables to patient-isolated 
equipment interfaces. This could compromise patient safety.

Item Part Number
Non-RoHS Part 

Number
Description Length

1a 2030703-001 DVI to VGA Connector

NOTE: This adapter must be used for proper image 
display with the Vivid.

N/A

1b 2032340-002 2032340-001 Video Cable 100 ft *

1c 2047596-001 VGA Video Connection Extender N/A

2a 2031919-001 ECG Analog Output Cable 100 ft *

2b 2032673-001 Vivid to Mac-Lab/CardioLab ECG Cable 600 mm

2c 2049942-001 Ferrite Filter (locate 50 mm from Vivid side of ECG 
cable)

N/A

3a 2031218-001 USB to RS485 Converter N/A

3b 2031215-001 Remote Trackball Cable 100 ft *

4 N/A Ethernet Cable (Can be connected to hospital network 
in the procedure room or run through conduit to the 
control room.)

N/A

* Run through conduit.

HP z600
 Computer

Vivid Remote
Trackball

2a 2b

3b

3a 4

1b

1a

1c

2c

IEB

Vivid
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Vivid Connections - Mac-Lab with TRAM

WARNING: SHOCK HAZARD

Do not connect analog input or analog output cables to patient-isolated 
equipment interfaces. This could compromise patient safety.

Item Part Number
Non-RoHS Part 

Number
Description Length

1a 2030703-001 DVI to VGA Connector

NOTE: This adapter must be used for proper image 
display with the Vivid.

N/A

1b 2032340-002 2032340-001 Video Cable 100 ft *

1c 2047596-001 VGA Video Connection Extender N/A

2a 2031919-001 ECG Analog Output Cable 100 ft *

2b 2032673-001 Vivid to Mac-Lab/CardioLab ECG Cable 600 mm

2c 2049942-001 Ferrite Filter (locate 50 mm from Vivid side of ECG 
cable)

N/A

3a 2031218-001 USB to RS485 Converter N/A

3b 2031215-001 Remote Trackball Cable 100 ft *

4 N/A Ethernet Cable (Can be connected to hospital network 
in the procedure room or run through conduit to the 
control room.)

N/A

5 417335-002 TRAM-RAC to Analog Output Box Cable 51 ft

417335-003 TRAM-RAC to Analog Output Box Cable 70 ft

* Run through conduit.

Vivid Remote 
Trackball 

2a 

2b 

3b 

3a 
4 

1b1a

1c

2c 

Acquisition 
 System 

IEB 

Analog Output Box 

TRAM-RAC 

IC 

6a 

6b 

5 

Vivid 
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Vivid Connections - Mac-Lab with PDM

WARNING: SHOCK HAZARD

Do not connect analog input or analog output cables to patient-isolated 
equipment interfaces. This could compromise patient safety.

Item Part Number
Non-RoHS Part 

Number
Description Length

1a 2030703-001 DVI to VGA Connector

NOTE: This adapter must be used for proper image 
display with the Vivid.

N/A

1b 2032340-002 2032340-001 Video Cable 100 ft *

1c 2047596-001 VGA Video Connection Extender N/A

2a 2011355-001 BNC to Phono to connect to the top of the breakout box 10 ft *

2b 2031919-001 ECG Analog Output Cable 100 ft *

2c 2049942-001 Ferrite Filter (locate 50 mm from Vivid side of ECG 
cable)

N/A

2d 2032673-001 Vivid to Mac-Lab/CardioLab ECG Cable 600 mm

3a 2031218-001 USB to RS485 Converter N/A

3b 2031215-001 Remote Trackball Cable 100 ft *

4 N/A Ethernet Cable (Can be connected to hospital network 
in the procedure room or run through conduit to the 
control room.)

N/A

5 2062755-001 CABLE, PDM TO ANOUT BOX 15 ft

2062755-002 CABLE, PDM TO ANOUT BOX 50 ft

2062755-003 CABLE, PDM TO ANOUT BOX 75 ft

2062755-004 CABLE, PDM TO ANOUT BOX 100 ft

* Run through conduit.

Vivid Remote
Trackball

2a

2b
3b

3a
4

2d

2c

Acquisition
 System

Analog Output Box

PDM

IC

5

Vivid

1b1a

1c
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CARTO/CardioLab/Vivid Integration

NOTE: The router is customer supplied per the specifications in the Mac-Lab/CardioLab/
Centricity Cardiology INW Server Pre-Installation Manual (PN 2063076-007).

Item Part Number
Non-RoHS Part 

Number
Description Length

1 2032340-002 2032340-001 Video Cable (VGA Out on Vivid to Splitter) 100 ft *

2 5380478 Isolated VGA-1: 2-splitter Kit (Supplied by Ultrasound) 

DVI cables from the splitter kit connect to CardioLab 
and CARTO Solios video boards to DVI IN on splitter 

N/A

3 2018217-001 CARTO System Crossover Network Cable 25 ft

4 N/A Ethernet Cable N/A

* Run through conduit.

CARTO™ 
System  Computer 

4 

4 

Hospital Network 

VGA Splitter 

Router 

3 

2 
2 

4 

4 

Acquisition
 System

Vivid 

1 
2-70 Mac-Lab/CardioLab/Centricity Cardiology INW Service Manual 2063076-010H EN 



Equipment Overview
Review Workstations

Review Workstation Connections

GE Client Workstation is shown. 

NOTE: The DASH can also be connected to the isolation transformer as shown in the DASH 
connection diagram (DASH Connection on page 2-73).

Item Part Number Description Length

1 80274-006 Power Cord (connect to a dedicated power supply or an isolated circuit) 6 ft

2 2003927-001 Power Cord 8 ft

3 2003927-001 Power Cord 8 ft

4a N/A DVI to VGA Adapter N/A

4b 2003928-001 Video Cable 5 ft

4b4a

2

1

3

Isolation Transformer

Monitor

Review Workstation
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Solar Connection

NOTE: The Solar and DASH monitors must only be connected to Pre/Post workstations. Do not 
connect a Solar or DASH monitor to an Acquisition, Nurse's, or Remote workstation.

Item Part Number Description Length

1 2003408-001 DB9M to DB9F Straight Thru 50 ft

Review Workstation
I/O Backplane

Solar Monitor
1
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DASH Connection

NOTE: The Solar and DASH monitors must only be connected to Pre/Post workstations. Do not 
connect a Solar or DASH monitor to an Acquisition, Nurse's or Remote workstation.

Item Part Number Description Length

1 N/A Ethernet N/A

2a 418335-002 RJ45 Cable 10 ft

2b 420915-013 DIDCA ASM PC Interface Autoport N/A

3 N/A Auxiliary N/A

Review Workstation
I/O Backplane

1

3

2a

2b

DASH Monitor
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Software

Operating System

Acquisition system/Review Workstations: Windows XP with Service Pack 3.

Software Only Workstation: Windows XP OS with SP3 or Windows 7 Professional with SP1.

Centricity Cardiology INW Server: Windows Server 2008 R2 with SP1.

Database

Acquisition system/Review Workstations: Microsoft SQL Server 2008 Standard Edition with 
SP3.

Software Only Workstations: Microsoft SQL Server 2008 SP3 Express Edition.

Centricity Cardiology INW Server: Microsoft SQL Server 2008 Standard Edition with SP3.

Application Software

Acquisition system/Review Workstations: Microsoft Office Word 2007 SP3, including Shared 
Features and Office Tools.

Software Only Workstations: Microsoft Office Word 2007 SP3, including Shared Features and 
Office Tools.
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Maintenance
Mac-Lab/CardioLab Service Performance Testing

WARNING: SHOCK HAZARD

To reduce the risk of shock and equipment damage, use safe working practices 
when servicing electrical equipment.

Service performance testing should always be done after any service work is performed on the 
Mac-Lab / CardioLab / Centricity Cardiology INW system in order to ensure proper system 
functioning. The purpose of this section is to provide guidelines for proper service performance 
testing based on the service/repair that was completed. This section can also be printed and used 
as a form to provide objective evidence of the testing performed. 

The FRU Checkout Procedure Table on page 3-3 provides a matrix to be followed in determining 
the tests and checks to perform based on the FRU replaced/service performed. Go to the 
appropriate row in the table and follow across that row’s column information to determine:

 Tools Recommended to perform testing

 Visual Inspection and Cleaning to perform

 Checkout Procedures tests(s) to perform

Detailed lists of the tools/tests that are referenced in the FRU Checkout Procedure Table are found 
in the sections immediately following it.

Configuration

Customer _________________________________  SR Number __________________ Date ___________

Number of Mac-Labs____ CardioLabs____ ComboLabs____ Workstations____ SW Only Workstations____

Network Type____ Number of INW Servers____ Number of DMS Servers____ Number of DMS Clients____
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FRU Checkout Procedure Table

FRU Description
Tools 

Recommended

Visual 
Inspection/
Cleaning

Checkout Procedure

Mac-Lab CardioLab ComboLab

Computer 1, 3, 4, 7 1, 2, 4, 5, 7 page 3-22, 
page 3-31

page 3-24, 
page 3-31

page 3-22, 
page 3-24, 
page 3-31

Computer Hard Drive 1, 2, 3, 4, 7 ALL page 3-22, 
page 3-31

page 3-24, 
page 3-31

page 3-22, 
page 3-24, 
page 3-31

Drive Replaced (DVD, SD 
Drive)

1, 2, 3, 4, 7 ALL page 3-22 page 3-24 page 3-22, 
page 3-24

PCI Slot Card Replaced (Video, 
PCI Comm, Dual NIC Adapter)

1, 2, 3, 4, 7 ALL page 3-22 page 3-24 page 3-22, 
page 3-24

TRAMNet to Ethernet Adapter 
Board

1, 2, 3, 4, 7 ALL page 3-22, 
page 3-26

page 3-24, 
page 3-26

page 3-22, 
page 3-24, 
page 3-26

Image Capture Board 1, 2, 3, 4, 5, 7 ALL page 3-22, 
page 3-26

page 3-24, 
page 3-26

page 3-22, 
page 3-24, 
page 3-26

Internal Computer Component 
(Memory, Power Supply, Fan)

1, 2, 3, 4, 7 ALL page 3-22 page 3-24 page 3-22, 
page 3-24

External Computer Component 
(Mouse, Keyboard, Bar Code 
Scanner)

1, 2, 3, 4, 7 ALL page 3-22 page 3-24 page 3-22, 
page 3-24

IEB (Vid Mux, I/O Board, Power 
Distribution/Supply, UPS)

1, 2, 3, 4, 7 1, 2, 3, 4, 6, 7 page 3-22, 
page 3-26

page 3-24, 
page 3-26

page 3-22, 
page 3-24, 
page 3-26

Monitor 1, 7 2, 7 page 3-22 page 3-24 page 3-22, 
page 3-24

Printer 1, 7 2, 7 page 3-22, 
page 3-27

page 3-24, 
page 3-27

page 3-22, 
page 3-24, 
page 3-27

PDM/PDM Base Station 1, 3, 4, 7 1, 2, 4, 7 page 3-22, 
page 3-26

page 3-24, 
page 3-26

page 3-22, 
page 3-24, 
page 3-26

TRAM/TRAMNet 1, 3, 4, 7 1, 2, 4, 7 page 3-22, 
page 3-26

page 3-24, 
page 3-26

page 3-22, 
page 3-24, 
page 3-26

Amplifier 3, 5, 7 2, 5, 7 n/a page 3-24 page 3-22, 
page 3-24

CARTO (cabling) 5, 7 1, 5, 7 n/a page 3-24, 
page 3-28

page 3-22, 
page 3-24, 
page 3-28
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Audible Indicators 7 2, 7 page 3-22, 
page 3-28

page 3-24, 
page 3-28

page 3-22, 
page 3-24, 
page 3-28

RF Ablation (Serial Cable, Opto-
isolator)

1, 7 1, 7 n/a page 3-24, 
page 3-28

page 3-22, 
page 3-24, 
page 3-28

Stimulator 1, 3, 6, 7, 8 1, 2, 7 n/a page 3-24, 
page 3-28

page 3-22, 
page 3-24, 
page 3-28

DASH/Solar 1, 5, 7 1, 2, 7 page 3-22, 
page 3-28

page 3-24, 
page 3-28

page 3-22, 
page 3-24, 
page 3-28

RMOT 5, 7 1, 2, 7 page 3-22, 
page 3-29

page 3-24, 
page 3-29

page 3-22, 
page 3-24, 
page 3-29

Analog Out 1, 7 1, 7 page 3-22, 
page 3-29

page 3-24, 
page 3-28, 
page 3-29

page 3-22, 
page 3-24, 
page 3-28, 
page 3-29

INW Server 1, 5, 7 1, 2, 3, 7 page 3-22, 
page 3-29, 
page 3-31

page 3-24, 
page 3-29, 
page 3-31

page 3-22, 
page 3-24, 
page 3-29, 
page 3-31

INW SERVER PARTS (MEMORY, 
DISK RAID ADAPTER, DISK DRIVE, 
TAPE DRIVE, UPS, UI INTERFACE)

1, 2, 5, 7 1, 2, 3, 7 page 3-22, 
page 3-29

page 3-24, 
page 3-29

page 3-22, 
page 3-24, 
page 3-29

NO PARTS REPLACED 7 1, 2, 3, 4, 5, 7 page 3-22 page 3-24 page 3-22, 
page 3-24

UPDATES/UPGRADES 7 1, 2, 3, 4, 5, 7 page 3-22 page 3-24 page 3-22, 
page 3-24

FRU Description
Tools 

Recommended

Visual 
Inspection/
Cleaning

Checkout Procedure

Mac-Lab CardioLab ComboLab
3-4 Mac-Lab/CardioLab/Centricity Cardiology INW Service Manual 2063076-010H EN 



Maintenance
Tools Recommended

1. Standard hand tools (PN N/A)

a. Multi-headed Screwdriver

b. Allen Wrenches (English and Metric)

c. Dykes

d. Needle Nose Pliers

e. Crescent Wrench

f. Tie Wraps

2. Service manual (PN 2063076-010) for reference only

3. Installation manual (PN 2063076-008, if available) for reference only

4. Micropace Quick Installation Manual (PN MP3156) for reference only

5. Patient simulator (MARQIII Simulator - PN 2032042-001 or equivalent)

6. Portable Dry Vacuum Cleaner ESD, HEPA (PN 46-194427P392), Filter 
(PN 46-194427P393) (HEPA Certified, if available)

7. ESD Mat/Strap

8. Test LEDs for Stimulator

Visual Inspection/Cleaning

Inspect the following for excess wear and/or any visual signs of damage 
and/or clean as indicated:

1. Network/Serial/Communication cabling 

2. AC power cord(s)/video cables 

3. Inspect/Remove dust from fans on all computers 

4. TRAM/PDM cables

5. CardioLab II Plus Amplifier cables

6. Clean dust from all internals

7. Inspect external housing/case of all system components for damage
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Mac-Lab/CardioLab System Electrical Safety Testing

Introduction

Electrical safety tests provide a method of determining the safety of the final configured system 
and helping to ensure no hazards exist for the patient or operator. 

GE Healthcare recommends that safety tests be performed:

 Upon initial installation of the system, after all additional third party devices are connected 

 Once a year thereafter

 After any upgrade

 Any time a part is repaired or replaced 

 Any time another third party system/device is connected

When connecting to additional third party devices, it is recommended to also perform the electrical 
safety tests on those devices as instructed by the manufacturer after the final configuration is in 
place to ensure a safe final system configuration.

WARNING: These tests should only be performed by qualified personnel.

NOTE: These test procedures do not cover TRAM-RAC, TRAM or CO2 module testing. Refer to 
the service documentation accompanying those devices for required procedures.

Setup

Testing must be performed on the final system configuration. This includes all connections to third 
party devices (CARTO, stimulator and so on). 

The system will have multiple connections to the mains supply:

 IEB 

 Isolation transformer 

 CardioLab II Plus amplifier

 TRAM-RAC or PDM Base Station

Each mains connected device must be tested separately. TRAM-RAC procedures are described in 
the service documentation accompanying the TRAM-RAC.

Before beginning testing, confirm that the complete system is set up properly and is functional. 
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Test Equipment

The following test equipment is required.

 Safety Analyzer with the following features:

 Digital Multimeter (DMM)

 Leakage current tester equivalent to circuits shown in procedures

 At least one ECG lead connector

 ECG cable (CardioLab II Plus amplifier testing only - included with amplifier)

 Leadwires (CardioLab II Plus amplifier testing only - included with amplifier)

 ECG Test Body (PDM testing only)

 SpO2 Test Body - Nellcor or Masimo (PDM testing only)

The schematics in each section provide a general understanding of the test equipment. Actual 
configuration of test equipment may vary.

Test Records

Record the results of all tests. Keep records for reference when performing future tests. Refer to 
Electrical Safety Test Results Record on page D-14 for a blank record sheet.
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Tests

If any test limits are exceeded, the device under test fails. Contact GE Healthcare Technical 
Support.

Refer to the Safety Analyzer instructions for specific test equipment use information.

Some tests only apply to equipment in the patient environment. The patient environment is defined 
by IEC 60601-1-1 as “any volume in which intentional or unintentional contact can occur between 
patient and parts of the system or between patient and other persons touching parts of the 
system.” This is further defined as anything less than or equal to 1.5 m away from the surface of 
the patient table, as shown in the following illustration.

Inspection

Verify that power outlets are wired correctly per the country's electrical code standard before 
performing electrical safety tests. The results of the electrical safety tests may be inaccurate if a 
properly wired power outlet is not used.

Verify all power cables are securely connected and have no visible signs of damage. Damaged 
cables must be replaced.

2.5 m

1.5 m1.5 m

1.5 m
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Protective Earthing

Devices Under Test

This test applies to all mains-powered equipment:

 IEB 

 Isolation transformer 

 CardioLab II Plus amplifier

 PDM Base Station

Setup

Configure the test circuit as shown in the following illustration.

NOTE: The measuring device (MD) represents the safety analyzer.

LINE

NEUTRAL

EARTH

Device
Under
Test

PEMD*

Power Cord
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Procedure

1. Power up the entire system, then set the power switch of the device under test to Off.

2. Connect the power cord of the device under test to the power receptacle on the Safety 
Analyzer. 

3. Set the power switch of the device under test to On. 

4. Measure the resistance between the protective earth pin in the mains plug (ground pin in 
power cord) and each exposed metal surface on the device under test.

5. Set the power switch of the device under test to Off.

NOTE: It is not required to measure the resistance between the protective earth pin and exposed 
metal surfaces of devices powered by the IEB or the isolation transformer. Protective 
earthing requirements do not apply to devices powered by isolated power sources, 
because these devices do not rely on their protective earth connection for safety 
purposes.

Acceptance Criteria

Resistance must read 0.2 ohms or less for devices and their power cords.
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Earth Leakage Current

Devices Under Test

This test applies to all mains-powered equipment:

 IEB 

 Isolation transformer 

 CardioLab II Plus amplifier

 PDM Base Station

Setup

Configure the test circuit as shown in the following illustration.

NOTE: The measuring device (MD) represents the network and voltage measuring instrument 
and its frequency characteristics per IEC 60601-1.

Leakage Tester
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EARTH
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Procedure

1. Power up the entire system, then set the power switch of the device under test to Off.

2. Connect the power cord of the device under test to the power receptacle on the Safety 
Analyzer.

3. Set the power switch of the device under test to On. 

4. Configure the leakage tester switches to the Single Fault Condition:

a. Earth -Open

b. Polarity - Normal

5. Record the leakage current.

6. Configure the leakage tester switches to the Single Fault Condition:

a. Earth -Open

b. Polarity - Reverse

7. Record the leakage current.

8. Set the power switch of the device under test to Off.

Acceptance Criteria

Leakage current readings must be less than or equal to the following limits:

 300 µA for systems requiring compliance to UL 60601-1

 500 µA for systems requiring compliance to IEC 60601-1
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Enclosure Leakage current

Devices Under Test

This test applies to all mains-powered equipment:

 IEB 

 Isolation transformer 

 CardioLab II Plus amplifier

 PDM Base Station

Only exposed conductive surfaces located in the Patient Environment are required to be tested for 
leakage current limits.

Setup

Configure the test circuit as shown in the following illustration.

NOTE: The measuring device (MD) represents the network and voltage measuring instrument 
and its frequency characteristics per IEC 60601-1.

Procedure

1. Power up the entire system, then set the power switch of the device under test to Off.

2. Connect the power cord of the device under test to the power receptacle on the Safety 
Analyzer. 

3. Set the power switch of the device under test to On. 

4. Configure the leakage tester switches to the Single Fault Condition:

a. Earth -Open

b. Polarity - Normal

Leakage Tester
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 M
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Power Cord
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5. Connect the probe to:

 an exposed conductive area on the device under test, if the device is located in the patient 
environment (Example: CardioLab II Plus Amplifier, Isolation Transformer or IEB in patient 
area), or

 an exposed conductive area on a component in the patient environment powered by the 
device under test (applies to IEB and isolation transformer only) (Example: remote 
monitors in the patient environment powered by the isolation transformer; CardioLab II 
Plus Amplifier in the patient environment powered by the IEB)

6. Record the leakage current.

7. Configure the leakage tester switches to the Single Fault Condition:

a. Earth -Open

b. Polarity - Reverse

8. Record the leakage current.

9. Configure the leakage tester switches to the Normal Condition:

a. Earth -Closed

b. Polarity - Reverse

10. Record the leakage current.

11. Configure the leakage tester switches to the Normal Condition:

a. Earth -Closed

b. Polarity - Normal

12. Record the leakage current.

13. Repeat the previous tests for multiple points on the device under test:

 exposed conductive areas on the device under test, if the device is located in the patient 
environment (Example: CardioLab II Plus Amplifier, Isolation Transformer or IEB in patient 
area)

 exposed conductive areas on a component in the patient environment powered by the 
device under test (applies to IEB and isolation transformer only) (Example: remote 
monitors in the patient environment powered by the isolation transformer; CardioLab II 
Plus Amplifier in the patient environment powered by the IEB)

14. Set the power switch of the device under test to Off.

Repeat this procedure as necessary for each device under test to measure the leakage current of 
the exposed conductive areas in the patient environment. 

Acceptance Criteria

Leakage current readings for equipment must be less than or equal to the following limits:

 Single Fault Condition:

 300 µA for systems requiring compliance to UL 60601-1

 500 µA for systems requiring compliance to IEC 60601-1

 Normal Condition: 100 µA
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Patient (Source) Leakage Current — CardioLab II Plus Amplifier

Device Under Test

This section applies only to the CardioLab II Plus Amplifier. Refer to Patient (Source) Leakage 
Current — PDM on page 3-17 for PDM tests.

NOTE: The CardioLab II Plus Amplifier patient connections are multiple functions of the same 
applied part.

Setup

Configure the test circuit as shown in the following illustration.

NOTE: The measuring device (MD) represents the network and voltage measuring instrument 
and its frequency characteristics per IEC 60601-1.

Procedure

1. Connect the power cord of the device under test to the power receptacle on the Safety 
Analyzer.

2. Connect the following accessories to the amplifier:

 ECG cable

 Leadwires

3. Connect the leadwire ends to the ECG lead connections on the Safety Analyzer.

NOTE: It is possible that not all leadwire ends will have a connection point on the Safety 
Analyzer. The CardioLab II Plus amplifier ECG inputs utilize the same isolation circuit, so 
testing of one represents testing of all.

4. Set the power switch of the device under test to On. 
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5. Configure the leakage tester switches to the Single Fault Condition:

a. Earth -Open

b. Polarity - Normal

6. Record the leakage current.

7. Configure the leakage tester switches to the Single Fault Condition:

a. Earth -Open

b. Polarity - Reverse

8. Record the leakage current.

9. Configure the leakage tester switches to the Normal Condition:

a. Earth -Closed

b. Polarity - Reverse

10. Record the leakage current.

11. Configure the leakage tester switches to the Normal Condition:

a. Earth -Closed

b. Polarity - Normal

12. Record the leakage current.

13. Set the power switch of the device under test to OFF.

NOTE: The results of testing the ECG inputs of the CardioLab II Plus amplifier represent results 
for all of the amplifier applied parts because they utilize the same isolation circuit.

Acceptance Criteria

Leakage current readings must be less than or equal to the following limits:

 Single Fault Condition: 50 µA

 Normal Condition: 10 µA
3-16 Mac-Lab/CardioLab/Centricity Cardiology INW Service Manual 2063076-010H EN 



Maintenance
Patient (Source) Leakage Current — PDM

Device Under Test

This section applies only to the PDM powered by the Base Station. Refer to Patient (Source) 
Leakage Current — CardioLab II Plus Amplifier on page 3-15 for CardioLab II Plus Amplifier tests.

Setup

Configure the test circuit as shown in the following illustration.

NOTE: The measuring device (MD) represents the network and voltage measuring instrument 
and its frequency characteristics per IEC 60601-1.

Procedure

1. Connect the power cord of the device under test to the power receptacle on the Safety 
Analyzer.

2. Connect the ECG Test Body to the ECG/RESP connector on the PDM.

3. Set the power switch of the device under test to On. 

4. Configure the leakage tester switches to the Single Fault Condition:

a. Earth -Open

b. Polarity - Normal

5. Record the leakage current.

6. Configure the leakage tester switches to the Single Fault Condition:

a. Earth -Open

b. Polarity - Reverse
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2063076-010H EN Mac-Lab/CardioLab/Centricity Cardiology INW Service Manual 3-17



Maintenance
7. Record the leakage current.

8. Configure the leakage tester switches to the Normal Condition:

a. Earth -Closed

b. Polarity - Reverse

9. Record the leakage current.

10. Configure the leakage tester switches to the Normal Condition:

a. Earth -Closed

b. Polarity - Normal

11. Record the leakage current.

12. Set the power switch of the device under test to OFF.

13. Remove the ECG Test Body and repeat the procedure with the appropriate SpO2 Test Body 
connected to the blue SpO2 connector of the PDM.

NOTE: The results of testing the SpO2 input of the PDM represent results for the Temp/CO and 
IBP applied parts because they utilize the same isolation circuit.

Acceptance Criteria

Leakage current readings must be less than or equal to the following limits:

 Single Fault Condition: 50 µA

 Normal Condition: 10 µA

Patient (Sink) Leakage Current — CardioLab II Plus Amplifier

Device Under Test

This section applies only to the CardioLab II Plus Amplifier. Refer to Patient (Sink) Leakage 
Current — PDM on page 3-20 for tests for the PDM.

NOTE: The CardioLab II Plus Amplifier patient connections are multiple functions of the same 
applied part.

Setup

Configure the test circuit as shown in the following illustration.
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NOTE: The measuring device (MD) represents the network and voltage measuring instrument 
and its frequency characteristics per IEC 60601-1.

Procedure 

1. Connect the power cord of the device under test to the power receptacle on the Safety 
Analyzer. 

2. Connect the following accessories to the amplifier:

 ECG cable

 Leadwires

3. Connect the leadwire ends to the ECG inputs on the Safety Analyzer.

NOTE: It is possible that not all leadwire ends will have a connection point on the Safety 
Analyzer. The CardioLab II Plus amplifier ECG inputs utilize the same isolation circuit, so 
testing of one represents testing of all.

4. Set the power switch of the device under test to On. 

5. Use the Safety Analyzer to apply mains voltage to the ECG lead connections.

WARNING: SHOCK HAZARD

The Patient (sink) Leakage Current test causes high voltages on the test body. 
Do not touch conductive regions of the safety analyzer.

6. Configure the leakage tester switches to:

a. Earth -Closed
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b. Polarity - Normal

7. Record the leakage current.

8. Configure the leakage tester switches to: 

a. Earth -Closed

b. Polarity - Reverse

9. Record the leakage current.

10. Set the power switch of the device under test to Off.

NOTE: The results of testing the ECG inputs of the CardioLab II Plus amplifier represent results 
for all of the amplifier applied parts because they utilize the same isolation circuit.

Acceptance Criteria

Leakage current readings must be less than or equal to 50 µA. 

Patient (Sink) Leakage Current — PDM

This test applies only to the PDM. Refer to Patient (Sink) Leakage Current — CardioLab II Plus 
Amplifier on page 3-18 for tests for the CardioLab II Plus Amplifier.

Setup

Configure the test circuit as shown in the following illustration.

NOTE: The measuring device (MD) represents the network and voltage measuring instrument 
and its frequency characteristics per IEC 60601-1.
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Procedure 

1. Connect the power cord of the device under test to the power receptacle on the Safety 
Analyzer. 

2. Connect the ECG Test Body to the ECG/RESP connector on the PDM.

3. Set the power switch of the device under test to On. 

4. Use the Safety Analyzer to apply mains voltage to the ECG lead connections.

WARNING: SHOCK HAZARD

The Patient (sink) Leakage Current test causes high voltages on the test body. 
Do not touch conductive regions of the safety analyzer.

5. Configure the leakage tester switches to:

a. Earth -Closed

b. Polarity - Normal

6. Record the leakage current.

7. Configure the leakage tester switches to: 

a. Earth -Closed

b. Polarity - Reverse

8. Record the leakage current.

9. Set the power switch of the device under test to Off.

10. Remove the ECG Test Body and repeat the procedure with the appropriate SpO2 Test Body 
connected to the blue SpO2 connector of the PDM.

NOTE: The results of testing the SpO2 input of the PDM represent results for Temp/CO and IBP 
applied parts because they utilize the same isolation circuit.

Acceptance Criteria

Leakage current readings must be less than or equal to 50 µA. 
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Checkout Procedure

Use this manual and the Mac-Lab, CardioLab and/or Centricity Cardiology INW Operator’s 
manual(s) for reference. Perform the following procedures for all applicable options. Ensure all test 
studies created are deleted upon checkout completion.

Mac-Lab SCOP (Standard Checkout Procedure)

1. Verify the Mac-Lab module is selected. Create a new study (select the New Study icon). Enter 
the required fields: patient last name, first name and medical record number.

2. If applicable, select a user for user tracking. Verify the current user is displayed in the Log 
window title.

3. If applicable, join the test study from a Nurse’s Review Workstation by highlighting the test 
study and select the Review Study icon.

4. If applicable, select a different user for user tracking. Verify the current user is displayed in the 
Log window title.

5. Add a Macro (Windows > Macro) to the event log on the Acquisition. If applicable, verify that 
input comes across to the Nurse’s Review Workstation.

6. Add a list item to the study. For example, add a complication or staff member on the 
Acquisition (Study > Staff). If applicable, verify that the item comes across on the Nurse’s 
Review Workstation.

7. If applicable, add Macro and list item to the study from a Nurse’s Review Workstation and 
verify that items come across to the Acquisition.

8. Connect the test cables from the patient simulator to the TRAM/PDM Module. The green 
connector is for ECG, red connectors for invasive blood pressures, blue connector for SpO2, 
black connector for non-invasive blood pressure (NIBP) and brown connector for cardiac 
output.

9. Verify that ECG traces display at 60 bpm, 120 bpm and 180 bpm for all 12 leads.

10. Verify blood pressure traces at two measurement points on P1, P2 and P3 inputs (0 mmHg 
and 100 mmHg).

11. Verify Cardiac Output traces at two measurement points.

12. Verify that NIBP readings are displayed on the patient status bar by placing the pressure cuff 
over the left or right arm and initiating a measurement.

13. Verify SpO2 by placing the finger probe on the right or left index finger. Verify that oxygen 
saturation and pulse rate readings are displayed on the patient status bar.

14. If applicable, perform the EtCO2 module Capnostat/CapnoFlex sensor check. Remove the 
adaptor from the sensor, but ensure that the sensor cable is still connected to the module. 
Ensure that the cell windows are clean and dry. Place the sensor on the cell marked REF. 
Verify that the reading is 38 mmHg +/- 2 on the display.

15. If applicable, verify FFR is enabled.

16. If applicable, verify CA 1000 is enabled, the DICOM Viewer application can open and the 
PACs can be queried.
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17. If applicable, verify the CardioImage/Image Capture feature: 

a. Open the Image Window (select Windows > Image 1 or Windows > Image 2), in either 
the Real-Time, Review, or CardioImage monitor.

b. Drag and drop the window into the selected section of the monitor.

c. Verify that there is an image from the fluoro monitor. 

d. Click the Freeze icon to capture a fluoro image.

18. If applicable, verify real time vitals by initiating an NIBP measurement from a Nurse’s Review 
Workstation.

19. Press F2 (barcode) on the keyboard and scan a barcode to verify barcode reader functionality.

20. Generate a report and verify printer operation.

a. Select Study > Reports.

b. Click New and select a report. 

c. Click a blank cell to add an X, which generates the report.

d. Click Generate to generate the selected report.

e. Highlight the report created and click View.

f. Select the Print Preview icon.

g. Click the Print icon to print the report.

21. If applicable, close the study (Study > Close Study) on the Nurse’s Review Workstation.

22. Select Study > Close Study to close the study and verify that no error messages are 
displayed and that the study is listed in System Catalog and Network Catalog if networked to 
the Centricity Cardiology INW server.

23. Verify that the Patient is in the DMS or Carddas Database.

24. If applicable, verify if Patient search is active by performing a Patient Search and picking a last 
name that exists on the Cathlab schedule.
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CardioLab SCOP (Standard Checkout Procedure)

1. Verify the CardioLab module is selected. Create a new study by clicking on New Study and 
then select a study configuration. Enter the required fields: patient last name, first name and 
medical record number.

2. If applicable, select a user for user tracking. Verify the current user is displayed in the Log 
window title.

3. If applicable, join the test study from a Nurse’s Review Workstation by highlighting the test 
study and clicking Review Study.

4. If applicable, select a different user for user tracking. Verify the current user is displayed in the 
Log window title.

5. Add a Macro (Windows > Macro) to the event log on the Acquisition. If applicable, verify that 
input comes across to the Nurse’s Review Workstation.

6. Add a list item to the study. For example, add a complication or staff member on the 
Acquisition (Study > Staff). If applicable, verify that the item comes across on the Nurse’s 
Review Workstation.

7. If applicable, add a Macro and list item to the study from a Nurse’s Review Workstation and 
verify that the items come across to the Acquisition.

8. Connect the ECG lead wires and blood pressure cables from the CardioLab II Plus Amplifier to 
the patient simulator.

9. Verify communication between the amplifier and computer:

a. Select Administration > Amplifier Test. 

b. Select Device Id and Detect > Read Amplifier Id EEPROM.

c. Verify readings.

d. Select Register Readback > Read Continuously.

e. Verify no failures.

f. Select Stop Reading.

g. Select Walking Ones > Walk Continuously.

h. Verify no failures.

i. Select Stim Walking Ones > Walk Continuously.

j. Verify no failures.

k. Select Stop Walking.

l. Select Calibration Pulse > Pulse All.

m. Verify calibration pulses are uniform in height.

n. Exit out of Amplifier Test.

10. Turn on the stimulator device (for example, Bloom or MicroPace or EP Med) and verify the 
sensing of the ECG signal. Stimulate inputs 1 – 4 and verify that pacing spikes are displayed.
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11. Using the simulator play an invasive pressure on P1 and P2 and verify that a pressure 
waveform is displayed and values appear in the patient status bar. 

12. Verify that NIBP readings are displayed by placing the pressure cuff over the left or right arm 
and initiating a measurement.

13. Verify SpO2 by placing the finger probe on the left or right index finger. Verify that oxygen 
saturation and pulse rate readings are displayed.

14. If applicable, verify CA 1000 is enabled, the DICOM Viewer application can open and the 
PACs can be queried.

15. If applicable, perform the EtCO2 module Capnostat/CapnoFlex sensor check. Remove the 
adaptor from the sensor, but ensure that the sensor cable is still connected to the module. 
Ensure that the cell windows are clean and dry. Place the sensor on the cell marked REF. 
Verify that the reading is 38 mmHg +/- 2 on the display.

16. If applicable, verify the CardioImage/Image Capture feature:

a. Open the Image Window (select Windows menu > Image Window 1 or 2), in either the 
Real-Time, Review, or CardioImage monitor.

b. Drag and drop the window into the selected section of the monitor.

c. Verify that there is a trigger signal and an image from the fluoro monitor.

d. Click the Freeze icon to capture a fluoro image.

17. If applicable, verify that the CARTO icon is blue (located on the right side of the Patient Status 
bar on the Real-Time screen).

18. If applicable, verify that the ablation device is selected and configured and that all required 
cabling is attached (for example, opto-isolator).

19. If applicable, verify real time vitals on the Nurse’s Review Workstation. Initiate an NIBP 
measurement from a Nurse’s Review Workstation.

20. Press F2 (barcode) on the keyboard and scan a barcode to verify barcode reader functionality.

21. Generate a report and verify printer operation.

a. Select Study > Reports.

b. Click New and select a report.

c. Click a blank cell to add an X, which generates the report.

d. Click Generate to generate the selected report.

e. Highlight the report created and click View.

f. Select the Print Preview icon.

g. Click the Print icon to print the report.

22. If applicable, close the study (select Study > Close Study) on the Nurse’s Review 
Workstation.

23. Select Study > Close Study to close the study and verify that no error messages are 
displayed and that the study is listed in the System Catalog and Network Catalog if networked 
to a Centricity Cardiology INW server.
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24. Verify that the Patient is in the DMS or Carddas Database.

25. If applicable, verify if Patient search is active by performing a Patient Search and picking a last 
name that exists on the Cathlab schedule.

TRAM Module Testing

1. Verify that there is a connection to the TRAM.

2. Connect the simulator to the TRAM for ECG.

3. Run the TRAMNet Test: C:\WINDOWS\Utilities\CathAmpTest\tramnetest.bat.

4. Verify signals are present.

5. Click Get All. The bottom display will appear with the RAC and TRAM version.

6. Click the X in the upper right corner to close the utility.

7. Click Yes to Exit.

PDM Testing

1. Verify that there is a connection to the PDM.

2. Connect the simulator to the PDM for ECG.

3. Run the PDM Test: C:\WINDOWS\Utilities\CathAmpTest\PDMtest.bat.

4. Verify signals are present.

5. Click Get All. The bottom display will appear with the PDM version.

6. Click the X in the upper right corner to close the utility.

7. Click Yes to Exit.

CardioImage/Image Capture Testing

1. Verify that the correct .dcf file is selected for Video Format under Configuration.

2. Open the Image Window (select Windows > Image 1 or Windows > Image 2), in either the 
Real-Time, Review, or CardioImage monitor.

3. Drag and drop the window into the selected section of the monitor.

4. Verify that there is a trigger signal and an image from the fluoro monitor.

5. Click Freeze to capture a fluoro image.

IEB Testing

1. Verify that switched video is functional: 

a. Ensure video cable is connected to Switch Vid 1 and 2 on the back of the IEB and to the 
remote monitor on the boom.

b. For Mac-Lab, go to the main menu and select Windows > Physician Video. 
For CardioLab, use the drop-down box under the main menu to select switch video.
3-26 Mac-Lab/CardioLab/Centricity Cardiology INW Service Manual 2063076-010H EN 



Maintenance
2. Verify UPS functionality by unplugging power from IEB and confirming that the acquisition 
computer remains powered.

Printer Testing

Verify that a test page prints.
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CARTO Testing

1. Verify the ECG connections to the CARTO system.

2. Select Start > Settings > Network Connections. Verify the CARTO connection is 100Mbps.

3. Start a new CardioLab study and verify that the CARTO icon is blue (located on the right side 
of the Patient Status bar on the Real-Time screen).

Audible Indicators Testing

1. Open a CardioLab study. Open the Vital Configuration window from the Measurements 
drop-down menu.

2. Verify that the Audible Indicators check box is selected and that the min/max setting is 
adjusted.

3. For Mac-Lab, verify that ECG tone can be set in the Heart Rate section.

4. Adjust the Audible Indicators min/max slider to verify an audible tone.

RF Ablation Testing

NOTE: You need to perform the following test with the customer’s cooperation.

1. Open the Ablation window in CardioLab.

2. Generate a RF output using an Ablation device.

3. Verify that the waveforms and values are properly displayed in the Ablation window.

Stimulator Testing

1. Connect a Patient Stimulator and open a CardioLab Study.

2. Turn on the stimulator device (for example, Bloom or MicroPace or EP Med) and verify the 
sensing of the ECG signal.

3. Stimulate inputs 1 – 4 and verify that pacing spikes are displayed.

4. Refer to the vendor manual for configuration and checkout information.

DASH / Solar Testing

1. Connect NIBP and SpO2 to the DASH or Solar monitor.

2. Verify that the interface cable is properly connected to the Pre/Post Review Workstation.

3. On the Pre/Post Review Workstation, create a new Mac-Lab or CardioLab study.

4. Perform a Stat Vitals measurement and verify that a log entry is created in the log window of 
the Nurse’s Review Workstation.
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Remote Operators Terminal Testing

1. Verify that the DIP-switch position 2 for the Normal Scroll Lock position is set to ON. Setting 
the Normal Scroll Lock position to ON ensures pressing the normal Scroll Lock key on the 
keyboard does not lock the remote keyboard.

2. Verify mouse and keyboard functionality at the RMOT.

Analog Out Testing

NOTE: Due to the various configurations and usages of this output, the customer’s cabling and 
test device is required to complete the verification.

1. Verify that there are signals coming out of DFIB Sync out from TRAM/PDM.

2. Verify that there are signals coming out of analog out on back of the TRAM RAC or from 
analog output from the front of the PDM.

3. Verify that there are signals coming out of analog output in back of IEB.

Centricity Cardiology INW Testing

1. Log on to the server as Administrator (Contact GE Healthcare Technical Support or the 
system administrator for current password information).

2. Select Start > All Programs > Microsoft SQL Server 2008 > SQL Server Management 
Studio

3. In the window that opens, select or type the following:

 Server Type: Database Engine

 Server Name: Computer name (the Computer name can be found by right-clicking on 
Computer from desktop, choosing Properties and looking in the Computer Name, 
domain, workgroup settings section)

 Authentication: SQL Server Authentication

 Login: sa

 Password: GEMSSQL08!admin

4. Click Connect.

5. Right-click Replication, select Launch Replication Monitor and highlight the Server name

6. Verify that there are no red X’s displayed against Publication Status and ensure there is an 
OK with the green color.
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7. If there are red X’s displayed against all publications, verify that SQLSERVERAGENT service 
is running on the server. If the SQLSERVRAGENT service is not running on the server, start 
the service and restart replication setup.

8. On the left in the Object Explorer window, expand SQL Server Agent > Jobs.

9. Right-click Database Maintenance job and select Properties.

10. In the window that opens, click Schedules and verify that the Database Maintenance job has 
a schedule.

11. Verify a full backup has been performed on the INW server, backing up the following folders. 
For customers using Enterprise Backup, refer to the Centricity Cardiology INW Operators 
Manual (PN 2063076-003 non-US or PN 2063076-303 US-only). 

 D:\Gemms\Prucka\Database\Maintenance\Backup

 D:\Gemms\Prucka\Database\Maintenance\Log

 D:\Gemms\Prucka\Studies

 D:\GEData\ArchiveLogs

12. Create a test study on one of the Acquisition systems and then close the study.

13. Verify that the new study is displayed on the Network catalog on the other systems 
(Acquisitions and Reviews).

14. Verify that lists and macros are present.

15. Verify that List Sharing and replication is working properly on all Acquisitions and Server by 
adding a supply item in the DMS or Carddas and verify that item shows up on all Acquisition 
systems in replication. Remember to remove the item from the DMS or Carddas after the test.

16. Verify that a study that has been pulled to the INW server can be reviewed from all systems 
(Acquisitions and Reviews).
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Remote Connection Testing

Verify that InSite ExC and/or VPN is working for remote diagnostics. Refer to the Proprietary 
Service Manual (PN 2063076-019).
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Planned Maintenance

GE Healthcare recommends performing planned maintenance. Use the following procedures 
when performing planned maintenance. Refer to Maintenance Record of Results on page D-1 for 
forms to record the results. Also perform appropriate checkout procedures after planned 
maintenance is complete to ensure the system is functional for customer use. 

NOTE: Only qualified service personnel should replace components. Refer component 
replacement to GE Healthcare authorized service personnel only.

General Cleaning and Inspection

WARNING: SHOCK HAZARD

If liquids or foreign materials have entered a device, take it out of service and 
have it checked by qualified service personnel to verify safety and functionality 
before it is used again. Ingress of foreign substances may result in shock, fire, 
excess leakage current, or device failure.

WARNING: Use caution when cleaning the environment near equipment. Fluid ingress may 
damage devices or compromise electrical safety.

General Inspection

Before cleaning, inspect components, cables, and accessories. If signs of damage or degradation 
are present, contact a GE Healthcare representative to determine if equipment needs to be 
replaced. 

General Cleaning

Refer to each specific equipment subsection in this portion of the manual for specific equipment 
cleaning and disinfection instructions. For other system components and cables, use the following:

 Wipe down the component with a soft, lint-free cloth lightly dampened with mild dishwashing 
detergent diluted in water. Wring excess fluid from lint-free cloth before using. Avoid contact 
with open vents, plugs, or connectors.

 Do not pour or spray any liquid directly on the device, cables or leadwires or permit fluid to 
seep into connections or openings.

 Wipe the surfaces with a clean, dry, soft, lint-free cloth until the equipment is thoroughly dry.

 Do not make patient connections until the equipment is thoroughly dry.
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Cautions

 Never immerse the device in any liquid.

 Do not pour or spray any liquid directly on the device, cables or leadwires or permit fluid to 
seep into connections or openings.

 Mild dishwashing detergent is used for cleaning several system components. The mild 
dishwashing detergent does not contain Acetone, Ketone, Betadine or solutions that contain 
wax or wax compounds.

 Never use solutions or products that contain the following ingredients:

 Acetone

 Ketone

 Betadine

 Solutions that contain wax or wax compounds

 Do not use abrasive cleaners or solvents of any kind.

 Never autoclave or steam clean the device, cables or leadwires.

 Do not make patient connections until equipment is thoroughly dry.

Avoid products that contain active ingredients and solutions similar to these products.

NOTE: Do not use cleaners containing abrasives, alcohol or wax, Acetone, or Betadine. And 
never immerse any component in a liquid or apply cleaner directly to the component. 
Always apply the cleaner to the cleaning cloth and wring out any excess if necessary. If 
too much cleaner is used, it may run inside the case and cause damage.
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Monitors

CAUTION: EQUIPMENT DAMAGE

Do not use benzene, thinner, ammonia, or any other volatile substances to 
clean the monitor or the screen. These chemicals may damage the cabinet 
finish as well as the screen.

CAUTION: EQUIPMENT DAMAGE

Do not use OA cleaner as it will cause deterioration or discolor the LCD 
surface.

Tools

 Multiple soft, lint-free cloths

 Mild dishwashing detergent

Clean CRT Monitors 

 Turn off the monitor and unplug from the wall outlet.

 Plastic components — use a lightly-dampened, warm cloth. Avoid using detergent of any kind 
because some detergents can leave a milky film on the plastics.

 Monitor screen — use a soft, clean cloth lightly dampened with water. If possible, use a special 
screen-cleaning tissue or solution suitable for the antistatic coating with water.

Clean LCD Monitors

 Turn off the monitor and disconnect power before cleaning.

NOTE: Do not rub any part of the LCD monitor with hard or coarse material.

 Monitor Screen — Clean the LCD monitor screen (the viewing area of the screen) with a dry 
soft, lint-free cloth. Do not use any cleaning solution or glass cleaner.

NOTE: Do not apply pressure to the LCD monitor screen.

 LCD cabinet (plastic components) — Dampen a soft, lint-free cloth with a mild dishwashing 
detergent diluted in water, wipe the plastic surfaces and then dry with a dry, soft, lint-free cloth.

 Unpacking — use a soft cloth to gently wipe off the monitor after unpacking. A white powder 
may occur during the shipping of the monitor. Handle the monitor with care because darker 
colored plastics may scratch and show white scuff marks more than lighter-colored plastics.

NOTE: Many plastics are used on the surface of the cabinet. DO NOT clean with benzene, 
alkaline, alcohol, detergent, glass cleaner, waxes of any kind, polish cleaner, soap or 
Office Automation (OA) cleaner. Do not place rubber or vinyl against the cabinet for long 
periods. These types of fluids and fabrics can cause the paint to deteriorate, crack, or 
peel.
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Mac-Lab Leadwires and ECG Cables

Clean the ECG cables and leadwires after each exam as shown in the following sections. 

Tools

 Cotton swabs

 Multiple soft lint-free cloths

 Mild dishwashing detergent

 Sodium hypochlorite (5.2% household bleach) minimum 1:500 dilution (minimum 100 ppm 
free chlorine) and maximum 1:10 dilution

Cleaning and Disinfection

 Remove the cables and leadwires from device or system before cleaning.

 Use care in cleaning leadwires to prevent pulling the long wires from the connector ends. 
Metal connections can be pulled away from the connectors.

 Avoid breaking internal wires by excessive bending strain or flexing of the leadwires and ECG 
cables.

 For general cleaning of cables and leadwires, wipe with a soft, lint-free cloth dampened with a 
mild dishwashing detergent diluted in water. Wring excess fluid from lint-free cloth before 
using.

 Wipe the surfaces with a clean, dry, soft, lint-free cloth until the equipment is thoroughly dry.

 To disinfect, wipe exterior with a soft lint-free cloth, using the following solution as 
recommended in the APIC Guidelines for Selection and Use of Disinfectants (1996): Sodium 
hypochlorite (5.2% household bleach) minimum 1:500 dilution (minimum 100 ppm free 
chlorine) and maximum 1:10 dilution.

NOTE: Wring excess disinfectant from lint-free cloth before using.

 Dry the equipment thoroughly with a clean, dry, soft, lint-free cloth after disinfecting.

 Do not make patient connections until equipment is thoroughly dry.

 Clean each connector lead with a dry cotton swab.

 Take care not to let fluid “pool” around connection pins. If this should happen, blot dry with a 
soft, lint-free cloth.

Sterilize Leadwires and ECG Cables

Ethylene oxide gas (EtO) sterilization is NOT RECOMMENDED, but may be required for cables 
and leadwires. Frequent sterilization will reduce the useful life of cables and leadwires. Follow the 
recommendations from the sterilizer manufacturer for EtO sterilization.

CardioLab Leadwires and ECG Cables

To perform the planned maintenance for the CardioLab Leadwires and ECG cables, refer to the 
supplier Service Manual for the proper cleaning and disinfection procedure.
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Catheter Input Module

Perform the daily cleaning of the Catheter Input Module (CIM) as shown in the following sections.

Tools

 Cotton swabs

 Multiple soft, lint-free cloths

 Mild dishwashing detergent

 Sodium hypochlorite (5.2% household bleach) minimum 1:500 dilution (minimum 100 ppm 
free chlorine) and maximum 1:10 dilution

Cleaning and Disinfection 

 Remove all cables from the Catheter Input Module.

 Wipe down the component with a soft, lint-free cloth lightly dampened with mild dishwashing 
detergent diluted in water. Wring excess fluid from lint-free cloth before using. Avoid contact 
with open vents, plugs or connectors.

 Wipe the surfaces with a clean, dry, soft, lint-free cloth until the equipment is thoroughly dry.

 To disinfect, wipe exterior with a soft lint-free cloth, using the following solution as 
recommended in the APIC Guidelines for Selection and Use of Disinfectants (1996): Sodium 
hypochlorite (5.2% household bleach) minimum 1:500 dilution (minimum 100 ppm free 
chlorine) and maximum 1:10 dilution.

NOTE: Wring excess disinfectant from lint-free cloth before using.

 Dry the equipment thoroughly with a clean, dry, soft, lint-free cloth after disinfecting.

 Do not make patient connections until equipment is thoroughly dry.

 Clean each connector port with a dry cotton swab.

 Take care not to let fluid “pool” around connection pins. If this should happen, blot dry with a 
soft, lint-free cloth.
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CardioLab II Plus Amplifier

Perform the following maintenance on the CardioLab II Plus Amplifier to maintain safe and efficient 
operation of the unit: 

Precautions

 Do not open the CardioLab II Plus Amplifier unless instructed to do so by qualified technical 
personnel. 

 Do not immerse any part of the amplifier in water. 

 Do not use organic solvents, ammonia based solutions or abrasive cleaning agents which may 
damage equipment surfaces.

Tools

 Cotton swabs

 Multiple soft, lint-free cloths

 Mild dishwashing detergent

 Sodium hypochlorite (5.2% household bleach) minimum 1:500 dilution (minimum 100 ppm 
free chlorine) and maximum 1:10 dilution

 Isopropyl Alcohol

Cleaning and Disinfection

 Wipe down the component with a soft, lint-free cloth lightly dampened with mild dishwashing 
detergent diluted in water. Wring excess fluid from lint-free cloth before using. Avoid contact 
with open vents, plugs, or connectors.

 Wipe the surfaces with a clean, dry, soft, lint-free cloth until the equipment is thoroughly dry.

 To disinfect, wipe exterior with a soft lint-free cloth, using the following solution as 
recommended in the APIC Guidelines for Selection and Use of Disinfectants (1996): Sodium 
hypochlorite (5.2% household bleach) minimum 1:500 dilution (minimum 100 ppm free 
chlorine) and maximum 1:10 dilution.

NOTE: Wring excess disinfectant from lint-free cloth before using.

 Dry the equipment thoroughly with a clean, dry, soft, lint-free cloth after disinfecting.

 Do not make patient connections until equipment is thoroughly dry.

Daily  Perform the daily cleaning of the amplifier as shown in the following sections.

 Check the case for cracks or other damage.

 Inspect all cords and cables for fraying or other damage.

 Inspect all plugs, cables and connectors for bent prongs or pins. 

 Verify that all cords and connectors are securely seated.

 Inspect controls for proper operation.

Monthly  Inspect all tips of the fiber optic cable and clean them with Isopropyl alcohol and a dry cotton 
swab.

 Clean all dust and debris from the fiber optic cable connectors with a dry cotton swab.
2063076-010H EN Mac-Lab/CardioLab/Centricity Cardiology INW Service Manual 3-37



Maintenance
 Clean each connector port with a dry cotton swab.

 Take care not to let fluid “pool” around connection pins. If this should happen, blot dry with a 
soft, lint-free cloth.

IEB

Perform the monthly cleaning of the IEB as shown in the following sections.

Tools

 Cotton swabs

 Multiple soft, lint-free cloths

 Mild dishwashing detergent

 Vacuum cleaner

Clean IEB

 Vacuum the IEB externally to remove the dust.

 Wipe down the component with a soft, lint-free cloth lightly dampened with mild dishwashing 
detergent diluted in water. Wring excess fluid from lint-free cloth before using. Avoid contact 
with open vents, plugs, or connectors.

 Wipe the surfaces with a clean, dry, soft, lint-free cloth until the equipment is thoroughly dry.

 Clean each connector port with a dry cotton swab.

 Take care not to let fluid “pool” around connection pins. If this should happen, blot dry with a 
soft, lint-free cloth.

Inspect IEB

 Check the case for cracks or other damage.

 Inspect cables for fraying or other damage.

 Inspect all plugs, cables and connectors for bent prongs or pins.

 Ensure all cables and connectors are securely seated.

Safety Test

Refer to Mac-Lab/CardioLab System Electrical Safety Testing on page 3-6.
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Function Test

1. Connect the Acquisition system to the IEB.

2. Connect a Remote Monitor to test the Switch Video Functionality.

3. Connect a patient simulator to the ECG and Pressure’s P1 and P2 on the TRAM module.

4. Turn on the IEB and Acquisition system power switches.

5. Log onto the Mac-Lab system.

6. Launch the Mac-Lab/CardioLab application.

7. Launch a new Mac-Lab study.

8. Adjust the simulator so that the BP waveforms are zero.

9. Zero the BP waveforms in the Mac-Lab study.

10. Re-adjust the simulator so it simulates Arterial and Venous pressure waveforms.

11. Verify pressures in the window.

12. Verify that the correct BP waveforms are present on the Real-Time window.

13. Close the Mac-Lab study.

14. Launch a new CardioLab study.

15. Select Training Clabplay study configuration.

16. Connect a simulator to the CardioLab II Plus amplifier to display ECG and intracardiac signals.

17. Verify that the correct signals are present.

18. On the remote monitor, verify Real-Time window is displayed.

19. From the Switch Video drop-down menu, select Review.

20. Verify the Remote monitor now shows the Review window.

21. If applicable, in the Switch Video drop-down menu, select Image.

22. If applicable, verify the Remote monitor now shows the image window.

23. From the Switch Video drop-down menu, select Real-Time.

24. Verify the Remote monitor now shows the Real-Time window.

25. Close the window and exit the application.
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RF Filter Box

Perform the daily cleaning of the RF Filter Box as shown in the following sections.

Tools

 Cotton swabs

 Multiple soft, lint-free cloths

 Mild dishwashing detergent

 Sodium hypochlorite (5.2% household bleach) minimum 1:500 dilution (minimum 100 ppm 
free chlorine) and maximum 1:10 dilution

Cleaning and Disinfection

 Wipe down the component with a soft, lint-free cloth lightly dampened with mild dishwashing 
detergent diluted in water. Wring excess fluid from lint-free cloth before using. Avoid contact 
with open vents, plugs, or connectors.

 Wipe the surfaces with a clean, dry, soft, lint-free cloth until the equipment is thoroughly dry.

 To disinfect, wipe exterior with a soft lint-free cloth, using the following solution as 
recommended in the APIC Guidelines for Selection and Use of Disinfectants (1996): Sodium 
hypochlorite (5.2% household bleach) minimum 1:500 dilution (minimum 100 ppm free 
chlorine) and maximum 1:10 dilution.

NOTE: Wring excess disinfectant from lint-free cloth before using.

 Dry the equipment thoroughly with a clean, dry, soft, lint-free cloth after disinfecting.

 Do not make patient connections until equipment is thoroughly dry.

 Clean each connector port with a dry cotton swab.

 Take care not to let fluid “pool” around connection pins. If this should happen, blot dry with a 
soft, lint-free cloth.
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Analog Output Box

Perform the daily cleaning of the Analog Output Box as shown in the following sections.

Tools

 Cotton swabs

 Multiple soft, lint-free cloths

 Mild dishwashing detergent

 Sodium hypochlorite (5.2% household bleach) minimum 1:500 dilution (minimum 100 ppm 
free chlorine) and maximum 1:10 dilution

Cleaning and Disinfection

 Wipe down the component with a soft, lint-free cloth lightly dampened with mild dishwashing 
detergent diluted in water. Wring excess fluid from lint-free cloth before using. Avoid contact 
with open vents, plugs, or connectors.

 Wipe the surfaces with a clean, dry, soft, lint-free cloth until the equipment is thoroughly dry.

 To disinfect, wipe exterior with a soft lint-free cloth, using the following solution as 
recommended in the APIC Guide Lines for Selection and Use of Disinfectants (1996): Sodium 
hypochlorite (5.2% household bleach) minimum 1:500 dilution (minimum 100 ppm free 
chlorine) and maximum 1:10 dilution.

NOTE: Wring excess disinfectant from lint-free cloth before using.

 Dry the equipment thoroughly with a clean, dry, soft, lint-free cloth after disinfecting.

 Do not make patient connections until equipment is thoroughly dry.

 Clean each connector port with a dry cotton swab.

 Take care not to let fluid “pool” around connection pins. If this should happen, blot dry with a 
soft, lint-free cloth.
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System Interconnect Cables

System interconnect cables are cables that connect between the equipment. Examples of system 
interconnect cables include the following:

 Power cables

 Video cables

 Network cables

 Speaker cables

 Ethernet cables

Perform the daily cleaning of the system cables as shown in the following sections.

Tools

 Cotton swabs

 Multiple soft, lint-free cloths

 Mild dishwashing detergent

Cleaning

 Remove system interconnect cables from the devices or systems before cleaning.

 Wipe down the component with a soft, lint-free cloth lightly dampened with mild dishwashing 
detergent diluted in water. Wring excess fluid from lint-free cloth before using. Avoid contact 
with open vents, plugs, or connectors.

 Wipe the surfaces with a clean, dry, soft, lint-free cloth until the equipment is thoroughly dry.

 Inspect and clean the leads of the plug on the interconnect cables with a dry cotton swab.
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Computer

This section is applicable to both the Acquisition system and the Review Workstation.

Tools

 Cotton swabs

 Multiple soft, lint-free cloths

 Vacuum cleaner

Clean Computer

 Power down the computer and remove all cables prior to cleaning.

 Remove the dust from the top covers of the computer and clean with dry, soft, lint-free cloth.

 Remove side covers of computer and remove dust with vacuum and dry cotton swabs.

 Remove dust from the system fan with vacuum and dry cotton swabs.

 Remove dust from the power supply with vacuum and dry cotton swabs.

 Clean each connector port with a dry cotton swab.

 Clean and check each CD drive and DVD drive unit with a dry cotton swab.

 Clean the keyboard with soft, lint-free cloth and vacuum.

Inspect Computer

 Check the computer housing for cracks or other damage.

 Inspect all cables for stress, cuts, tears or other damage.

 Inspect all plugs, cables and connectors for bent prongs or pins.

 Verify that all cables and connectors are securely seated.

 Inspect power supply fan for any damage.

Boot Test

1. Plug the computer into an AC power outlet.

2. Press the power button on the computer.

3. Verify the computer performs the proper boot operation without errors.

4. Verify all fans in the computer operate without error.

5. Verify the computer displays come up without error.

6. Verify the keyboard allows the user to enter text.
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Server

This section applies to the Cardiology Centricity INW server. 

Tools

 Cotton swabs

 Multiple soft, lint-free cloths

 Vacuum cleaner

Clean Server

 Power down the server and remove all cables prior to cleaning.

 Clean the exterior surfaces with a clean soft, lint-free cloth dampened with water.

 Do not pour or spray any liquid directly on the Server or permit fluid to seep into connections or 
openings.

 Remove top cover of server and remove dust with vacuum.

 Remove dust from fans with vacuum and dry cotton swabs.

 Remove dust from the power supply with vacuum and dry cotton swabs.

 Clean each connector port with a dry cotton swab.

 Replace top cover of server and plug server into an AC power outlet.

Inspect Server

 Check the case for cracks or other damage.

 Inspect all cords and cables for fraying or other damage.

 Inspect all plugs, cables and connectors for bent prongs or pins.

 Ensure that all cables and connectors are properly seated.

Diagnostic Test

NOTE: The diagnostic tests in this section are for the ML370 (G4/G5) and the DL370 (G6 
ProLiant) servers. Use the proper procedure based on which server is being used.

ML370 (G5) Servers

1. Select Start > HP Information Center > Diagnostics for Windows.

2. Select the Test tab.

3. At the Quick Test tab (default), select Begin Testing.

4. Click OK at the prompt.

5. Wait for the tests to complete. (This may take several minutes.)

6. Verify all tests pass.

7. Select File > Exit.
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DL370 (G6 ProLiant) Server

1. Select Start > All Programs > HP System Tools > HP Array Diagnostic Utility.

2. Double-click on HP Array Diagnostic Utility.

NOTE: If a Pop-up is blocked message appears, click on the message and select Temporarily 
Allow Pop-ups.

3. Verify no errors are listed in the report.

4. Select File > Exit.

5. Select Exit ADU.
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Vivid External Trackball

Perform the monthly cleaning of the Vivid external trackball as shown in the following sections.

Tools

 Multiple soft, lint-free cloths

 Mild dishwashing detergent

Cleaning

NOTE: Use only specified solutions or products to clean the unit. Do Not Spray Any Liquid 
directly onto the Vivid External Trackball. For further instructions on proper cleaning 
practices, refer to the Vivid Service Manual (PN 2378956-100).

 Shut down the Vivid unit.

 Wipe down the component with a soft, lint-free cloth lightly dampened with mild dishwashing 
detergent diluted in water. Wring excess fluid from lint-free cloth before using. Avoid contact 
with open vents, plugs, or connectors.

 Do not pour or spray any liquid directly on the trackball unit or permit fluid to seep into 
connections or openings.

 Wipe the surfaces with a clean, dry, soft, lint-free cloth until the equipment is thoroughly dry.

 Do not make the connections until the equipment is thoroughly dry.

Inspecting

 Ensure all labels on the unit are present and in readable condition.

 Inspect the unit for dents, scratches and cracks.

 Ensure the TGC sliders move freely and buttons work properly.

 Check the cable harness and connector for wear or damage.

 Turn the Vivid unit on.
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Performance Check

1. Connect the Trackball unit to the Vivid unit.

2. On the Trackball unit, move all TGC sliders and press all buttons.

3. Verify all buttons and TGC sliders move freely and do not stick.

4. Turn the Vivid unit on.

5. Once the Vivid unit is powered up, move the trackball on the Trackball unit.

6. Verify the mouse pointer moves on the Vivid display screen.

7. On the Trackball unit, press the buttons one at a time and click Clear to clear any Event 
window.Verify all buttons activate properly.

8. On the Trackball unit, move all TGC sliders to the left position.

9. In the upper-right corner, verify the value of all sliders is 0 (+/-2).

10. On the Trackball unit, move all TGC sliders to the right position.

11. In the upper-right corner, verify the value of all sliders is 63 (+/-2).

12. On the Trackball unit, move all TGC sliders to the central position.

13. In the upper-right corner, verify the value of all sliders is 31 (+/-2).

14. On the Trackball unit, rotate the Rotary (in both directions) and press the button at the center 
of the rotary.

15. Verify the Rotary is activated and there is a row of data from pressing the button and another 
row from releasing the button.

16. Verify the button backlights are illuminated.
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Vivid Mount

Perform the daily cleaning of the Vivid mount as shown in the following sections.

Tools

 Cotton swabs

 Multiple soft, lint-free cloths

 Mild dishwashing detergent

 Sodium hypochlorite (5.2% household bleach) minimum 1:500 dilution (minimum 100 ppm 
free chlorine) and maximum 1:10 dilution

Cleaning and Disinfecting

Periodically inspect and tighten all fasteners associated with the mounting system as necessary 
for optimal operation and safety.

 Wipe down the component with a soft, lint-free cloth lightly dampened with mild dishwashing 
detergent diluted in water. Wring excess fluid from lint-free cloth before using. Avoid contact 
with open vents, plugs, or connectors.

 Wipe the surfaces with a clean, dry, soft, lint-free cloth until the equipment is thoroughly dry.

 To disinfect, wipe exterior with a soft lint-free cloth, using the following solution as 
recommended in the APIC Guidelines for Selection and Use of Disinfectants (1996): Sodium 
hypochlorite (5.2% household bleach) minimum 1:500 dilution (minimum 100 ppm free 
chlorine) and maximum 1:10 dilution.

NOTE: Wring excess disinfectant from lint-free cloth before using.

 Dry the equipment thoroughly with a clean, dry, soft, lint-free cloth after disinfecting.

 Clean each connector port with a dry cotton swab.

 The surface finish will be permanently damaged by strong chemicals and solvents such as 
acetone or trichloroethylene.

 Never submerge or allow liquids to enter the Vivid mount arm. Contact of disinfectant solutions 
with metal parts may cause corrosion. Wipe any cleaning agents off the arm immediately using 
a water-dampened cloth.
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HP Color LaserJet CP2025n and M451 Printer

Tools

 Multiple soft lint-free cloths

Clean Printer

 Clean exterior surfaces of the printer with a soft, lint-free cloth dampened with water.

 Use a dry, soft, lint-free cloth to dry the printer.

 Refer to the manufacturer instructions for information on how to clean the inside of the printer.

NOTE: Do not use ammonia-based cleaners on or around the printer.

Inspect Printer

 Check the case for cracks or other damage.

 Inspect cables for fraying or other damage.

 Inspect all plugs, cables and connectors for bent prongs or pins.

 Ensure all cables and connectors are securely seated.

Clean Printer Using Cleaning Mode

1. Press OK to open the menus.

2. Press the Left Arrow or Right Arrow button to highlight Service.

3. Press OK.

On the CP2025n, an asterisk (*) appears next to the active screen.

4. Press the Left Arrow or Right Arrow button to highlight Cleaning Mode.

5. Press OK.

6. Verify the cleaning mode completes without errors.
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HP LaserJet P2035n and M401

Tools

 Multiple soft, lint-free cloths

Clean Printer

 Clean exterior surfaces of the printer with a soft, lint-free cloth dampened with water.

 Use a dry, soft, lint-free cloth to dry the printer.

 Refer to the manufacturer instructions for information on how to clean the inside of the printer

NOTE: Do not use ammonia-based cleaners on or around the printer.

NOTE: Do not expose the print cartridge to light while cleaning the printer. Cover the print 
cartridge with a piece of paper.

Inspect Printer

 Check the case for cracks or other damage.

 Inspect cables for fraying or other damage.

 Inspect all plugs, cables and connectors for bent prongs or pins.

 Ensure all cables and connectors are securely seated.

Clean Print-Cartridge Area

1. Open the print-cartridge door and remove the cartridge.

2. With a dry, lint-free cloth, wipe any residue from the media-path and the print-cartridge cavity.

3. Replace the cartridge and close the cartridge door.

4. Reconnect the power cord and turn on the printer.

5. Verify the cleaning mode completes without errors.
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Clean Paper Path Area (P2035n only)

1. Ensure the printer is idle and the Ready light is on.

2. Load paper in Tray 1.

3. Print a cleaning page:

NOTE: The cleaning process takes about 2 minutes. The cleaning page stops periodically during 
the cleaning process. Do not turn off the printer until the cleaning process has finished. 

NOTE: This process may be repeated several times to thoroughly clean the printer.

4. Reconnect the power cord and turn on the printer.

a. Open the print driver Properties screen.

b. Select the Device Settings tab.

c. Select the Cleaning Page option.

d. Click OK.

Print Cleaning Page (M401 Only)

1. On the printer control panel, press the OK button to open the menus.

2. Open the following menus:

 Service

 Cleaning Page

3. Load plain paper in Tray 1, and then press the OK button to start the cleaning process.

4. Wait until the process completes.
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Uninterruptible Power Supply (UPS)

The Uninterruptible Power Supply is used with the Acquisition system only.

WARNING: EQUIPMENT HAZARD

Do not attempt to service the UPS or replace the battery. Doing so could result 
in equipment damage. Contact qualified GE Service personnel for service or 
replacement.

WARNING: EXPLOSION HAZARD

Do not incinerate the UPS battery or store at high temperatures.

Tools

 Cotton swabs

 Multiple soft, lint-free cloths

 Mild dishwashing detergent

Clean Uninterruptible Power Supply (UPS)

 Power off the UPS.

 Wipe down the component with a soft, lint-free cloth lightly dampened with mild dishwashing 
detergent diluted in water. Wring excess fluid from lint-free cloth before using. Avoid contact 
with open vents, plugs, or connectors.

 Clean each UPS connector port with a dry cotton swab.

 Do not pour or spray any liquid directly on the UPS or permit fluid to seep into connections or 
openings.

 Wipe the surfaces with a clean, dry, soft, lint-free cloth until the equipment is thoroughly dry.

Inspect Uninterruptible Power Supply (UPS)

 Check the case for cracks, leaks or other damage.

 Inspect all cords and cables for fraying or other damage.

 Inspect all plugs, cables and connectors for bent prongs or pins.
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Maintenance
Function Test

Uninterruptible Power Supply (UPS) Function Test

1. Unplug all cords from the UPS.

2. Plug the UPS power cord into an AC power outlet.

3. Verify the Green LED turns on.

4. Use Safety Analyzer to check voltage.

5. Verify the voltage is > 20V.

6. Plug the Acquisition system, monitor and the IEB into the UPS.

7. Verify all systems turn on and boot properly.

Battery Test

1. Ensure the Acquisition system is plugged into the UPS.

2. If not already on, turn on the Acquisition system.

3. Unplug the UPS so the Acquisition system is powered by the UPS battery.

4. Verify the Acquisition system stays powered for 10 seconds under battery power.

5. Plug the UPS back into the AC power outlet.
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Mobile Workstation

Perform the daily cleaning of the Mobile Workstation as shown in the following sections.

Tools

 Multiple soft, lint-free cloths

 Mild dishwashing detergent

 Sodium hypochlorite (5.2% household bleach) minimum 1:500 dilution (minimum 100 ppm 
free chlorine) and maximum 1:10 dilution

 1/2 inch socket wrench

 9/64 inch hex wrench (provided with workstand)

Cleaning and Disinfection

 Wipe down the component with a soft, lint-free cloth lightly dampened with mild dishwashing 
detergent diluted in water. Wring excess fluid from lint-free cloth before using. Avoid contact 
with open vents, plugs, or connectors.

 Wipe the surfaces with a clean, dry, soft, lint-free cloth until the equipment is thoroughly dry.

 To disinfect the Mobile Workstation, wipe exterior with a soft lint-free cloth, using the following 
solution as recommended in the APIC Guidelines for Selection and Use of Disinfectants 
(1996): Sodium hypochlorite (5.2% household bleach) minimum 1:500 dilution (minimum 100 
ppm free chlorine) and maximum 1:10 dilution.

NOTE: Wring excess disinfectant from lint-free cloth before using.

 Dry the equipment thoroughly with a clean, dry, soft, lint-free cloth after disinfecting.

 The surface finish will be permanently damaged by strong chemicals and solvents such as 
acetone or trichloroethylene.

 Never submerge the roll stand or allow liquids to enter the mounting assemblies, wipe any 
cleaning agents off the mounting assembly immediately using a water-dampened cloth.

Adjusting Tilt and Tilt Tension

1. For minor adjustments of the display tilt, loosen the Tilt Adjustment Lever, grasp the top and 
bottom of the display and tilt it to the desired angle. Tighten the Tilt Adjustment Lever.

CAUTION: EQUIPMENT DAMAGE

Tilt tension screws on the mobile workstand must be torqued to a minimum of 
35 in-lbs (4.0 N-m).

NOTE: The Tilt Adjustment Lever is a multi-position, clamping lever that operates by lifting, 
rotating and releasing the handle.

2. To adjust tilt tension, equally tighten or loosen the two (2) Tension Adjustment Screws with the 
9/64 inch hex wrench provided.
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Adjusting Swivel or Pivot Tension

CAUTION: EQUIPMENT DAMAGE

Swivel tension nut must be torqued to a minimum of 20 in-lbs (2.3 N-m).

NOTE: The Utility Hook must be removed to allow adjustment of the swivel nut.

Using a 1/2 inch socket wrench, tighten or loosen the pivot tension bolt swivel nut to the desired 
tension.

Routine Maintenance

Periodically inspect all mounting hardware. Tighten or adjust as necessary for optimal operation 
and safety.

Desk

Perform the daily cleaning of the Desk as shown in the following sections.

Tools

 Multiple soft, lint-free cloths

 Mild dishwashing detergent

 Sodium hypochlorite (5.2% household bleach) minimum 1:500 dilution (minimum 100 ppm 
free chlorine) and maximum 1:10 dilution

Cleaning and Disinfection

 Wipe down the component with a soft, lint-free cloth lightly dampened with mild dishwashing 
detergent diluted in water. Wring excess fluid from lint-free cloth before using. Avoid contact 
with open vents.

 Wipe the surfaces with a clean, dry, soft, lint-free cloth until the equipment is thoroughly dry.

 To disinfect the Desk, wipe exterior with a soft lint-free cloth, using the following solution as 
recommended in the APIC Guidelines for Selection and Use of Disinfectants (1996): Sodium 
hypochlorite (5.2% household bleach) minimum 1:500 dilution (minimum 100 ppm free 
chlorine) and maximum 1:10 dilution.

NOTE: Wring excess disinfectant from lint-free cloth before using.

 Dry the equipment thoroughly with a clean, dry, soft, lint-free cloth after disinfecting.

 The surface finish will be permanently damaged by strong chemicals and solvents such as 
acetone or trichloroethylene.

 Never submerge or allow liquids to remain on the desk, wipe any cleaning agents off the desk 
immediately using a water-dampened cloth soft, lint-free cloth.
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PDM Base Station

Perform the daily cleaning of the PDM Base Station as shown in the following sections.

Tools

 Cotton swabs

 Multiple soft, lint-free cloths

 Mild dishwashing detergent

 Sodium hypochlorite (5.2% household bleach) minimum 1:500 dilution (minimum 100 ppm 
free chlorine) and maximum 1:10 dilution

Cleaning and Disinfection

 Wipe down the component with a soft, lint-free cloth lightly dampened with mild dishwashing 
detergent diluted in water. Wring excess fluid from lint-free cloth before using. Avoid contact 
with open vents, plugs, or connectors.

 Wipe the surfaces with a clean, dry, soft, lint-free cloth until the equipment is thoroughly dry.

 To disinfect, wipe exterior with a soft lint-free cloth, using the following solution as 
recommended in the APIC Guidelines for Selection and Use of Disinfectants (1996): Sodium 
hypochlorite (5.2% household bleach) minimum 1:500 dilution (minimum 100 ppm free 
chlorine) and maximum 1:10 dilution.

NOTE: Wring excess disinfectant from lint free cloth before using.

 Dry the equipment thoroughly with a clean, dry, soft, lint-free cloth after disinfecting.

 Do not make patient connections until equipment is thoroughly dry.

 Clean each connector port with a dry cotton swab.

 Take care not to let fluid “pool” around connection pins. If this should happen, blot dry with a 
soft, lint-free cloth.
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PDM Base Station Mount

Perform the daily cleaning of the PDM Base Station Mount as shown in the following sections.

Tools

 Multiple soft, lint-free cloths

 Mild dishwashing detergent

 Sodium hypochlorite (5.2% household bleach) minimum 1:500 dilution (minimum 100 ppm 
free chlorine) and maximum 1:10 dilution

Cleaning and Disinfection

 Wipe down the component with a soft, lint-free cloth lightly dampened with mild dishwashing 
detergent diluted in water. Wring excess fluid from lint-free cloth before using. Avoid contact 
with open vents, plugs, or connectors.

 Wipe the surfaces with a clean, dry, soft, lint-free cloth until the equipment is thoroughly dry.

 To disinfect, wipe exterior with a soft lint-free cloth, using the following solution as 
recommended in the APIC Guidelines for Selection and Use of Disinfectants (1996): Sodium 
hypochlorite (5.2% household bleach) minimum 1:500 dilution (minimum 100 ppm free 
chlorine) and maximum 1:10 dilution.

NOTE: Wring excess disinfectant from lint free cloth before using.

 Dry the equipment thoroughly with a clean, dry, soft, lint-free cloth after disinfecting.

 The surface finish will be permanently damaged by strong chemicals and solvents such as 
acetone or trichloroethylene.

 Never submerge the roll stand or allow liquids to enter the mounting assemblies. Wipe any 
cleaning agents off the mounting assembly immediately using a water-dampened cloth. 

Dry the equipment thoroughly with a clean, dry, soft, lint-free cloth.

PDM

Perform the daily cleaning of the PDM as shown in the following sections.

Tools

 Multiple soft, lint-free cloths

 Cellular urethane cleaning swab

 Cotton swab, gauze pad

 Water, Soap

 Mild dishwashing detergent

 Clorox bleach (Active ingredient: 5.25% Sodium Hypochlorite-off the shelf) Mix 10:1 with H2O.

 Sagrotan (dilution 3:100, containing 75 mg tartaric acid per 100 ml solution).

 Sodium hypochlorite (5.2% household bleach) minimum 1:500 dilution (minimum 100 ppm 
free chlorine) and maximum 1:10 dilution.
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Visual Inspection

 Remove power and all cables before inspecting or cleaning the equipment.

 Inspect the equipment and its component carefully prior to installation, once every 12 months 
thereafter each time the equipment is serviced. Do not use the equipment if damage is 
determined. Refer damaged equipment to qualified service personal.

 Inspect the case for cracks or other physical damage.

 Inspect cables for frying or other damage.

 Inspect all plugs and connectors for bent pins or other damage.

 Check for loose or missing screws on the mounting hardware.

NOTE: Damaged cables or equipment should be replaced by qualified service personnel.

Cleaning and Disinfection

1. Remove power, all cables and batteries.

2. Close the battery door.

3. Wipe down the component with a soft, lint-free cloth lightly dampened with mild dishwashing 
detergent diluted in water. Wring excess fluid from lint-free cloth before using. Avoid contact 
with open vents.

4. Wipe the surfaces with a clean, dry, soft, lint-free cloth until the equipment is thoroughly dry.

5. To disinfect, wipe exterior with a soft lint-free cloth lightly dampened with any one of the 
permitted cleaning agents as follows:

 Clorox bleach (Active ingredient: 5.25% Sodium Hypochlorite-off the shelf) Mix 10:1 with 
H2O.

 Sagrotan (dilution 3:100, containing 75 mg tartaric acid per 100 ml solution).

NOTE:  Wring excess disinfectant from lint free cloth before using.

 Contact of disinfectant solution with metal parts may cause corrosion.

 Do not damage or bend connector pins when cleaning or drying.

6. Allow solution to remain on device for a minimum of one minute or per hospital guidelines.

7. Take care not to let fluid “pool” around connection pins. If this happens, blot dry with a soft, lint-
free cloth or cotton swab. Shake out excess liquids from connector recesses.

8. Dry the equipment thoroughly with a clean dry soft, lint-free cloth after disinfecting.

NOTE: Drying times may vary based on environmental conditions.

Storage

 Remove batteries when the device is not in use, even for short period of time.

 Store in a dry well-ventilated area.

 Hang the device using a holder if available.

 If leadwires or cables are attached, hang them straight.

 Do not coil leadwires or cables tightly around the device.
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Consequences of Using Improper Cleaning Product

 Case may become brittle or may break.

 Overall system performance degradation.

 Melting, dulling or distorting the case.

 Total medical device failure requiring replacement.

 Unit malfunction.

 Void warranty.

Cleaning Products to Avoid

Cleaning products known to cause the types of problems listed in the previous section include, but 
are not limited to:

 Sani-cloth wipes

 Ascepti wipes

 HB Quat

 Clorox wipes (they do not contain bleach)

 Over the counter detergents (for example, Fantastic, Tilex and so on)

Products that contain active ingredients and solutions similar to these products should also be 
avoided.

Expansion Cover Cleaning

1. Use a cellular urethane cleaning swab lightly moistened with the following solution as 
recommended in the APIC guidelines for selection and use of disinfectants (1996):

Sodium hypochlorite (5.2% household bleach) minimum 1:500 dilution (minimum 100 ppm 
free chlorine) and maximum 1:10 dilution.

2. Insert the cotton swab under the expansion interface to clean.

Battery Compartment Cleaning

Under normal operation, the battery compartment should not require cleaning. If the battery 
compartment does require cleaning, follow these instructions.

1. Remove the battery from the battery compartment.

2. Clean the device with a gauze pad or cloth lightly moistened with one of the following:

 Water

 Soap

3. Use a cloth lightly moistened with distilled water to rinse away the cleaning solution. Make 
sure moisture does not enter the electronics area below the battery compartment floor.

4. Dry thoroughly with a soft lint-free cloth. Allow the battery compartment to air dry completely 
prior to closing the compartment door.
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PDM Bedrail/Mount

Perform the daily cleaning of the PDM bedrail/mount as shown in the following sections.

Tools

 Multiple soft, lint-free cloths

 Cotton swab

 Mild dishwashing detergent

 Clorox bleach (Active ingredient: 5.25% Sodium Hypochlorite-off the shelf) Mix 10:1 with H2O.

Cleaning and Disinfection

1. Wipe down the component with a soft, lint-free cloth lightly dampened with mild dishwashing 
detergent diluted in water. Wring excess fluid from lint-free cloth before using. Avoid contact 
with open vents.

2. Wipe the surfaces with a clean, dry, soft, lint-free cloth until the equipment is thoroughly dry.

3. To disinfect, wipe exterior with a soft lint-free cloth lightly dampened with any one of the 
permitted cleaning agents as follows:

 Clorox bleach (Active ingredient: 5.25% Sodium Hypochlorite-off the shelf) Mix 10:1 with 
H2O.

 Sagrotan (dilution 3:100, containing 75 mg tartaric acid per 100 ml solution).

NOTE:  Wring excess disinfectant from lint free cloth before using.

 Contact of disinfectant solution with metal parts may cause corrosion.

4. Allow solution to remain on device for a minimum of one minute or per hospital guidelines.

5. Take care not to let fluid “pool” around connection pins. If this happens, blot dry with a soft, lint-
free cloth or cotton swab. Shake out excess liquids from connector recesses.

6. Dry the equipment thoroughly with a clean dry soft, lint-free cloth after disinfecting.

NOTE: Drying times may vary based on environmental conditions.

Stimulator Cable

Perform the monthly cleaning of the Stimulator cable as shown in the following sections.

Tools

 Cotton swabs

 Multiple soft, lint-free cloths

 Mild dishwashing detergent

 Sodium hypochlorite (5.2% household bleach) minimum 1:500 dilution (minimum 100 ppm 
free chlorine) and maximum 1:10 dilution
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Cleaning and Disinfection

 Wipe down the component with a soft, lint-free cloth lightly dampened with mild dishwashing 
detergent diluted in water. Wring excess fluid from lint-free cloth before using. Avoid contact 
with open vents, plugs, or connectors.

 Wipe the surfaces with a clean, dry, soft, lint-free cloth until the equipment is thoroughly dry.

 To disinfect, wipe exterior with a soft lint-free cloth, using the following solution as 
recommended in the APIC Guidelines for Selection and Use of Disinfectants (1996): Sodium 
hypochlorite (5.2% household bleach) minimum 1:500 dilution (minimum 100 ppm free 
chlorine) and maximum 1:10 dilution.

NOTE: Wring excess disinfectant from lint-free cloth before using.

 Dry the equipment thoroughly with a clean, dry, soft, lint-free cloth after disinfecting.

 Do not make patient connections until equipment is thoroughly dry.

 Clean each connector port with a dry cotton swab.

 Take care not to let fluid “pool” around connection pins. If this should happen, blot dry with a 
soft, lint-free cloth.
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Ablation Stim Extender Cable

Perform the monthly cleaning of the Ablation Stim Extender cable as shown in the following 
sections.

Tools

 Cotton swabs

 Multiple soft, lint-free cloths

 Mild dishwashing detergent

 Sodium hypochlorite (5.2% household bleach) minimum 1:500 dilution (minimum 100 ppm 
free chlorine) and maximum 1:10 dilution

Cleaning and Disinfection

 Wipe down the component with a soft, lint-free cloth lightly dampened with mild dishwashing 
detergent diluted in water. Wring excess fluid from lint-free cloth before using. Avoid contact 
with open vents, plugs, or connectors.

 Wipe the surfaces with a clean, dry, soft, lint-free cloth until the equipment is thoroughly dry.

 To disinfect, wipe exterior with a soft lint-free cloth, using the following solution as 
recommended in the APIC Guidelines for Selection and Use of Disinfectants (1996): Sodium 
hypochlorite (5.2% household bleach) minimum 1:500 dilution (minimum 100 ppm free 
chlorine) and maximum 1:10 dilution.

NOTE: Wring excess disinfectant from lint-free cloth before using.

 Dry the equipment thoroughly with a clean, dry, soft, lint-free cloth after disinfecting.

 Do not make patient connections until equipment is thoroughly dry.

 Clean each connector port with a dry cotton swab.

 Take care not to let fluid “pool” around connection pins. If this should happen, blot dry with a 
soft, lint-free cloth.
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Auxiliary Cable

Perform the daily cleaning of the Auxiliary cable as shown in the following sections.

Tools

 Cotton swabs

 Multiple soft, lint-free cloths

 Mild dishwashing detergent

 Sodium hypochlorite (5.2% household bleach) minimum 1:500 dilution (minimum 100 ppm 
free chlorine) and maximum 1:10 dilution

Cleaning and Disinfection

 Wipe down the component with a soft, lint-free cloth lightly dampened with mild dishwashing 
detergent diluted in water. Wring excess fluid from lint-free cloth before using. Avoid contact 
with open vents, plugs, or connectors.

 Wipe the surfaces with a clean, dry, soft, lint-free cloth until the equipment is thoroughly dry.

 To disinfect, wipe exterior with a soft lint-free cloth, using the following solution as 
recommended in the APIC Guidelines for Selection and Use of Disinfectants (1996): Sodium 
hypochlorite (5.2% household bleach) minimum 1:500 dilution (minimum 100 ppm free 
chlorine) and maximum 1:10 dilution.

NOTE: Wring excess disinfectant from lint-free cloth before using.

 Dry the equipment thoroughly with a clean, dry, soft, lint-free cloth after disinfecting.

 Do not make patient connections until equipment is thoroughly dry.

 Clean each connector port with a dry cotton swab.

 Take care not to let fluid “pool” around connection pins. If this should happen, blot dry with a 
soft, lint-free cloth.

Capnoflex LF CO2 Module

The CapnoFlex LF CO2 Module manufacturer recommends performing a module calibration 
verification procedure yearly. Refer to the CapnoFlex LF CO2 Module Service Manual (PN 
2000966-449) for details. 

Other GE Peripheral Devices

To perform the planned maintenance for the following devices, refer to the respective supplier 
service manual for the proper cleaning and disinfection procedure.

 PDM

 TRAM-RAC 4A

 TRAM module

 Capnostat Sensor

 DASH

 SOLAR
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Maintenance
 Vivid i/q

 Innova Central Touch Screen Unit (ITU)
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OEM Component Support Locations

Component 
Type

Component Support Location

Servers HP ProLiant
ML350p G8 Server

For Service and Maintenance Guide, go to 

http://bizsupport2.austin.hp.com/bizsupport/TechSupport/Home.jsp.

In the left hand panel, select Manuals, enter ProLiant ML350p Gen 8 Server in the Search field, 
select >>. The link to the documentation will appear. Click the link and select the applicable 
document from the list of documents.

HP ProLiant
DL370 G6 Server

For Service and Maintenance Guide, go to 

http://bizsupport2.austin.hp.com/bizsupport/TechSupport/Home.jsp.

In the left hand panel, select Manuals, enter ProLiant DL370 G6 Server in the Search field, 
select >>. The link to the documentation will appear. Click the link and select the applicable 
document from the list of documents.

HP ProLiant
ML370 G5 Server

For Service and Maintenance Guide, go to 

http://bizsupport2.austin.hp.com/bizsupport/TechSupport/Home.jsp.

In the left hand panel, select Manuals, enter ProLiant ML370 G5 Server in the Search field, 
select >>. The link to the documentation will appear. Click the link and select the applicable 
document from the list of documents.

Acquisition 
Systems and 
Review 
Workstations

HP z600 For Service and Maintenance Guide, go to 

http://h20000.www2.hp.com/bizsupport/TechSupport/Home.jsp.

In the left hand panel, select Manuals, enter z600 in the Search field, select >>. The link to the 
documentation will appear. Click the link and select the applicable document from the list of 
documents.

Monitors NEC 20-inch
LCD2090UXi-BK-1

For Service and Maintenance Guide, go to http://necdisplay.com and use the Search function to 
locate the applicable document.

EIZO 21-inch
S2133

For Service and Maintenance Guide, go to http://www.eizo.com click Support > Manuals and use 
the Search function to locate the applicable document.
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Printers

HP Color LaserJet
CP2025n

For Service and Maintenance Guide, go to 

http://h20000.www2.hp.com/bizsupport/TechSupport/Home.jsp.

In the left hand panel, select Manuals, enter CP2035n in the Search field, select >>. The link to 
the documentation will appear. Click the link and select the applicable document from the list of 
documents.

HP Color LaserJet 
M451nw

For Service and Maintenance Guide, go to 

http://h20000.www2.hp.com/bizsupport/TechSupport/Home.jsp.

In the left hand panel, select Manuals, enter m451nw in the Search field, select >>. The link to the 
documentation will appear. Click the link and select the applicable document from the list of 
documents.

HP LaserJet
P2035n

For Service and Maintenance Guide, go to 

http://h20000.www2.hp.com/bizsupport/TechSupport/Home.jsp.

In the left hand panel, select Manuals, enter P2035n in the Search field, select >>. The link to the 
documentation will appear. Click the link and select the applicable document from the list of 
documents.

HP LaserJet 
M401n

For Service and Maintenance Guide, go to 

http://h20000.www2.hp.com/bizsupport/TechSupport/Home.jsp.

In the left hand panel, select Manuals, enter m401n in the Search field, select >>. The link to the 
documentation will appear. Click the link and select the applicable document from the list of 
documents.

Stimulator MicroPace
EPS320 Cardiac 
Stimulator

For Service and Maintenance Guide, go to www.micropaceep.com and use the Search function to 
locate the applicable document.

Backup 
Device

HP D2D Backup 
System D2D2504I

For Service and Maintenance Guide, go to 

http://h20000.www2.hp.com/bizsupport/TechSupport/Home.jsp.

In the left hand panel, select Manuals, enter D2D2504I in the Search field, select >>. Select HP 
D2D2504I Backup System. The link to the documentation will appear. Click the link and select the 
applicable document from the list of documents.

Component 
Type

Component Support Location
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Disk Defragmentation

This section provides the defragmentation process. While RAID systems provide for reduced 
fragmentation of files, it is very important to defragment the Centricity Cardiology INW server, 
Acquisition systems and Review Workstations.

NOTE: The more frequent defragmentation is run, the less time it will take to complete the 
process.

Defragmentation Scheduling Recommendations

GE Healthcare recommends that defragmentation should be run every six months to ensure 
proper operation of Mac-Lab/CardioLab systems.

GE Healthcare does NOT recommend an automated or scheduled task for the defragmentation 
process of the Mac-Lab/CardioLab systems.

Centricity Cardiology INW Server

The Centricity Cardiology INW server operates with the Windows Server 2008 software system.

NOTE: Depending on the last time defragmentation was run, this process could take up to 
several hours to complete.

1. Logon to the Centricity Cardiology INW server as Administrator.

2. Select Start > All Programs > Accessories > System Tools > Disk Defragmenter. The 
Disk Defragmenter window appears.

3. Select (C:\) and click Defragment. The Session Status will indicate Defragmenting until the 
defragmenting process is complete.

NOTE: Wait for the defragmentation process to complete.

4. Select (D:\) and click Defragment. The Session Status will indicate Defragmenting until the 
defragmenting process is complete.

5. Click Close.
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Acquisition System/Review Workstation

The Acquisition system and Review Workstation operate with the Windows XP SP3 software 
system.

NOTE: Depending on the last time defragmentation was run, this process could take up to 
several hours to complete.

1. Logon to the Acquisition system or Review Workstation as MLCLTechUser.

2. Select Start > Programs > Accessories > System Tools > Disk Defragmenter. The Disk 
Defragmenter window appears.

3. Select (C:\) and click Defragment. The Session Status will indicate Defragmenting until the 
defragmenting process is complete.

NOTE: Wait for the defragmentation process to complete.

4. Click Close on the dialog indicating the defrag is complete.

5. Select (D:\) and click Defragment. The Session Status will indicate Defragmenting until the 
defragmenting process is complete.

6. Click Close on the dialog indicating the defrag is complete.

7. Click Close.
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Event Log Collection from the Centricity Cardiology 
INW Server

The following steps need to be performed every month on the Centricity Cardiology INW server to 
collect the Event Viewer logs of the INW server and all Acquisition, Review and Software Only 
Review systems. The logs will be stored in a central location on the INW Server.

1. Log on to the INW Server as domain Administrator. 

2. Select Start > Run and then type Eventvwr to open the Event Viewer.

3. In the Event Viewer window, select Action > Connect to Another Computer...

4. In the Select Computer dialog, select the Another Computer option and click Browse...

5. In the Select Computer dialog that appears, type the computer name in the Enter the Object 
Name field (for example, CLWSXXXXX).

6. Click Check Names. 

NOTE: If the Windows Security dialog opens, enter the user name and password for domain 
MLCLTechUser of the computer and click OK.

7. Click OK on the Select Computer window.

8. Check the Connect as another user check box and then click Set User...

9. Enter the user name and password for <domain name>\MLCLTechUser of the computer/
workstation and click OK.

10. Click OK in the Select Computer dialog. The Event Viewer shows the event logs of the 
system connected in step 5.

11. Browse to Event Viewer > Classic Event Viewer > Global Logs.

12. Right click the Application event folder and select Save Log File As...

13. Navigate to D:\GEData\ArchiveLogs.

14. Change the Save as type to CSV (Common delimited) (*.csv).

15. Name the file as <System Name><App, Sys or Security><Date>.csv and click Save.

16. Repeat steps 12 to 15 for the System event folder and the Security event folder.

17. Repeat this procedure for all other systems in the network.
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Troubleshooting
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Troubleshooting
Introduction

This chapter provides detailed troubleshooting information to help resolve hardware, software, 
networking, and other potential issues with the components of the system. Additionally, this 
chapter describes procedures to follow to ensure that the system is properly connected and set up 
before powering on. This chapter also describes how to power on the Acquisition system and the 
Review Workstation. 

Getting Started

Inspection 

The following inspection should be performed before using the equipment:

 Verify all equipment is undamaged and in its proper location.

 Verify all accessories are undamaged.

 Verify all cords and cables are properly connected, tight and undamaged.

 Verify mounted equipment (such as remote monitors, TRAM-RAC 4A or PDM) is properly 
installed and secure.

 Verify that all cords, socketed components and connectors are securely seated.

 Verify that keyboard, mouse and any other input devices are undamaged and working 
properly.

If signs of equipment damage or degradation are present, contact GE Healthcare to determine if 
equipment is safe for use or if a replacement is needed.

Powering on the Acquisition System

Complete the following steps if necessary to power on the Acquisition system:

1. Ensure the Integrated Electronics Box (IEB) is powered on as indicated by the power button 
on the front of the IEB being in the up position. If the IEB is not powered on, switch the power 
button to the up position.

2. Ensure the UPS is powered on as indicated by the green LED on the front of the UPS. If the 
UPS is not powered on, press and hold the power button until the green LED is lit and the 
audible tone stops.

3. Ensure the Acquisition system is powered on as indicated by the blue LED on the front of the 
Acquisition system. If the Acquisition system is not powered on, press the power button on the 
front of the computer until the LED illuminates.

NOTE: The Acquisition system should remain powered on at all times to ensure that the 
scheduled database maintenance that is executed during off peak hours can be 
executed. A database maintenance job is executed on Acquisition systems for better 
performance and to check for consistency and integrity errors in the databases. In a 
network environment studies are also moved from the Acquisition systems to the server 
periodically, which requires that the systems should remain powered on at all times.
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4. Ensure the peripheral devices (printer, ablation device, cardiac stimulator, TRAM-RAC 4A, 
PDM Base Station) are powered on as indicated by their power LEDs. Refer to the device 
specific manuals for instructions to power on if the peripheral devices are not already powered 
on. The TRAM-RAC 4A and PDM Base Station are powered on if they are plugged into power.

NOTE: For information regarding powering on the amplifier, refer to the CardioLab Operator’s 
Manual (PN 2063076-002 non-US or PN 2063076-302 US-only).

Powering on the Review Workstation

Complete the following steps if necessary to power on the Remote Review Workstation, Pre/Post 
Review Workstation or Nurse's Workstation:

1. Ensure the isolation transformer is powered on as indicated by the power button being in the 
up position. If the isolation transformer is not powered on, switch the power button to the up 
position.

2. Ensure the Review Workstation computer is powered on as indicated by the power LED being 
illuminated. If the Review Workstation computer is not powered on, press the power button on 
the front of the computer.

3. Ensure the monitor is powered on as indicated by the power LED being illuminated. If the 
monitor is not powered on, press the power button on the front of the monitor.

4. Ensure the DASH or Solar monitor (Pre/Post Workstations only) is powered on as indicated by 
the DASH or Solar monitor power LED. Refer to the DASH or Solar specific manual for more 
detailed information.

NOTE: The Solar and DASH monitors must only be connected to Pre/Post Workstations. Do not 
connect a Solar or DASH monitor to an Acquisition, Nurse's, or Remote Workstation.
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Troubleshooting

Initial Troubleshooting Inspection

WARNING: SHOCK HAZARD

To reduce the risk of shock and equipment damage, use safe working practices 
when servicing electrical equipment.

CAUTION: EQUIPMENT DAMAGE

Do not disconnect or reconnect cables while the system is under power 
(especially the barcode scanner).

Always use the following username for troubleshooting the system:

mlcltechuser (Contact GE Healthcare Technical Support or the system administrator for current 
password information).

NOTE: SECURITY BREACH

Never leave a system logged in as mlcltechuser. When done, always log out and leave 
the system at the custom shell.

Before performing any troubleshooting procedure, check the following:

 The IEB is plugged in and power and ground are available at the wall outlet (also check the 
outlet circuit breaker).

 The IEB, computer, monitors, keyboard and any optional equipment are properly connected 
and all connections are tight. Be sure to check for:

 Frayed cables

 Exposed conductors

 Bent prongs or pins

 Damaged cable housings

 Loose plug screws

 Both IEB power switches (one in front and one in back) are on.

 Computer power switch is on.

 All monitors are turned on and set to the appropriate brightness and contrast.

 Equipment housing for cracks, overheating, or other damage.
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Hardware

Initial Check

1. Right-click My Computer and select Explore.

2. Navigate to C:\Windows\cpqdiag\cpqdiag.exe.

3. Run a complete hardware diagnostic test on the system.

NOTE: The tests also include an internal serial loopback test.

General Issues

No Video Display on the Review Stations with LCD Monitor

Check the video cable. The computer and monitors both have DVI connectors.

 Set screen resolution to 1600 x 1200 for each monitor.

 Use the DVI-VGA adapter with the DB15-HD15 cable. 

 Try the supplied DVI-HD15 cable.

 Try a different cable with the monitor or test the monitor on a different station.

New Hardware Found

If any devices were not automatically installed, a New Hardware Found message may be 

displayed at restart for any one of the following devices: 

 Matrox Helios eA/xA frame grabber 

 Matrox Helios analog acquisition device 

 Matrox Solios eA/XA (quad) frame grabber 

 Matrox Solios Analog Com port 0(COMxx) 

 Matrox Solios Analog Com port 1(COMxx) 

 Matrox Solios Analog Com port 2(COMxx) 

 Matrox Solios Analog Com port 3(COMxx) 

 Matrox Helios Analog Com port(COMxx) 

 Matrox Helios Analog Com port(COMxx) 

 Matrox Helios Analog Com port(COMxx) 

 Matrox Helios Analog Com port(COMxx) 

 Odyssey Vision Processor (XA) 

 Odyssey XA analog acquisition device 

NOTE: Where x is an integer. 

If new hardware is found, perform the following procedure for each wizard: 

1. Select Install the software automatically (Recommended) and click Next. 

2. If a choice of drivers is presented, choose the default selection and click Next. 
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3. If prompted about Windows Logo testing or driver signing, click Continue anyway. 

4. Click Finish when the installation is complete.

Vertical Lines Present on Display – Matrox M9140 Quad Video Board

If vertical lines are present on systems using the Matrox M9140 Quad video board, update the 
device driver to V2.12.00.147 and reconfigure the displays to resolve the issue.

Install Matrox M9140 Quad Video Board Drivers V2.12.00.147

Install the Matrox M9140 Quad video board drivers using CD-R MATROX M9140 QUAD VIDEO 
CARD DRIVER, V2.12.00.147 (P/N 2074635-001).

1. Power on the system.

2. Log on to Windows and the Custom Shell as mlcltechuser.

3. Ignore any New Hardware found messages.

4. If an error message about stopping ONL display appears, click OK. 

5. Insert CD-R MATROX M9140 QUAD VIDEO CARD DRIVER, V2.12.00.147 (P/N 2074635-
001) into the drive.

6. Browse to the CD drive and double-click Setup.exe.

7. At the Matrox Display Driver Installation - Matrox PowerDesk window, click Next.

8. At the Matrox Display Driver Selection window, click Next.
4-6 Mac-Lab/CardioLab/Centricity Cardiology INW Service Manual 2063076-010H EN 



Troubleshooting
9. At the Ready to Install window, click Next.

10. At the Installation Completed Successfully window, click Next.

11. At the Installation Completed window, click the Restart Computer checkbox and click 
Finish.

Post Installation Steps for Matrox M9140 Quad Video Board Drivers V2.12.00.147

After installing drivers for the Matrox M9140, the logon fields might not display properly when the 
computer first restarts. Restarting the computer again resolves the issue.

1. Log on as mlcltechuser.

NOTE: The logon fields are present, but might not display properly. 

2. Shut down and restart the system again to resolve the issue.

3. Log on to Windows and the Custom Shell as mlcltechuser.

4. Reconfigure the monitor settings using Set Display Configurations in the Centricity Cardiology 
New Installation Manual (P/N 2047900-108).
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Acquisition Hard Drive Failure

RAID Failure

When the system gives indication of a RAID failure, it typically means that a drive has failed and 
should be replaced. 

NOTE: If a drive failure is detected, a message containing information about the problem will 
open. If this happens, the system should remain functional, but any local study data will 
be at risk if another failure occurs. Contact your GE Healthcare Service Representative to 
schedule a hard drive replacement. 

The following procedure requires:

 Access to the Acquisition system

 Appropriate replacement hard drive for the system

 Approximately 1 hour

HP z600 Workstation

1. Log on to the system as mlcltechuser.

2. Select Start > Programs > Intel > Intel Rapid Storage Technology.

Both drives will be shown attached to the PRIMARY array.

3. Click on the failed drive.
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4. Record the Serial Number and Port.

5. Shut the system down and remove the power.

6. Open the side panel of the system.

7. Using the Serial Number and Port, determine which drive to remove.

8. Remove the drive from the system.

9. Place the new drive into the system.

10. Replace the side panel of the system.

11. Reattach the power and turn on the system.

12. When the BIOS screen appears, press the space bar to show all boot information.

13. Press Ctrl + I when the RAID configuration utility message appears.

14. Press Enter to select to rebuild the new hard drive in the Degraded Volume Detected screen.

15. Press 5 to Exit the RAID configuration utility. Enter Y to confirm the exit of the RAID 
configuration utility. 

16. Allow the system to boot normally, logging into Windows as mlcllogonuser. Logon to the 
custom shell as mlcluser.

17. Once the system boots to Windows, the Intel Rapid Storage Technology will pop up a 
message in the taskbar. Click on the message and ensure the RAID is now rebuilding on the 
new drive.

NOTE: The RAID rebuild process may take up to one hour to complete.

After the RAID configuration completes, proceed to the Replace One Hard Drive on page 4-10 to 
confirm the RAID has successfully rebuilt.
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RAID Configuration

Replace One Hard Drive

If one of the two hard drives needs to be replaced, replace the drive and complete the following 
procedure to verify a successful RAID configuration.

NOTE: This RAID configuration procedure is not applicable for GE Review workstations.

1. Reboot the system. At the startup screen, press the space bar.

2. Verify that the RAID volume Status is Normal and the Physical Disk Type/Status is Member 
Disk (0).
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Replace Both Hard Drives

This procedure will need to be performed by a GE Healthcare Field Service Engineer.

Communication Issues

Unable to Communicate with Cath Amplifier

 The system cannot have an IP address in the range of 192.168.0.xxx.

Verify the IP address for the system network connection (in network properties) is not 
192.168.0.xxx. For example, if one of the other adapters on the Acquisition system has the IP 
configured for 192.168.0.20, the TRAMNet connection will fail and TRAM/PDM 
communication will fail.

The IP address of the Cath Amplifier is 192.168.0.100 and cannot be changed.

 Verify the TRAMNet jumper cable (1 ft Ethernet cable) is connected into the left network port.

Review Installation manual (if available) and TRAM/Amplifier Connections on page 2-56 for 
proper cable connections. This jumper cable applies only to installations where the TRAM is 
used and is not applicable to PDM.

 If using the PDM, ensure that the PDM is registered on the system. If necessary, run the 
Select Amplifier utility to select and register the PDM on the system. Refer to the Mac-Lab 
Operator’s Manual (PN 2063076-001 non-US or PN 2063076-301 US-only) for details.

PDM Error Messages

NOTE: For additional diagnostic information about the PDM, use the PDM Service Tool which is 
installed on Acquisition systems. Launch the PDM Service Tool from the Start menu by 
selecting Programs > GE Healthcare > PDM Version 2.1 > PDM Version 2.1. Refer to 
the PDM Service Manual for details.

"Cath Amplifier hardware error. Please contact Technical Support."

This is reported when PDM itself reports a hardware error. The actual error code will be logged to 
the Windows event log. Refer to the PDM Service manual for a list of all PDM error codes.

"Cath Amplifier battery error. Please contact Technical Support."

This is reported when PDM reports a battery error. Possible errors related to the battery, could be 
overheating or the battery not inserted properly. See the Windows Event Log for more details.

"Cath Amplifier battery is low. Please charge or replace the battery."

This is reported when a PDM battery is present and its charge level is low. (If battery is not 
present, no message will be reported, but a warning will be logged to the event log upon opening a 
study.). The PDM should be connected to the PDM Base station to charge the battery.

"The Cath Amplifier on this system does not support Invasive Pressures."

This is reported upon opening a Mac-Lab study if the PDM being used does not support any 
invasive blood pressures. Replace the PDM with one that has invasive blood pressures or contact 
a GE Sales Representative to purchase the IBP option for the PDM.
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Switching Ablation Devices

When switching ablation devices during a case, the following is the correct procedure:

1. Select the NULL ablation device driver (Force Sense Device, if any, may remain selected).

2. Click Apply and wait five seconds for the selection to be processed.

3. Perform any necessary switching of ablation cables.

4. Select the new ablation device.

5. Click Apply and wait five seconds for the selection to be processed.

6. Proceed with the case.

NOTE: If the system does not appear to be receiving ablation device data, selecting the NULL 
ablation device and then re-selecting the desired ablation device driver in the ablation 
setup screen will reset the COM port and may resolve the ablation data reception issue. If 
no force device is present, leave the force device selection at the NULL setting.

Switching to/from CryoCath Ablation Device

When switching ablation devices from the CryoCath to any other, the cable should be switched 
first followed by the ablation device driver. When switching from any RF ablation device to the 
CryoCath, the ablation device driver should be switched first followed by the cable. If an ablation 
device appears to not be receiving data, clicking on the ablation device driver in the ablation setup 
screen will reset the com port. This may resolve the ablation data transmission issue.

Barcode Issues

System Locks Up After First Scanning with Barcode Scanner

Ensure the barcode scanner is connected to a USB port. Otherwise, re-seat the connector. 

Scanning Causes an NIBP/NBP Measurement

Scanning a particular type of barcode during the Mac-Lab/CardioLab study can trigger an NIBP/
NBP measurement. This occurs when EAN128 format barcodes are scanned. The barcode 
scanner reads the hidden characters of the scan code in case of USB interface and then 
generates the F8 key press, which will initiate the NIBP/NBP measurement. Refer to the Mac-Lab/
CardioLab Barcode Scanner Configuration Instructions (PN 2050508-001).

To allow for scanning of the EAN128 format, the configuration of the barcode scanner needs to be 
updated. To update the barcode scanner, scan the following configuration barcode.
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This is a one time configuration and will be permanent on the barcode scanner. This configuration 
can even be performed during the study.

“Item not found” Error when Scanning Inventory with Barcode Scanner

When using a barcode scanner on ComboLab systems, error “Item not found” may occur when 
switching between Mac-Lab and CardioLab systems and the user is trying to scan inventory. This 
error occurs because DMS supports lists by modality and inventory is unique only in a modality.

When using a ComboLab system and entering inventory with the barcode scanner the user must 
close and restart the Mac-Lab/CardioLab application when switching between Mac-Lab and 
CardioLab studies. Restarting the application between Mac-Lab and CardioLab studies will ensure 
the proper inventory list is presented for each respective study.

CardioLab II Plus Amplifier

CardioLab II Plus Amplifier Does Not Send Signals to CardioLab System

If the CardioLab II Plus Amplifier does not send signals to the CardioLab system or unable to 
communicate with amplifier message is received: 

1. Ensure that the amplifier is plugged in and turned on.

2. Verify that the external cables are connected properly and are securely attached.

3. Replace the fiber optic cable (FOC).

4. Clean the FOC with isopropyl (rubbing) alcohol and blow out the connectors with compressed 
air. 

5. Disconnect the FOC from back of the computer and make sure that there is a light coming 
from the end of the cable that was plugged into CPU IN. 

6. With the amplifier and computer turned on, the green LED next to the CPU IN port on the 
computer will turn green when connected properly. 

7. If the problem is intermittent, this problem may indicate a dirty or broken FOC or connector. 

8. If the problem persists, ensure that all connections inside the amplifier are secure and the 
boards are seated securely in their slots. 

Random Spikes or Square Waveforms Appear in Signals

Random spikes or square waveforms appear in signals when not stimulating the patient: 

 Clean the FOC contacts with a non-abrasive, lint-free cloth and isopropyl alcohol. 

 Replace the fiber optic cable.

 If the waveforms only exist on one channel, try replacing either the catheter, catheter extender, 
or catheter junction box. In addition, try another Catheter Input Module. 

Fiber Optic Cables

1. Clean each end of the fiber optic cable connecting the amplifier to the computer with a soft, 
dry, clean cloth.
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2. Use a can of compressed air to remove any dust accumulation from the connector at the 
amplifier.

CardioLab Signal Noise

This section identifies basic causes of signal noise and suggested solutions. Noise can be caused 
by a number of different factors that may interact with each other. Only GE approved accessories 
and supplies should be used with the Mac-Lab/CardioLab system to avoid noise issues.

Contact your GE Service Representative if the noise cannot be corrected. Be sure to keep notes 
about the noise type and what was tried to correct the noise.

For CardioLab, over filtered “Blocky” signals can be improved by adjusting filter settings, screen 
resolution, sampling rate and contrast / brightness as listed in the following:

 Select 0.05Hz or 0.5Hz for ECG signals; a high-pass filter setting too high (5Hz) will distort the 
waveform.

 Turn off notch filters on Intracardiac channels.

 Set screen resolution to 1600 x 1200 for each monitor.

 Increasing sample rate from 1K to 2K can improve signal quality.

The following actions can be taken to reduce the risk of medical device Electromagnetic 
Interference (EMI) and achieve Electromagnetic Compatibility (EMC):

 Assess the EMC environment of the healthcare facility (for example, identify radio transmitters 
in and around the facility) and identify areas where critical medical devices are used (for 
example, ER, ICU, CCU, NICU).

 Increase the distance between sources of EMI and susceptible devices.

 Remove devices that are highly susceptible to EMI.

 Lower power transmitted from electrical and electronic equipment (EMI sources) under 
hospital control (for example, paging systems).

 Label devices susceptible to EMI.

 Educate healthcare facility staff (nurses and doctors) to be aware of and to recognize, 
potential EMI related problems.

Surface ECG Noise

Overview

Proper placement of electrodes and good skin preparation are vital to getting ECG signals free of 
noise. The Right Leg electrode is the reference lead of the Mac-Lab/CardioLab system and good 
contact with the patient is critical to all ECG and Intracardiac (CardioLab only) signals.

Surface ECG noise can appear on some traces but not others. To help troubleshoot the cause of 
noise, Einthoven's Theorem can be used to determine the problem electrode or lead wire.
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Examples of how Einthoven's Theorem can be used:

 If Lead I and II are noisy but Lead III is normal, look for a bad electrode / lead wire at Right 
Arm.

 If Lead I and III are noisy but Lead II is normal, look for a bad electrode / lead wire at Left Arm.

 If Lead II and III are noisy but Lead I is normal, look for a bad electrode / lead wire at Left Leg.

 If all leads are noisy, look for a bad electrode / lead wire at Right Leg (or multiple electrodes / 
lead wires).

The Multi-Link ESU ECG patient cable is recommended when using in the presence of an 
electrosurgical unit. This cable, with a built-in ESU filter, helps reduce electrosurgical noise 
detected on the ECG signal.

ECG noise can be categorized into several different types of noise including power line frequency, 
baseline drift and muscle artifact. For CardioLab systems only, additional noise types are ablation 
and pacing artifact. 

Power Line Frequency Noise - ECG

The Power Line Frequency noise is the most common type of noise with traces becoming fuzzy, 
thick, or dull. Power Line Frequency Noise can appear on one or all ECG traces. The source of the 
noise is derived from the local AC power frequency, 60Hz or 50Hz. The 60Hz sine wave noise can 
be measured (period of the 60Hz sine wave is 1/60 = 16.7ms) by turning up the display speed. The 
notch filter is designed to filter this noise out.

Example of Power Line Frequency Noise - 60Hz noise on all ECG traces:
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Typically, Power Line Frequency noise is the result of a difference in ECG lead wire impedance 
(poor connection with the patient). For CardioLab systems, Power Line Frequency can induce 
noise on the CardioLab II Plus Amplifier.

Possible contributing factors of Power Line Frequency noise include:

 Notch filter turned off (CardioLab only)

 Bad lead wires

 Bad patient cables

 Poor electrode connection with the patient

Recommended corrective actions include:

 Turn on the notch filter on all ECG traces (CardioLab only)

 Replace bad or worn out lead wires

 Replace bad or worn out patient cables

 Ensure electrodes have been placed in the correct location where the skin was properly 
prepared. Typically, this noise source improves with no intervention after 10 minutes of contact 
with the patient.

Baseline Drift Noise - ECG

The Baseline Drift noise appears as if the entire ECG trace is moving vertically. The frequency of 
this noise is a variable. The ECG trace can move with some physical movement in the lab. 

Example of Baseline Drift Noise:
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The Baseline Drift noise is often the result of differences in ECG lead wire impedance (poor 
connection with the patient) inducing noise from some physical movement near the patient.

Possible contributing factors of Baseline Drift noise include:

 Bad lead wires

 Bad patient cables

 Poor electrode connection with the patient

 Electrode location susceptible to respiration movement

 Patient movement

 Patient drape movement

 Patient table not grounded properly

Recommended corrective actions include:

 Adjust the High Pass Filter to a higher setting to filter out this noise (for example, change from 
0.05 Hz to 0.5 Hz) (CardioLab only)

 Replace bad or worn out lead wires

 Replace bad or worn out patient cables

 Ensure electrodes have been placed in the correct location where the skin was properly 
prepared. Typically, this noise source improves with no intervention after 10 minutes of contact 
with the patient.

 Limit patient movement
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 Ground the patient table with a common ground shared with the TRAM-RAC or PDM Base 
Station (Mac-Lab only) or CardioLab II Plus Amplifier (CardioLab only).

Muscle Artifact Noise - ECG

The Muscle Artifact noise is a variable noise riding on a trace or multiple traces. This noise can be 
traced to movement of the patient such as shivering or snoring. The Muscle Artifact noise is often 
the result of a difference in ECG lead wire impedance (poor connection with the patient).

Example of Muscle Artifact Noise:

Possible contributing factors of Muscle Artifact noise include:

 Bad lead wires

 Bad patient cables

 Poor electrode connection with the patient

 Electrode location 

 Patient movement caused by patient being cold, reaction to medications, or snoring

Recommended corrective actions include:

 Replace bad or worn out lead wires

 Replace bad or worn out patient cables

 Ensure electrodes have been placed in the correct location where the skin was properly 
prepared. Typically, this noise source improves with no intervention after 10 minutes of contact 
with the patient.

 Limit patient movement

Pacing Artifact Noise - ECG

The Pacing Artifact noise (CardioLab only) occurs while the pace generator (stimulator) is actively 
pacing the heart and disappears after the pacing pulses are turned off. Generally, the higher the 
pacing current, the higher the amplitude of noise will be generated on the ECG trace. Some pacing 
artifact is considered normal operation.

NOTE: Stimulators are constant current sources. If the resistance is higher than the normal due 
to bad or corroded cables/connections, the voltage delivered by the stimulator will be 
higher and therefore more likely to generate larger spikes/artifact. To help troubleshoot a 
possible problem, the CardioLab II Plus Amplifier can be bypassed using the direct 
stimulator connection on the CIM module.
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Example of Pacing Artifact Noise:

Possible contributing factors of Pacing Artifact noise include:

 Excessively high pacing current settings on the stimulator (“milliamp” output and “duration” 
settings)

 Bad stimulator cables

 Loose fitting or bad stimulator connections

 Stimulator Isolation / Interface box (low batteries)

 Pacing for long periods of time causing a charge build-up on the pacing poles of the catheter. 
This will lead to a natural occurring event of a long decay back to baseline after each pacing 
spike.

Recommended corrective actions include:

 Reduce the pacing current (Common settings: 1-5mA @ 2.0ms)

 Replace bad or worn out stimulator cables

 Replace batteries present in Stimulator Isolation / Interface box

 Use a bi-phasic stimulator

Ablation Noise - ECG

The Ablation noise (CardioLab only) occurs while the RF generator is actively ablating the heart 
and disappears after the generator is turned off. A large spike on the waveform may occur at the 
time the RF generator changes its power output (turned on or turned off). This spike could be 
confused with a pacing spike.
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Example of Ablation Noise - With RF Generator On:

Possible contributing factors of Ablation noise include:

 Bad lead wires

 Bad patient cables

 Poor electrode connections with the patient

 Bad ablation grounding pad

 Proximity of electrodes / lead wires to RF source

 Grounding of equipment

Recommended corrective actions include:

 Replace bad or worn out lead wires

 Replace bad or worn out patient cables

 Ensure electrodes have been placed in the correct location where the skin was properly 
prepared. Typically, this noise source improves with no intervention after 10 minutes of contact 
with the patient.

 Replace bad or worn out grounding pad

 Ground the Ablation Device (RF Generator) and patient table with a common Ground shared 
with the CardioLab II Plus Amplifier.

Intracardiac Signal Noise

Overview

The Intracardiac Signal noise is applicable to the CardioLab system only. Proper placement of 
catheters and good electrical contact are vital to maintaining Intracardiac signals free of noise. The 
Right Leg electrode is the reference lead of the CardioLab system and good contact with the 
patient is critical to all ECG and Intracardiac signals.

When troubleshooting Intracardiac signal noise issues, it is possible to configure a new channel of 
the amplifier and move the poles of the catheter to different poles of the CIM module. If the same 
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noise is seen on two identical channels of the CardioLab II Plus Amplifier, the problem is likely not 
the amplifier but the signal or ground wiring.

Intracardiac signal noise can be categorized into several different types of noise including power 
line frequency, baseline drift, pacing artifact, ablation, unipolar high frequency and mapping 
systems.

Power Line Frequency Noise - Intracardiac

The Power Line Frequency noise is the most common type of noise (when not ablating) with 
traces becoming fuzzy, thick, or dull. Power Line Frequency Noise can appear on one or all 
Intracardiac traces. The source of the noise is derived from the local AC power frequency, 60Hz or 
50Hz. The power line frequency noise can be measured by turning up the display speed and 
measuring the period of corresponding sine wave (1000ms/60 = 16.7ms for 60Hz or 1000ms/50 = 
20ms for 50Hz).

Example of Power Line Frequency Noise - 60Hz noise on all ECG traces:

Possible contributing factors of Power Line Frequency noise include:

 Grounding of devices (bad electrical grounds: power outlets at the patient table / wall outlet, 
power strips, equipment in the lab, power cords)

 Bad Ablation Device cabling (Personality module/wires)

 Poor routing of wires / cables around other equipment

 Poor electrode connection with the patient - Right Leg lead

 High Gain (>5000) will amplify signal as well as noise

Recommended corrective actions include:

 Ground the Ablation Device (RF Generator) and patient table with a common ground shared 
with the CardioLab II Plus Amplifier

 Replace Ablation Device cabling (personality module/wires)

 Improve routing of wires / cables away from other equipment

 Replace bad or worn out lead wires

 Replace bad or worn out patient cables

 Ensure electrodes have been placed in the correct location where the skin was properly 
prepared. Typically, this noise source improves with no intervention after 10 minutes of contact 
with the patient.

Baseline Drift Noise - Intracardiac

The Baseline Drift noise appears as if the entire trace is moving vertically. The frequency of this 
noise is a variable but low in frequency, similar to the surface ECG baseline trace. 

Possible contributing factors of Baseline Drift noise include:
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 Bad lead wires

 Bad patient cables

 Poor electrode connection with the patient

 Electrode location susceptible to respiration movement

 Patient movement

 Patient drape movement

 Patient table not grounded properly

Recommended corrective actions include:

 Adjust the High Pass Filter to a higher setting to filter out this noise (for example, normal 
setting: m30 Hz for Intracardiac signal)

 Replace bad or worn out lead wires

 Replace bad or worn out patient cables

 Ensure electrodes have been placed in the correct location where the skin was properly 
prepared. Typically, this noise source improves with no intervention after 10 minutes of contact 
with the patient.

 Limit patient movement

 Ground the patient table with a common ground shared with the CardioLab II Plus Amplifier

Pacing Artifact Noise - Intracardiac

The Pacing Artifact noise occurs while the pace generator (stimulator) is actively pacing the heart 
and disappears after the pacing pulses are turned off. Generally, the higher the pacing current, the 
higher the amplitude of noise will be generated on the trace.

NOTE: Stimulators are constant current sources. If the resistance is higher than the normal due 
to bad or corroded cables/connections, the voltage delivered by the stimulator will be 
higher and therefore more likely to generate larger spikes/artifact. To help troubleshoot a 
possible problem, the CardioLab II Plus Amplifier can be bypassed using the direct 
stimulator connection on the CIM module.

Example of Pacing Artifact Noise:
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Possible contributing factors of Pacing Artifact noise include:

 Excessively high pacing current settings on the stimulator (“milliamp” output and “duration” 
settings)

 Bad stimulator cables

 Loose fitting or bad stimulator connections

 Stimulator Isolation / Interface box (low batteries)

 Pacing for long periods of time causing a charge build-up on the pacing poles of the catheter. 
This will lead to a natural occurring event of a long decay back to baseline after each pacing 
spike.

Recommended corrective actions include:

 Reduce the pacing current (Common settings: 1-5mA @ 2.0ms)

 Replace bad or worn out stimulator cables

 Replace batteries present in Stimulator Isolation / Interface box

 Use a bi-phasic stimulator

Ablation Noise - Intracardiac

The Ablation noise occurs while the RF generator is actively ablating the heart and disappears 
after the generator is turned off. Generally, the higher the power setting on the RF generator, the 
higher the amplitude of noise. Noise on the Ablation Distal signal is the most difficult noise to 
eliminate. With power settings above 35W, noise is expected on the Ablation Distal signal. Using 
the Pacing Enabled RF Filter Box kit (PN 2082432-001) will help filter out the Ablation noise.

Example of Ablation Noise:
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Possible contributing factors of Ablation noise include:

 Poor electrode connections with the patient

 Bad ablation grounding pad

 Proximity of electrodes / lead wires to RF source

 Grounding of equipment

 Old version of EPT Personality Module are not designed for “Ablate and Record” capability

 No Pacing Enable RF Filter Box kit

Recommended corrective actions include:

 Ensure electrodes have been placed in the correct location where the skin was properly 
prepared. Typically, this noise source improves with no intervention after 10 minutes of contact 
with the patient.

 Replace bad or worn out grounding pad

 Ground the Ablation Device (RF Generator) and patient table with a common Ground shared 
with the CardioLab II Plus Amplifier.

 Replace “Ablate and Record” Personality Module and associated cables

 Use Pacing Enabled RF Filter Box kit

Unipolar High Frequency Noise - Intracardiac

The Unipolar High Frequency noise is the result of a difference in noise level on the catheter pole 
and the channel reference (either the surface ECG Wilson Central Terminal (WCT) or Aux Ref). 
Unipolar signals are more susceptible to noise because a catheter pole and a channel reference 
affect the common mode rejection of the system.

Possible contributing factors of Muscle Artifact noise include:

 Bad lead wires

 Bad patient cables

 Poor electrode connection with the patient

 Placement of ECG cable near the other devices (when WCT is used as channel reference) 
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Recommended corrective actions include:

 Adjust the Low Pass Filter to a lower setting to filter out this noise (for example, change from 
1000Hz to 150Hz)

 Replace bad or worn out lead wires

 Replace bad or worn out patient cables

 Ensure electrodes have been placed in the correct location where the skin was properly 
prepared. Typically, this noise source improves with no intervention after 10 minutes of contact 
with the patient.

 Route the ECG cable away from other electrical devices

Mapping System Noise - Intracardiac

The Mapping System noise is typically associated with power Line frequency noise or magnet 
generated noise. Turning the display speed up faster and using calipers will allow the noise 
frequency to be measured (the period of the 60 Hz sine wave is 1/60 = 16.7 ms).

Example of Mapping System Noise:

Possible contributing factors of Mapping System noise include:

 Poor electrode connections with the patient

 Grounding of equipment

 Magnet interference

 5.6KHz End Guide Signal (a signal emitted from the top of the ESI catheter used for catheter 
location)

Recommended corrective actions include:

 Adjust the Low Pass Filter to 150 Hz to filter out magnet interference or 5.6 KHz End Guide 
signal interference

 Ensure electrodes have been placed in the correct location where the skin was properly 
prepared. Typically, this noise source improves with no intervention after 10 minutes of contact 
with the patient.

 Ground the Mapping System and patient table with a common Ground shared with the 
CardioLab II Plus Amplifier.
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Mac-Lab Signal Noise

This section identifies basic causes of signal noise and suggested solutions. Noise can be caused 
by a number of different factors that may interact with each other. Only GE approved accessories 
and supplies should be used with the Mac-Lab system to avoid noise issues.

NOTE: The use of electrocautery may cause noise on waveforms. 

Contact your GE Service Representative if the noise cannot be corrected. Be sure to keep notes 
about the noise type and what was tried to correct it.

The following actions can be taken to reduce the risk of medical device Electromagnetic 
Interference (EMI) and achieve Electromagnetic Compatibility (EMC):

 Assess the EMC environment of the healthcare facility (for example, identify radio transmitters 
in and around the facility) and identify areas where critical medical devices are used (for 
example, ER, ICU, CCU, NICU).

 Increase the distance between sources of EMI and susceptible devices.

 Remove devices that are highly susceptible to EMI.

 Lower power transmitted from electrical and electronic equipment (EMI sources) under 
hospital control (for example, paging systems).

 Label devices susceptible to EMI.

 Educate healthcare facility staff (nurses and doctors) to be aware of and to recognize, 
potential EMI related problems.

Surface ECG Noise

Proper placement of electrodes and good skin preparation are vital to getting ECG signals free of 
noise. The Right Leg electrode is the reference lead of the Mac-Lab system and good contact with 
the patient is critical to all ECG signals.

Surface ECG noise can appear on some traces but not others. To help troubleshoot the cause of 
noise, Einthoven's Theorem can be used to determine the problem electrode or lead wire.

Examples of how Einthoven's Theorem can be used:
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 If Lead I and II are noisy but Lead III is normal, look for a bad electrode / lead wire at Right 
Arm.

 If Lead I and III are noisy but Lead II is normal, look for a bad electrode / lead wire at Left Arm.

 If Lead II and III are noisy but Lead I is normal, look for a bad electrode / lead wire at Left Leg.

 If all leads are noisy, look for a bad electrode / lead wire at Right Leg (or multiple electrodes / 
lead wires).

The Multi-Link ESU ECG patient cable is recommended when using in the presence of an 
electrosurgical unit. This cable, with a built-in ESU filter, helps reduce electrosurgical noise 
detected on the ECG signal.

ECG noise can be categorized into several different types of noise including power line frequency, 
baseline drift and muscle artifact.

Power Line Frequency Noise - ECG

The Power Line Frequency noise is the most common type of noise with traces becoming fuzzy, 
thick, or dull. Power Line Frequency Noise can appear on one or all ECG traces. The source of the 
noise is derived from the local AC power frequency, 60Hz or 50Hz. The power line frequency noise 
can be measured by turning up the display speed and measuring the period of corresponding sine 
wave (1000ms/60 = 16.7ms for 60Hz or 1000ms/50 = 20ms for 50Hz). The notch filter is designed 
to filter this noise out.

Example of power line 60Hz noise on an ECG trace:

Typically, Power Line Frequency noise is the result of a difference in ECG lead wire impedance 
(poor connection with the patient).

Possible contributing factors of Power Line Frequency noise include:

 Bad lead wires

 Bad patient cables

 Poor electrode connection with the patient

Recommended corrective actions include:

 Replace bad or worn out lead wires

 Replace bad or worn out patient cables

 Ensure electrodes have been placed in the correct location where the skin was properly 
prepared. Typically, this noise source improves with no intervention after 10 minutes of contact 
with the patient.
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Baseline Drift Noise - ECG

The Baseline Drift noise appears as if the entire ECG trace is moving vertically. The frequency of 
this noise is a variable. The ECG trace can move with some physical movement in the lab. 

Example of Baseline Drift noise:

The Baseline Drift noise is often the result of differences in ECG lead wire impedance (poor 
connection with the patient) inducing noise from some physical movement near the patient.

Possible contributing factors of Baseline Drift noise include:

 Bad lead wires

 Bad patient cables

 Poor electrode connection with the patient

 Electrode location susceptible to respiration movement

 Patient movement

 Patient drape movement

 Patient table not grounded properly

Recommended corrective actions include:

 Replace bad or worn out lead wires

 Replace bad or worn out patient cables

 Ensure electrodes have been placed in the correct location where the skin was properly 
prepared. Typically, this noise source improves with no intervention after 10 minutes of contact 
with the patient.

 Limit patient movement

 Ground the patient table with a common ground shared with the TRAM-RAC or PDM Base 
Station.

Muscle Artifact Noise - ECG

The Muscle Artifact noise is a variable noise riding on a trace or multiple traces. This noise can be 
traced to movement of the patient such as shivering or snoring. The Muscle Artifact noise is often 
the result of a difference in ECG lead wire impedance (poor connection with the patient).

Example of Muscle Artifact noise:
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Possible contributing factors of Muscle Artifact noise include:

 Bad lead wires

 Bad patient cables

 Poor electrode connection with the patient

 Electrode location 

 Patient movement caused by patient being cold, reaction to medications, or snoring

Recommended corrective actions include:

 Replace bad or worn out lead wires

 Replace bad or worn out patient cables

 Ensure electrodes have been placed in the correct location where the skin was properly 
prepared. Typically, this noise source improves with no intervention after 10 minutes of contact 
with the patient.

 Limit patient movement

Missing or Noisy Cath Amplifier Inputs

TRAM/PDM

 Ensure the desired waveform traces are turned on.

 Ensure BP waveforms are zeroed.

 Verify the pressure gain (right-click on label and select Scale).

 Click the Offset icon in the Real-Time window to offset the signal.

 Verify sensor pads are applied to properly prepared skin. Reapply or replace if necessary.

 If the problem persists, contact your GE Service Representative.

 GE offers optional ECG patient cables with electrosurgical noise filtering, which reduces the 
level of interference on ECG traces.

TRAM

 Ensure all power LEDs are on (for the TRAM-RAC and the TRAM module). Check power 
cords.

 If the power lights are on, ensure the TRAM-RAC cable is properly connected (refer to TRAM/
Amplifier Connections on page 2-56) and all connections are undamaged and tight.

 The TRAM module should be in the top position.

PDM

 Ensure all power LEDs are on (for the PDM and PDM Base Station). Check power cords.

 If the power lights are on, ensure the PDM Base Station cable is properly connected (refer to 
PDM/Amplifier Connections on page 2-57) and all connections are undamaged and tight.
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Software

CardioImage

Normal Operation and Setup

1. Connect the video output from the lab’s image source to the input of the Image Capture board 
(Odyssey or Helios board) on the Acquisition system. The BNC connectors on the cable 
attached to the Odyssey or Helios board are color-coded to indicate the channels: Red = 1, 
Blue = 2. If more than two video outputs are present, use the second (right) connector on the 
Odyssey or Helios board with the following color-coding: Red = 3, Blue = 4.

2. Double-click Mac-Lab/CardioLab on the desktop.

3. Start a test study.

4. Open the Image 1 window on the Review monitor by selecting the Windows menu and 
Image 1.

5. Select an area on the Review window to open the window.

6. Click the Toolkit on the Image window to open the Imaging Configuration screen.

7. For the selected channel, pick the correct video format (DCF) file that matches the input video 
source used.

For NTSC composite video, select RS170.DCF.

8. Click Freeze in the Image 1 window.

9. Ensure that an output is present from the lab’s image system.

Do this for all of the image inputs that are connected.

10. Verify that a single image is grabbed and displayed in the Image window.

11. Open an Image window on the Image monitor (third monitor).

12. Acquire a live image by clicking Live.

13. Ensure that a live image is displayed in the CardioImage window.

NOTE: This should be done for all of the image inputs that are connected.

14. If the image does not appear, or is not centered in the window, try to select a different video 
format (DCF) file.

Unable to Capture Image

The image grabber window is blank or displays an error (no video found).

1. Check the cables:

 Red and blue cables are input 1 and input 2 (respectively).

 Left DVI port on the Image Capture board is channels 1 and 2, right DVI port is channels 3 
and 4.
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2. Navigate to D:\GEMMS\Prucka\Utilities and run the ImgTest.exe program to verify that the 
board and the driver are installed correctly:

NOTE: This procedure requires an external composite video source, such as a DVD player, to be 
connected to the first input of the Odyssey board.

 Verify that the ImgTest program starts without errors.

 Select the Helios or Odyssey board from the drop-down list.

 Select RS170.DCF from the DCF drop-down list. If a different video source (not standard 
composite video) is used, select a DCF that matches the video source.

 Click the Live icon in the toolbar to start a live image capture.

 Verify that a live image is displayed.

 Click the Stop icon to stop the capture.

 Exit the test utility.

CAUTION: LOSS OF FUNCTION

Do not edit or change the original dcf files. They may be needed in the future. 
Always create a copy of the original dcf file to work on.

3. Contact technical support if an X-Ray image is not properly displayed using any of the 
supplied .dcf files.

 Provide all image source specifications (resolution size, video timing, frequency and so 
on). Contact the X-Ray OEM if necessary.

 Technical support may be able to create a custom dcf file based on the specifications.

Image Distorted

Use this procedure when able to capture images using one of the provided DCF files but the image 
is distorted or partially cut off.

1. Ensure to log on to Windows as mlcltechuser.

2. Attempt to capture using all provided DCF files. Identify the DCF file that gives the best image.

3. Select Start> Programs > Matrox Imaging> Tools> Intellicam.

4. Select the Options menu and choose System Selection. Choose Odyssey or Helios device 
and make it active.

5. Select the Open menu and browse to D:\GEMMS\Prucka\System\Image\Dcf.

6. Choose the DCF file that gave the best image.

7. Save the DCF file as a different name to prevent the original file from being modified.

8. Select the Digitizer menu and select Continuous Grab.

An image should appear at this time. If an image does not appear, check connections and 
make sure the imaging system is sending out a signal.

NOTE: If Intellicam does not capture images using the dcf file, use the imgTest utility (refer to 
Unable to Capture Image on page 4-30) or the CardioLab application to test the file.
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9. Click the Pixel Clock tab in the configuration box.

 If the image is a vertically elongated, increase the pixel clock value. This will make the 
image wider and shorter.

 If the image is a horizontally elongated, decrease the pixel clock. This makes the image 
taller and narrower. 

10. Click the Video Timing tab of the Configuration window.

NOTE: As settings are changed and images modified, it may be necessary to close the grab 
window from time to time and open a new one for the changes to take effect. Most 
changes will take effect in real-time during the grab.

It may also be necessary to turn off the pixel clock Auto-adjust to ensure the pixel clock 
setting is not lost.

 To decrease the amount of blank space to the left of the image, click the lock active and 
total box in the horizontal section.

 To move the image to the left, increase the back porch value.

 To move it to the right, decrease it.

With the lock active and total box checked, the software automatically computes the front 
porch value.

 To decrease the amount of blank space above the image, click the Lock Active and Total 
box in the vertical section.

 To move the image up, increase the back porch value.

With the lock active and total box checked, the software automatically calculates the back 
porch value.

11. Save changes made to the camera format once the image is set up correctly.

12. Return to the Mac-Lab/CardioLab software and start a study. Open the Study Configuration 
window and select the Imaging tab. In the camera type field for image input 1, select the.DCF 
file created in Intellicam utility. 

13. Test the camera format by acquiring an image. If the image is not acceptable, go back to 
Intellicam and adjust the image. 

NOTE: The brightness and contrast of the image can be adjusted by changing the controls in the 
image window.

14. If it is not possible to correct the image using manual adjustments, contact the vendor of the 
imaging system. The following details will be needed so the information can be directly 
entered in Intellicam to create a new DCF file:

 Whether video is interlaced or non-interlaced

 Pixel clock (dot clock) in MHz

 Horizontal frequency (line rate) in kHz

 Vertical frequency (frame rate) in Hz

 Image width (both active and total) in pixels

 Image height (both active and total) in lines 

 Horizontal sync, front porch and back porch duration, in pixels or microseconds

 Vertical sync, front porch and back porch duration, in lines or microseconds
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Image Buttons Grayed Out

The Live and Freeze buttons on the Image window toolbar are grayed out.

1. Check the Software options installed on the system. The CardioImage option should be 
enabled for Live capture support. The Image capture option must be enabled for single-image 
capture (Freeze).

2. Run the imgTest.exe program to verify that the imaging board and image driver is installed 
correctly. Refer to troubleshooting section Unable to Capture Image on page 4-30.

Windows XP/2008 (and Subsections)

Normal Operation and Setup

Windows XP/2008 are extremely stable (if the system files were deleted, the operating system 
puts them back, entire CD is built into the drive at C:\windows\i386).

 Three tools to use on 2008 are (refer to Installation manual):

 Active Directory users and computers

 Active Directory domains and trusts

 DNS configuration

 OEM images randomly generate the computer name based on CLWS or CLSV and 5 digits – 
if a duplicate name on the network is found, there is a utility built in to change the name 
automatically (C:\windows\special\rename.ps1). If the computer or server needs to be 
renamed, please contact a GE Service Representative for assistance.

 Files may be dragged to the CD to write to re-writable media.

Database

Back Up CLAB and CLINK Databases

A utility to create a back up of CLAB and CLINK (if exists) databases is available on all systems. 
This utility can be used to back up CLAB and CLINK (if exists) databases on the system.

To execute the utility:

1. Log onto the system as mlcltechuser (domain for networked environment/local for 
standalone environment).

2. Browse to the folder D:\GEMMS\PRUCKA\DATABASE\MAINTENANCE and double-click the 
batch file gems_clab_clink_backup.bat.

NOTE: Execution of this utility will overwrite the existing backup in 
D:\GEMMS\PRUCKA\DATABASE\MAINTENANCE\BACKUP folder

3. Acknowledge the message on the screen and press any key to continue.

Execution of the backup will display messages on the screen.

If the CLINK database exists on the system, a prompt asking for acknowledgement of the 
backup continuation will open. Press any key to continue.
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If the CLINK database does not exist on the system, the messages Clink database doesn't 
exist and Backup process finished will open.

4. Press any key to close the open command prompt.

NOTE: Execution messages will be logged in folder 
D:\GEMMS\PRUCKA\DATABASE\MAINTENANCE\LOG in Gems_Backup.log, 
Gems_clab_backup.log and Gems_clink_backup.log

Check the State of the CLAB and Master Databases

This utility can be used to check the overall state of CLAB and Master databases on Acquisition 
systems and the INW server.

To execute the utility:

1. Log on to the system as mlcltechuser (domain for networked environment/local for 
standalone environment).

2. Browse to the D:\GEMMS\PRUCKA\DATABASE\MAINTENANCE folder and double-click the 
batch file database_check.bat.

3. Press any key to close the open command prompt.

NOTE: Execution messages will be logged in 
D:\GEMMS\Prucka\database\maintenance\log\database_summary.log

On the server, orphan study folders will be deleted when Database_Check.bat is executed, the 
details of the deleted orphan study folders will be logged in 
D:\GEMMS\PRUCKA\DATABASE\MAINTENANCE\LOG\DELETEORPHANSTUDIES_<DATETI
MESTAMP>.LOG

On all systems (Server/Acquisition/GE Review/Software Only) the Clabuser and Scriptuser 
permissions will be reset on all tables and stored procedures in the CLAB Database if the 
permissions are found to be missing or changed while running the database check utility.

GEMS Task Monitor Service

NOTE: To start or stop the service, select Control Panel > Administrative Tools > Services > 
GEMS Task Monitor.

GEMS Task Monitor service monitors configured services. Based on configuration, this service 
could be used to start or stop any windows services.

On the Centricity Cardiology INW server, GEMS Task Monitor will be configured to monitor the 
CentralList Service. CentralList service will be used for communicating with CVIS server.

The GEMS Task Monitor service must be stopped for:

 CentralList Service configuration or maintenance: GEMS Task Monitor service will try to start 
CentralList Service at every 15 minutes. The CentralList Service may be started while 
configuring the GEMS Task Monitor service if GEMS Task Monitor service did not stop before 
configuration.

 If the Centricity Cardiology INW server is not configured to communicate with CVIS: The 
monitoring service as CentralList Service won't be running on Centricity Cardiology INW 
server. In this case stop and disable the GEMS Task Monitor. Be sure to start GEMS Task 
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Monitor service when configuring the Centricity Cardiology INW server to communicate with 
CVIS.

Networking

General Issues

Error: CardioLink Server Unavailable

 Evidence of a CardioLink Server Unavailable error is contained in the Application Event Log. 
These errors are not always consistent. The most common error is the following.

 Verify that under System Settings, the network storage is checked and that the correct path is 
being used (for example, \\clsvXXXX\pruckastudies\).

 Verify that the primary DNS server is the INW server.

 Ping the INW server by name (this will determine if it is a DNS/WINS resolution).

 If able to ping by IP but not by name, then it is a WINS resolution problem.

Error: Net Message Sender

 If a network system has an Acquisition system and a Nurse’s Workstation both joined in a case 
and the case logs do not sync up, verify that netmsgsender.exe is running as a process on 
the acquisition system.

 If it is not, go to Administrative Tools and start netmsgsender manually.
2063076-010H EN Mac-Lab/CardioLab/Centricity Cardiology INW Service Manual 4-35



Troubleshooting
 Reboot the system and verify the process started after the reboot.

Normal Operation and Setup

It is very important to understand the facilities IP Addressing scheme before equipment setup. If 
any IP setting is typed incorrectly, the system may not be able to communicate on the network.

IP Address

 Ping 127.0.0.1 to ensure the TCP/IP is installed properly.

 Ping the IP of the Local Computer to ensure the IP was entered correctly.

 If applicable, ping the IP Address of the Default Gateway. If this ping fails there will be no 
communication with other devices on the network.

 If applicable, ping the IP Address of a device located beyond the Default Gateway. This will 
ensure the Default Gateway is properly routing packets outside of the current network 
segment.

 Attempt to ping a remote device by name. If the system can ping by IP, but not by name, there 
is probably an issue with the DNS configuration.

Slow Transfer/Ping Speed

 If the system is experiencing slow transfer speeds ensure the NIC is communicating at 100mb/
s at Full Duplex. If the link is not 100mb/s then there may be a conflict between the NIC 
adapter and the network switch.

 To ensure transfer speeds of 100mb/s Full Duplex, the NIC and the Switch port must BOTH be 
configured for either: Auto Negotiate or forced 100/Full Duplex.

DNS: Client Side

 If unable to ping a system by name it may be the local DNS cache is out of date. To resolve 
this open a command prompt and type the following:

 Ipconfig /flushdns and press Enter

 neststat -r and press Enter

 If the problem persists after flushing the local DNS records the problem my reside on the 
server side.

DNS: Server Side

 Correct DNS Entry:

1. Launch Administrative Tools > DNS

2. Navigate to [Server Name] > Forward Lookup Zone > [Domain Name]

3. Ensure all records in the DNS table are accurate. If there is an IP / Name mismatch, the 
record can be updated by double-clicking it.
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 Clearing DNS Cache

1. Launch Administrative Tools > DNS.

2. Right-click the server name and select Clear the DNS Cache.

3. If the problem persists after flushing the local DNS records the problem my reside on the 
server side. Try a lengthy ping test to determine if packets are being dropped.

Stockert and SmartAblate Ablation Devices

General Issue

When using the Stockert ablation device interface to the CardioLab system, ablation event 
recording might continue for several seconds after turning off the RF power on the ablation device.

If this happens, events in the event log and plot windows record and display longer than the time of 
the actual RF power delivery. This functionality is intended and provides a way to record ablation 
information such as temperature after the ablation administration. 

For certain Stockert ablation devices, this recording behavior can be changed to eliminate the 
additional time and terminate CardioLab ablation recording at the end of RF power delivery. 

Change Ablation Recording Behavior of the Stockert Device Interface

Changing ablation event recording behavior is only supported for the following device and 
software:

 Stockert software version 1.037

 SmartAblate software version 1.2

NOTE: Refer to the device vendor documentation for instructions on retrieving the software 
version number. 

1. Verify that the Stockert in use supports changing the recording behavior.

2. Ensure CardioLab is closed.

3. Navigate to Start > Programs > Accessories and click Notepad. 

4. In Notepad, select File > Open and navigate to D:\gemms\prucka\bin\ablation. 

5. Double-click stockert.xml.

6. Find the line that contains the text <parm name="UseRFFlag" v="False" ....>.

a. To eliminate additional recording time, change False to True.

b. To restore default recording behavior, change True to False.

7. Save the file and exit Notepad.

8. Launch CardioLab and select the Stockert ablation device.

9. Click Apply.
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Centricity Cardiology INW Server

Operation and Setup

Refer to the Centricity Cardiology INW Operator’s Manual (PN 2063076-003 non-US or PN 
2063076-303 US-only) for additional Troubleshooting information specific to INW servers.

Study Puller

Study Stuck on the Acquisition System

If a study continues to be listed on the System catalog of an Acquisition and is failing to be pulled 
to the INW server highlight the study and select Continue. Close the study. The next time the 
NetStudyPuller runs, it will pull the study to the INW server.

Pull All Studies to the Server Immediately

This process should be used if an Acquisition system needs to be pulled out of replication and 
there are studies present on the system that have yet to be pulled to the INW server.

1. On the INW server, using Windows Explorer, browse to D:\GEMMS\Prucka\Utilities.

2. Double-click PullStudies.bat file.

NOTE: Once the batch file is run, a PullStudiesInProgress file will appear in the 
D:\GEMMS\Prucka\Utilities directory. When the studies are all pulled, a PullStudiesDone 
file will appear. There is a PullStudies.log file in the directory that will have additional 
information about the Study Puller.
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CVIS and DICOM Interfaces

Normal Operation and Setup

NOTE: For Acquisition and Review systems, the Local System and Remote Hosts sections 
must be completed to perform a patient search and a schedule search.

The previous screen shows the Local System configuration settings with some sample settings. 
Enter each field as described in the following:

DICOM Settings: These settings are for this Mac-Lab/CardioLab system. The following must be 
filled in this section.

 AE Title: The DICOM name for the Mac-Lab/CardioLab system. An AE Title typically only 
contains letters, numbers and the underscore character and must be 16 characters or less. 

NOTE: AE Titles are case sensitive, for example, Lab1 is not the same as LAB1. 

 Listen Port: Port number on which Mac-Lab/CardioLab listens for connections from the X-ray 
and U/S systems. Use the default of 1225.

Maximum search responses to accept: Defines the maximum number of DICOM search results 
displayed. Use the default value of 150.

Lock required patient demographics fields from Modality Worklist host: Leave checked to 
prevent the operator from changing Patient Name, MRN and Date of Birth when these values are 
provided by the CVIS.

Enable detailed logging of DICOM communications: If there are problems with connectivity, 
turn this feature on to troubleshoot the system. When finished troubleshooting, turn off this feature. 
These log files can be found in D:\GEMMS\Prucka\Logs\DICOM.

Include DOB in DICOM viewer patient context check: This is used to include the DOB 
parameter when searching for patient data with the DICOM viewer.
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INNOVA CENTRAL/Touch Screen: If this option was purchased, check the box to enable this 
feature.

The previous screen shows the Remote Hosts DICOM configuration settings with some sample 
settings. Enter each field as described in the following:

X-Ray System Settings: Fill in this section only if the X-ray system DICOM interface will be used. 
The typical X-ray systems are the GE Innova or the DLX.

 Automatic Start Exam: Check this box only if the X-ray system supports the Automatic Exam 
Start feature. When enabled, for each New Study or Continue Study, a notification is sent to 
the X-ray system to start an exam using the same patient demographics as the current study.

NOTE: Unless your X-ray system supports the Automatic Exam Start feature, leave this box 
unchecked.

 AE Title: The DICOM name for the X-ray system. This is found in the X-ray system’s 
configuration settings. (The default names are “dlx_root” for the DLX or “TERRA” for the 
Innova, but these values are typically changed).

 Hostname or IP Address: X-ray system hostname or IP address. (Obtain this from the 
hospital administrator).

 Port Number: Port number on which the X-ray system listens for connections from the Mac-
Lab/CardioLab. 

 Modality: Imaging system’s modality. This should be left at the default of XA.

 Text Encoding: How text sent to the X-ray system is encoded. This should be left at the 
default of Latin-1.

Ultrasound System Settings: Fill in this section if connecting to an ultrasound device such as a 
Vivid system.

 AE Title: DICOM name for the Ultrasound system. Check Ultrasound system configuration to 
verify the name.

 Hostname or IP Address: Ultrasound system hostname or IP address.

 Port Number: Port number on which the ultrasound system listens for connections from the 
Mac-Lab/CardioLab.

 Modality: Ultrasound system’s modality. This should be left at the default of US.
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 Text Encoding: How text sent to the Ultrasound system is encoded. This should be left at the 
default of Latin-1.

Modality Worklist Host: CVIS settings. This section must be filled in.

 AE Title: DICOM name for the CVIS. Default is MWL_MPPS_SCP. Check CVIS configuration 
to verify the name.

 Hostname or IP Address: CVIS hostname or IP address.

 Port Number: Port number on which CVIS listens for connections from the Mac-Lab/
CardioLab. Default values are:

 Domestic CVIS is 1225.

 Non-Domestic CVIS is 104. 

Check the CVIS configuration to verify the value.

 Text Encoding: How text sent to the CVIS is encoded. Leave at default of Latin-1 (exception: 
CVIS in China and Japan should be Unicode (UTF-8)).

MPPS Host: CVIS settings. This section must be filled in. Use exactly the same values used to fill 
in the Modality Worklist Host section.

Test DICOM Connectivity (CVIS)

Steps 1 and 2 are only valid for US (English Canada) CVIS.

1. Open the Study > Patient Search at the Navigator. 

2. Enter a Patient Last Name of Smith (or other common name) and press Start Search. One 
of the following outcomes will occur:

 One or more patient records are returned and shown in the list. (If too many matches are 
found the list will be truncated.) The DICOM configuration settings are correct.

 An error message is displayed indicating no matching patients were found. The DICOM 
configuration settings may be correct, but another name should be tried.

 Some other error message is displayed:

 The DICOM configuration settings are incorrect.

 The CVIS system configuration settings are incorrect.

 The CVIS system is not actively listening for connections. 

Begin troubleshooting with the next step.

3. These substeps are valid for both US and Non-US (English Canada) CVIS.

a. Log on as MLCLTechUser (to OS).

b. Open command prompt.

c. Type dicomdiag and press Enter. The diagnostic tool will attempt to connect to all 
configured remote DICOM hosts. Failures and recommended solutions will be reported.

d. The diagnostic tool will indicate what to do next.
2063076-010H EN Mac-Lab/CardioLab/Centricity Cardiology INW Service Manual 4-41



Troubleshooting
4. Check the DICOM server settings on the CVIS systems. Log in to the CVIS system using 
MuseAdmin (Contact GE Healthcare Technical Support or the system administrator for 
current password information). MuseAdmin is only valid for US (English Canada) CVIS.

a. Open the Interface Management Console tool (if it is not already running, look for it on 
the system tray). 

b. Select the DICOM MWL SCP on the left side (it may be called something else). 

c. Verify the DICOM server is running (it is shown on the right side). If it is not, click the + 
button on the toolbar.

d. Verify the AE Title and Network Port values match the Mac-Lab/CardioLab configuration.

e. Verify the CVIS application is running. If it is not, open the Centricity Cardiology DMS 
application on the desktop. 

f. Go to Administrative > System Management > DICOM Maintenance. 

g. Check the Location drop-down just above the DICOM Network group box. The Mac-Lab/
CardioLab system should have the same AE Title configured earlier in CVIS 
(MLCL_LAB1 in the previous example). 

h. If it does not, either modify the AE Title back in CVIS or click the Add Net Device button 
and enter the following information:

 AE Alias column: Enter a user-friendly name for the system (for example, Lab #1 or 
Mac-Lab 3). 

 AE Title column: Enter the AE Title of Mac-Lab/CardioLab system. 

 Modality column: Check the appropriate checkboxes: HD for Mac-Lab, EPS for 
CardioLab systems, or both for ComboLab systems.

i. Repeat the patient search. If all settings are correct, it should return a valid result.

NOTE: By default, only errors from the DICOM interface are logged. To see additional DICOM 
activity, including incoming and outgoing DICOM messages, select Administration > 
System Settings > Connectivity and check the Enable detailed logging of DICOM 
communications option. Incoming and outgoing DICOM messages are logged to 
D:\GEMMS\Prucka\Logs\DICOM. When troubleshooting has been completed, uncheck 
this option.

HL7 Export to CVIS

1. Perform a check on the Mac-Lab/CardioLab logs to verify successful HL7 export. Open 
Windows Explorer and navigate to D:\GEMMS\Prucka\ExportData and review the audit.log 
for any errors regarding the HL7 export.

2. Check the CVIS Interface Console audit logs to see if the HL7 message was received.

3. Check the CVIS archive logs to see if the HL7 message was processed.
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Export System Lists Utility

The Export System Lists utility is available in the event that Mac-Lab/CardioLab lists need to be 
exported into a form that can be imported into a CVIS system. This need may exist when a CVIS 
system is being added to an existing Mac-Lab/CardioLab installation.

Export System Lists Utility Functionality

Lists exported from Mac-Lab/CardioLab using this utility, can be imported into a CVIS system 
where Mac-Lab/CardioLab list items are associated to CVIS list items.

The Export System Lists utility is an independent utility and available only on a Standalone\ 
Network Acquisition system. The utility is located at 
D:\GEMMS\Prucka\Database\export_system_lists_for_cvis.bat

There are eight lists available to migrate. The following Mac-Lab/CardioLab Master list items are 
migrated:

 Complications (itemCompl.txt)

 Contrasts (ItemContrast.txt)

 Medications (ItemMedic.txt)

 Procedures (ItemProc.txt)

 Folders (Folder.txt)

 Barcodes (BarCodeList.txt)

 Inventory (ItemSupply.txt)

 Staff (StaffImport.txt)

The Export System Lists utility generates those text files in the 
D:\GEMMS\Prucka\Database\System_Lists_for_CVIS folder. If the System_Lists_for_CVIS 
folder does not exist in the specified location, the utility will create the folder. The system lists are 
exported to a comma delimited text file with Column Headers in the first row and the data is 
qualified with double quotes (“).

Export System Lists Utility Usage

To export system lists from a Mac-lab/CardioLab system, perform the following steps:

1. Log on to the system as mlcltechuser or Administrator.

2. Navigate to D:\GEMMS\Prucka\Database.

3. Double-click the export_system_lists_for_cvis.bat file. A command window opens. 

4. Press any key to continue and wait for the operation to complete.

5. Ensure that GEMS_SUCCESS message is displayed in the Command window.

In case of failure, refer to the log file Export_System_Lists_For_CVIS_<TimeStamp>.log or 
contact the System Administrator.

Exported systems lists are created in the D:\GEMMS\Prucka\Database\System_Lists_for_CVIS 
folder.
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To import the system lists into US (or English Canada) CVIS, refer to the US (or English Canada) 
CVIS System Management Manual (Centricity Cardiology Data Management System, System 
Management Manual).

To import the system lists into Non-US (or English Canada) CVIS, refer to the Non-US (or English 
Canada) CVIS Documentation.

General Issues

Supplies Added to CVIS System Do Not Show Up on Mac-Lab

 INW service that processes lists not configured or started 

 CVIS List Sharing Delta export not configured for the given location

 Corrupt XML export from the CVIS system

 CVIS List Sharing services on CVIS server not started

 Replication errors/issues with INW Server and Mac-Labs

 Network connection between CVIS and INW server lost (INW service can't find files even 
though they're getting created appropriately)

Cases Performed on Mac-Lab Do Not Show Up in CVIS System

 Interfaces on CVIS server not running or configured improperly

 Data Export Utility on Mac-Lab not configured correctly

 Data Export not turned on Mac-Lab in Sys Admin File Path setup

 Network connection between Mac-Lab and CVIS Server not up

Patients Scheduled on CVIS Do Not Show Up on Schedule Search

 DICOM settings not configured correctly on Mac-Lab

 DICOM services not running on CVIS Server

 Network connection lost between Mac-Lab and CVIS

Patient Admitted Do Not Show Up on Patient Search

 DICOM settings on Mac-Lab not configured correctly

 Network connection lost between Mac-Lab and CVIS

 Patient Interface service not running

 HIS feed to ADT Interface is down on CVIS

Test DICOM Connectivity (X-Ray or Ultrasound)

Mac-Lab/CardioLab: After setting or changing the configuration of the “Local System” Settings 
tab, the “X-ray System Settings” or the “Ultrasound System Settings” section within the Mac-Lab/
CardioLab application, either reboot the Acquisition system or manually restart the service called 
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“MWL MPPS Service”. Note that you must be logged in as MLCLTechUser to manually start this 
service. MLCLLogonUser does not have the privilege to do this.

X-ray: The X-ray system must be configured to use the Mac-Lab/CardioLab Acquisition system as 
its destination for both MWL and MPPS transactions. The X-ray system must not get this 
information from the CVIS system.

Ultrasound: The Ultrasound system must be configured to use the Mac-Lab/CardioLab 
Acquisition system as its destination for the Worklist source for the CardioLab dataflow. The 
Ultrasound system must not get this information from the CVIS system.

NOTE: To test with the Innova or Vivid, use the dicomdiag tool, as described in the previous 
section.

1. On the X-ray or Ultrasound system, use the DICOM Echo interface or a similar connectivity 
test, to verify that the connection with the Mac-Lab/CardioLab system can be established. If 
that works, the Mac-Lab/CardioLab system is configured correctly and is listening for and 
responding to requests.

2. In order to use the MWL interface on the X-ray or Ultrasound system to request patient and 
study data from the Mac-Lab/CardioLab system, follow these steps:

a. Start a new study on the Mac-Lab/CardioLab system. (If a new study is not started, the 
MWL request from the X-ray or Ultrasound system will fail because there is no patient and 
study data to report).

b. Make the MWL request from the X-ray or Ultrasound system. Key patient attributes such 
as Name, MRN, Date of Birth, Height and Weight should transfer from the Mac-Lab/
CardioLab and should be displayed on the X-ray or Ultrasound system.

3. If this doesn’t work, make sure the MWL MPPS Service is running on the Mac-Lab/CardioLab 
system. 

4. Check the error log and look for errors reported by the DICOM layer. 

5. Recheck the configuration on both systems (the values should match exactly):

 Mac-Lab/CardioLab: Local AE Title and Listen Port, the X-ray system’s AE Title and 
Modality. 

 X-ray System: AE Title values, MWL/MPPS destination Hostname/IP Address, Port 
Number. 

 Ultrasound System: AE Title value; Worklist destination AE Title, Hostname/IP 
Address and Port Number.

INNOVA CENTRAL/Touch Screen

Check Connection Status

1. Open the Mac-Lab/CardioLab application.

2. Select Administration > System Settings.

3. Select the Connectivity screen.

4. Check the Connection Status in the Touchscreen section. 
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 Connected is displayed if the INNOVA CENTRAL/Touch screen is connected.

If the connection status is disabled, ensure the INNOVA CENTRAL/Touch screen enable 
check box is checked. If the check box is grayed out, the software option is disabled. Any 
changes to items on this dialog require an application restart to update.

 Listening on port nnn (where nnn is the port setting) is displayed if the INNOVA 
CENTRAL/Touch screen is not connected.

If the INNOVA CENTRAL/Touch screen is connected and this message is displayed, 
ensure the port listed is 889. This is the INNOVA CENTRAL/Touch screen connection 
port.

CARTO XP/CARTO 3 System

NOTE: Error messages on the CARTO System itself (such as a magnet positioning error) are the 
responsibility of the manufacturer — either refer to the documentation or call CARTO 
System technical support.

Normal Operation and Setup

The CARTO System has five states:

 Gray and unclickable: Software option must be enabled.

 Gray and clickable: Disconnected--No physical connection between the CARTO System and 
Mac-Lab/CardioLab systems.

 Blue: Connected. If the icon does not turn blue automatically, check the connections.

 Green: Passive interface. Must be activated from the Acquisition.

 Yellow: Active interface. Must be activated from the CARTO System. Refer to OEM 
documentation for specific information. 

In active mode, a point selected on the Acquisition system is also selected on the CARTO System 
(however, a point selected at the Review system is not selected at the CARTO System). 

One CARTO System study may only be synched to one Mac-Lab/CardioLab study (a 1 to 1 
relationship). The same two studies may be independently stopped and restarted, but a new 
CARTO System study can not be added to an existing Mac-Lab/CardioLab study.

Netmsgsender is used to communicate between Acquisition and Review systems. Check the 
connection between Acquisition and Review systems before targeting problem as CARTO System 
issues (for example, log entries not being added).

A quick-connect cable is required to show ECG information.

CARTO System files are always less than 1MB.

CARTO System Button Inactive

Verify normal operation.

 Ensure the CARTO System interface is enabled on the Mac-Lab/CardioLab system.

 The interface is only available in the CardioLab application (ensure not in Mac-Lab 
application).
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 The interface is only accessible from the Real-Time window.

 The CARTO System must be version 7.0 or greater to be able to use this interface.

 Patient demographics may be edited on the CARTO System.

 CARTO System does not support import of foreign language demographics from Mac-Lab/
CardioLab system (ENGLISH ONLY). Foreign languages are displayed as unrecognizable 
characters.

CARTO System Connection Failure

 Check cabling. 

 The CARTO System option requires a crossover cable connected from the acquisition system 
computer to the CARTO System computer. Ensure cable and connectors are good.

 Verify the Ethernet lights are on.

CARTO IP Address Conflict

 Use ping to test communication between the two systems.

 The CARTO System interface uses hardcoded IP address on our system.

 The IP of the CARTO System is 192.168.5.1

 The IP of the Mac-Lab/CardioLab CARTO System adapter is 192.168.5.2

Cannot Print to CARTO Printer from Acquisition System

This functionality is not supported. The Mac-Lab/CardioLab and CARTO System are completely 
independent and only send messages for points and waveform data.

Mapping Points are Unsynchronized or Missing

At the Acquisition system double-click points to see the data.

 Regular CARTO System mapping points are not editable on Mac-Lab/CardioLab system.

 Resynch at the CARTO System.

 Check the CARTO System point filter on the log. Missing points may be filtered out.

 Points missing from a report may have been manually deselected (the default is to include all 
points in a report).

 During normal operation waveform point synchronization may be off by up to ± 50ms. 

 If it is off by more than ± 50ms, select a different channel (the channel registered is the 
channel measured in CardioLab).
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Network Irregularity Error with CARTO System

Error “Network Irregularity: The network messaging component could not be detected running on 
the system. This will effect the performance of the Mac-Lab/CardioLab network environment.” 
appears when the CARTO connection is lost.

A lost connection can be the result of powering off the CARTO, physically unplugging the CARTO 
to move to another lab, or a problem with the network connection between the CardioLab and the 
CARTO.

1. Logon to the Mac-Lab/CardioLab Custom Shell as local mlcltechuser.

2. Select Start > Run. The Run window will appear.

3. Enter ncpa.cpl and click OK. The Network Connections window appears.

4. Select Advanced > Advanced Settings and click the Adapters and Bindings tab.

5. In the Connections list, verify the first four items that must be in the following order:

 Loopback Connection

 Local Area Connection

 CARTO Connection

 TRAMNET Connection

6. If the first four items are not in the proper order, select entries in the Connections list and click 
the up or down buttons to move entries higher or lower until the first four items are in the 
proper order. Ignore any entries that follow these four items.

7. Click OK.

8. Log off and allow the system to automatically log on as MLCLLogonUser.

With this change, the CARTO may be disconnected or powered off during a CardioLab case as 
needed.

Signal Noise

The following steps should be tried when troubleshooting noise associated with connectivity of the 
CARTO system. Each of these steps have proven to reduce or eliminate noise.

NOTE: If the 10 ft 2015944-001 ECG cable is used, the total ECG signal path will be lengthened 
significantly and in some clinical settings increased noise may appear on the ECG 
readout.

1. For CARTO XP, make sure Revision 10 or newer of the CARTO PIU is being used. Earlier 
revisions of the PIU can make the overall system more susceptible to ECG noise. Revision 10 
introduced an improved grounding scheme.

2. For CARTO XP, if not using the CARTO IC cable (that is, currently providing IC signals to the 
CARTO PIU by connecting the CARTO IC input leads to the CardioLab CIM terminals), try 
routing all catheter leads to the CARTO PIU IC inputs, then connect the CardioLab to the 
CARTO PIU using the blue CARTO-to-CardioLab cable (PN 2015944-001). This is the 
recommended system configuration.
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3. For CARTO XP, in some clinical settings, the use of the ECG cable that connects the CARTO 
PIU and the CardioLab II Plus Amplifier (PN 2015944-001) can be a source of noise. In this 
case, noise may be reduced by removing this cable and instead connecting the CardioLab to 
the ECG terminals on the top of the CARTO PIU via the ECG cable assembly (PN 2003419-
001) along with the ECG lead set (PN 2003421-001). This is a cleaner alternative to “double 
patching” the patient (10 electrodes for the CardioLab, 10 electrodes for the CARTO).

4. If noise is present during ablation, try using the RF Filter Box (PN 2082432-001).

Data Import Does Not Work for Non-English Systems

 This is expected behavior. Patient demographics are shared only between English CardioLab 
systems and CARTO Systems.

 For non-English CardioLab systems, the demographic data must be entered manually.

EP Recording is Disabled on the CARTO System

This issue may be seen on the CARTO System while trying to configure the EP Recording 
Preferences. The Tools > EP Recording menu item may be disabled.

A lost connection can be the result of powering off the CARTO, physically unplugging the CARTO 
to move to another lab, or a problem with the network connection between the CardioLab and the 
CARTO.

1. Log on to Windows and the Mac-Lab/CardioLab Custom Shell as local mlcltechuser for 
standalone systems and domain mlcltechuser for networked systems.

2. Select Start > Settings > Control Panel > Network Connections. The Network 
Connections window appears.

3.  Right-click on CARTO Connection and select Status.

4.  Check that the Status is Connected. If the status is not connected, follow the instructions in 
CARTO System Connection Failure on page 4-47.

Send Movies Option Disabled in EP Recording Preferences on the CARTO 
System

This issue may be seen on the CARTO System while trying to configure the EP Recording 
Preferences for Sending CARTO Movies. The Send Movie Option may be grayed.

This issue can occur when the Shared folder created on the CardioLab system is not accessible 
on the CARTO System.

1. Log on to Windows and the Mac-Lab/CardioLab Custom Shell as local mlcltechuser for 
standalone systems and domain mlcltechuser for networked systems.

2. Select Start > Settings > Control Panel > Network Connections. The Network 
Connections window appears.

3. Right-click on CARTO Connection and select Properties.
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4. Ensure that the File and Printer Sharing for Microsoft Networks setting has been enabled 
in the CARTO Connection Properties.

Vivid System

Error Messages

Error messages on the Vivid System itself should be referred to the Vivid User Guide for the 
current version of the Vivid.

EtCO2

Capnostat Sensor Check

The sensor cable has two cells, as shown in the figure below. One is marked -0- (zero) and one is 
marked REF (reference). Whenever incorrect values or sensor failure are suspected, perform a 
sensor check.

Follow these steps to perform a sensor check:

1. Remove the adaptor from the sensor, but be certain that the sensor cable is still connected to 
the module.

2. Ensure that the cell windows are clean and dry.

3. Place the sensor on the cell marked REF. 

Depending on the units of measure, you should see a reading of 38 mmHg (± 2) on the 
display. If the displayed value is within range, you can resume recording. 

If the sensor is not within range, the error message Not Calibrated is displayed. The sensor 
must be calibrated to the zero cell.

Item Description

1 Capnostat Sensor Cable to Module

2 -0- Cell

3 REF Cell

4 Capnostat Sensor Module

1

2
3

4

4-50 Mac-Lab/CardioLab/Centricity Cardiology INW Service Manual 2063076-010H EN 



Troubleshooting
General Error Messages

Following is a list of error messages that may be displayed in the End Tidal CO2 window when 
recording CO2. The error message should clear when normal operating criteria are met or a 
solution is found. If a message persists, call GE Healthcare for service at 1-800-437-1171 option 4 
(U.S. only). Outside the United States, please contact your sales/service office.

NOTE: The actual message that appears on the monitor depends on the module used and the 
installed software version.

Message Cause Solution

Pump is blocked. 
Please check.

Nasal cannula, moisture filter, sidestream 
adaptor tube or exhaust line is blocked.

Check nasal cannula, moisture filter, sidestream adaptor tube 
and exhaust lines for blockage and replace if necessary. If the 
blocked line condition persists for a period of time, the module’s 
pump will automatically shut off. The pump must then be 
restarted to clear the message. To restart the pump, clear or 
replace any blocked lines and, for Dual CO2 modules, select the 

Start/Stop EtCO2 Pump icon; for Mainstream CO2 modules, 

reinsert the sample line into the CapnoFlex LF module. Repeat 
this process until the Pump is Blocked. Please Check. message 
clears.

Sensor cable is 
disconnected. 
Please check.

Sensor cable is not connected to module. Check sensor cable connection.

Please calibrate the 
sensor on the zero 
cell.

A new sensor was introduced into the system 
or there is a possible signal drift in sensor 
electronics.

Zero the CO2 sensor. 

Cannot be 
calibrated.

Calibration cannot be performed during warm 
up or while there is an error.

Wait for the module to warm up or clear the error condition before 
calibrating.

Please check/
calibrate adaptor

 Adaptor is not attached to sensor

 Adaptor is obstructed

 Adaptor used is of a different type than 
the one last calibrated to the sensor

 Ensure the sensor is securely snapped onto the adaptor.

 Check for possible obstructions in the adaptor and clean if 
required. 

 Recalibrate the adaptor. 

Please Check 
Sample Line

 Sample line is disconnected

  Sample line used is of a different type 
than the type used when adaptor was 
last calibrated.

 Be sure the sample line is securely connected. 

 Recalibrate the adaptor using the new type of sample line.

Incompatible Sensor Capnostat sensor is of older type and not 
supported by module software.

Use only a Capnostat 3 sensor.

Calibration Error 
Sensor

Sensor signal is out of tolerance. Calibrate the sensor. 

Not calibrated Sensor signal is out of tolerance. Calibrate the sensor. 

Service CO2 module 

CPU

Module failure. Contact GE Healthcare or contact your sales/ service 
representative for service.

Service CO2 module 

RAM

Module failure. Contact GE Healthcare or contact your sales/ service 
representative for service.
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Centricity Cardiology CA 1000

Error messages on the CA 1000 software itself should be referred to the Centricity Cardiology CA 
1000 V2.0 Installation Guide.

Remote Connectivity - InSite

Normal Operation

Once the agents are configured and started after initial setup, any configuration problems will 
cause the agents to attempt to connect three times at two minute intervals before shutting down.

Once the agents are successfully configured and started:

 If the system is restarted, the agents attempt to start three times and then shut down until 
manually restarted.

 In the event of a failure (that is, the network or enterprise is server down), the service agent 
polls every 10 minutes until it can connect.

Start/Stop InSite Service

This section describes how to start or stop the InSite service.

1. Log on to Windows and the Mac-Lab/CardioLab Custom Shell as local mlcltechuser for 
standalone systems and domain mlcltechuser for networked systems.

Service CO2 module 

ROM

Module failure. Contact GE Healthcare or contact your sales/ service 
representative for service.

Service CO2 module 

2nd CPU

Module failure. Contact GE Healthcare or contact your sales/ service 
representative for service.

Service CO2 module 

Sensor Temperature

Module failure. Contact GE Healthcare or contact your sales/ service 
representative for service.

CO 2 module is 

warming up...

Occurs when:

 The Sensor is first plugged in

 A module is placed in a TRAM-RAC 4A

 When a sensor is first powered on.

Message clears automatically. If it lasts more than 4 minutes, call 
GE Healthcare service or contact your sales/service 
representative.

Calibrating... Module is calibrating. Message clears automatically. If the message is displayed 
continuously, call GE Healthcare service or contact your sales/
service representative.

Calibration Error The module cannot be calibrated. Call GE Healthcare service or contact your sales/service 
representative.

Please calibrate 
cannula

The adaptor is not calibrated. Calibrate the adaptor. 

Unknown Error Module failure due to unknown cause. Call GE Healthcare service or contact your sales/service 
representative.

Message Cause Solution
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2. On the Desktop, double-click Service Console.

3. In the left pane of the Service Console window, expand InSite 2.0 folder then select the 
Configuration Utility folder.

4. Select the Service Controller tab.

5. Click Start Service. The InSite service will start.

NOTE: The Start Service button will be disabled if the service is already started.

6. Click Stop Service. The InSite service will stop.

NOTE: The Stop Service button will be disabled if the service is already stopped.

7. Click Start Service once more to restart the Insite Service if it was running prior to this 
procedure.

8. Log off as mlcltechuser and allow the system to auto logon.

FastPoll - Initiate Remote Service

This section describes how to use the Initiate Remote Service capability of InSite. The Initiate 
Remote Service feature will enable the InSite request processing to take place in 20-second 
intervals for the next 15 minutes.

NOTE: The Initiate Remote Service icon can be accessed by any user.

To access the Initiate Remote Service, on the Desktop, double-click the Initiate Remote Service 
shortcut icon.

Proactive Error Monitoring

The Mac-Lab/CardioLab system provides proactive error monitoring via InSite ExC. When an error 
condition occurs, an alert event is triggered to the InSite Back Office indicating the Device ID, 
Serial Number and error code that was encountered. The alert data is reviewed on a periodic basis 
and actions taken accordingly ranging from connecting to the device remotely to correct the error 
or dispatching and FE for on-site service.

Acquisition System and Review Workstation Alerts

The following is a list of error codes that are monitored on the Acquisition system and Review 
Workstation and if found generate an alert notification via InSite ExC. More details regarding these 
events can be found in the Windows Application event log.

GEMS-EVENTLOG_GEMS_MLCL_APPLICATION_ERROR

 Timed Out while waiting for network thread

 GetFileAttributes failed for path

 The exception EXCEPTION_ACCESS_VIOLATION was generated by the application

 Exit Code indicates failure for path

 Unable to create the patient directory

 Failed to copy file from

 Failed to update client status

 .rdb was denied
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EventCreate-EVENTLOG_GEMS_MLCL_DATABASE_ERROR

 Errors in Integrity check for master database

 Errors in Integrity check for clab database

 Errors in Integrity check for studycat database

 Maximum number of client connections reached

 truncating rdc file to

GEMS-EVENTLOG_GEMS_MLCL_SERVICE_ERROR

 CentralListService.exe failed to start

 Failed to create CentralListImport object

 Central List Service not starting

 The service cannot be started, either because it is disabled

 CNetMsgWatchdogHandler:WatchdogExpireCallback()

GEMS_EVENTLOG_GEMS_MLCL_OS_ERROR

 Dummy - Un-supported OS

GEMS_EVENTLOG_GEMS_MLCL_DISK_ERROR

 disk space left in the network storage path

 Insufficient disk space in directory

 Failed to allocate memory for image buffer

 Failed to allocate image buffer

 Memory allocation for the key BLOB failed with error code
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List of SNMP Faults

The following is a list of SNMP faults that are monitored on the INW Server. If the fault is detected, 
an alert notification is generated via InSite.

1. SNMP_EVENT_LOG_FOUNDATION_AGENTS_267 

2. SNMP_EVENT_LOG_FOUNDATION_AGENTS_399 

3. SNMP_EVENT_LOG_FOUNDATION_AGENTS_1174 

4. SNMP_EVENT_LOG_FOUNDATION_AGENTS_1176 

5. SNMP_EVENT_LOG_FOUNDATION_AGENTS_1178 

6. SNMP_EVENT_LOG_FOUNDATION_AGENTS_1180 

7. SNMP_EVENT_LOG_NIC_AGENTS_258 

8. SNMP_EVENT_LOG_NIC_AGENTS_259 

9. SNMP_EVENT_LOG_NIC_AGENTS_260 

10. SNMP_EVENT_LOG_NIC_AGENTS_269 

11. SNMP_EVENT_LOG_NIC_AGENTS_296 

12. SNMP_EVENT_LOG_STORAGE_AGENTS_399 

13. SNMP_EVENT_LOG_STORAGE_AGENTS_1061 

14. SNMP_EVENT_LOG_STORAGE_AGENTS_1062 

15. SNMP_EVENT_LOG_STORAGE_AGENTS_1064 

16. SNMP_EVENT_LOG_STORAGE_AGENTS_1067 

17. SNMP_EVENT_LOG_STORAGE_AGENTS_1068 

18. SNMP_EVENT_LOG_STORAGE_AGENTS_1070 

19. SNMP_EVENT_LOG_STORAGE_AGENTS_1075 

20. SNMP_EVENT_LOG_STORAGE_AGENTS_1076 

21. SNMP_EVENT_LOG_STORAGE_AGENTS_1077 

22. SNMP_EVENT_LOG_STORAGE_AGENTS_1152 

23. SNMP_EVENT_LOG_STORAGE_AGENTS_1153 

24. SNMP_EVENT_LOG_SERVER_AGENTS_399 

25. SNMP_EVENT_LOG_SERVER_AGENTS_1024 

26. SNMP_EVENT_LOG_SERVER_AGENTS_1082 

27. SNMP_EVENT_LOG_SERVER_AGENTS_1085 

28. SNMP_EVENT_LOG_SERVER_AGENTS_1088 

29. SNMP_EVENT_LOG_SERVER_AGENTS_1123 

30. SNMP_EVENT_LOG_SERVER_AGENTS_1137 
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31. SNMP_EVENT_LOG_SERVER_AGENTS_1138 

32. SNMP_EVENT_LOG_SERVER_AGENTS_1139 

Log Files

Log Collector Utility

Overview

The Log Collector icon is available on the desktop and the Start menu of Acquisition systems, 
Review Workstations and Centricity Cardiology INW Servers. The purpose of the Log Collector 
Utility is to collect any event logs, Mac-Lab/CardioLab logs and crash dump files that exist on the 
system when Log Collector is run.

The files are compressed and placed in the D:\GEMMS\Prucka\Remote Service\Insite 
2.0\FileWatcher directory to be collected by the InSite ExC Back Office Server. The collected 
compressed file name format is <SystemSerialNumber_DateTimeStamp>.xip.

Files Collected

Windows Application Log

Windows Security Log

Windows System Log

Dump files (less than 4 MB in size)

C:\*.log

D:\GEMMS\Prucka\Bin\*.log

D:\GEMMS\Prucka\Bin\Log\*.log

D:\GEMMS\Prucka\Setup\*.log

D:\GEMMS\Prucka\Execution\Log\*.log

D:\GEMMS\Prucka\Logs\*.*

D:\GEMMS\Prucka\Log\*.*

D:\GEMMS\Prucka\Logs\DICOM\*.*

D:\GEMMS\Prucka\Database\Maintenance\Log\*.log

D:\GEMMS\Prucka\ExportData\Audit.log

D:\GEData\Logs (*.log files within this directory and all of its subdirectories)

D:\GEMMS\Prucka\Bin\ArchiveUtility\Log\*.log

C:\Program Files\Microsoft SQL Server\MSSQL\LOG\*.*

C:\Program Files\Microsoft SQL Server\100\Setup Bootstrap\LOG\*.*
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Using the Log Collector Icon

1. Launch the Log Collector Utility either by double-clicking on the GEHC Log Collector icon 
on the desktop or by selecting it from the Windows Start menu.

2. If logged on as a non-administrator Widows account user, you will be prompted for 
authentication.

3. If prompted, enter the local MLCLTechuser password and click OK.

NOTE: When the logs have been collected a success message will open.

Event Viewer

The Event Viewer maintains logs about program, security and system events on the computer. 
The Event Viewer can be used to view and manage the event logs, gather information about 
hardware and software problems and monitor Windows security events.

1. To open the Event Viewer, on the Desktop, right-click My Computer and select Manage. The 
Computer Management window appears.

2. Click the Event Viewer to expand the menu to see the following items: Application, Security 
and System.

 Application Log - The application log contains events logged by applications or programs. 
For example, a database program might record a file error in the application log.

 Security Log - The security log records events such as valid and invalid logon attempts, as 
well as events related to resource use such as creating, opening, or deleting files or other 
objects. For example, if logon auditing is enabled, attempts to log on to the system are 
recorded in the security log.

 System Log - The system log contains events logged by Windows XP system 
components. For example, the failure of a driver or other system component to load during 
startup is recorded in the system log.

3. All logons are logged to the Security section, you will need administrator rights in order to view 
the security logs. The Mac-Lab/CardioLab system handles its own errors.

4. Select View > Customize. The Customize View window appears.

5. Select or clear the check boxes to show or hide items in the console window. Click OK.

You also have to have administrator rights in order to save log files.

6. Right-click Computer Management (in the directory tree) and then select Connect to 
another computer in the drop-down menu to connect to another computer.

Application Logs

Information, Warning and Error messages are logged during different states of Mac-Lab/
CardioLab (Acquisition and Review) and INW server systems. These messages can be used for 
checking: the state of the system, success of a command, or for debugging.

In addition, the Mac-Lab/CardioLab application writes messages to the file 
D:\GEData\Logs\NTEventLog.log. This log file contains the same messages that are found in the 
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Windows Event Log. Events in NTEventLog.log are listed in order with the newest events at the 
end of the file. This log file contains only Mac-Lab/CardioLab events, which means that it does not 
contain messages from other Windows components. This can be beneficial, as NTEventLog.log 
may have older information than what is available in the Windows Event Viewer, because the 
Windows Event Viewer discards the oldest events as it fills up. The NTEventLog.log automatically 
creates a new file when it fills up, but the previous log file is preserved in the same location with a 
similar name.

NOTE: Some events, such as from the Mac-Lab/CardioLab database components, are logged 
only to the Windows Event Log and will not be found in the NTEventLog.log.

Device Log Files

These are errors that are created from devices that are hooked up to the Mac-Lab/CardioLab 
system.

Detailed Application Logs for Troubleshooting

Some components of the Mac-Lab/CardioLab system provide a mechanism to log detailed 
messages about their operation. This detailed logging is off by default, as it is to be used for 
troubleshooting purposes only. The components of the Mac-Lab/CardioLab system that can 
provide this detailed logging are as follows:

 Ablation device interface

 Image capture and display

File Name Origin or Location Usage Description
Server/

Workstation

Application Events D:\GEData\Logs\NTEventLog.log Logs most of the application events that also appear in the 
Windows Event Log

Both

DICOM log files D:\GEMMS\Prucka\Logs\DICOM Logs the status/details about the DICOM interface. These 
logs are created only if the option is checked in the 
Connectivity section of System Settings.

Workstation

Data Export Audit 
Log Files

D:\GEMMS\Prucka\Exportdata Logs the status/details about the Data Export operation. Workstation

Crash Dump Files D:\GEMMS\Prucka\Remote 
Service\Insite 2.0\File 
Transfer\Outgoing

Logs the crash dump when there is an application crash. Workstation

SQL Server log files C:\Program Files\Microsoft SQL 
Server\MSSQL\log

Logs the status/details about the operation of the SQL 
server.

Both

File Name Origin or Location Usage Description
Server/

Workstation

TramNetErr.log D:\GEMMS\Prucka\Bin\P
EITramNet.dll

Logs the connection status and failures on the TRAMNet Driver. Workstation

DashErr.log D:\GEMMS\Prucka\Bin\P
EIDash.dll

Logs the device status and errors occurred on the DASH/Solar. Workstation
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 Real-time signal display

 Study Management (for example copy, move, import/restore, delete) 

For each of these components, failures are recorded in the Windows Event Log and the log file 
D:\GEData\Logs\NTEventLog.log. If a particular problem is observed in one of these areas and 
the normal messages are insufficient to diagnose the failure, it may be helpful to gather more 
detailed logs of what is happening. This is done by first enabling detailed logging and then trying to 
reproduce the failure condition, typically after normal hours when the procedure room is available 
for this purpose.

Enable Detailed Logging - Acquisition System or Review Workstation

1. Close the Mac-Lab/CardioLab application.

2. Using Windows Explorer, browse to D:\GEMMS\Prucka\Setup.

3. Right-click the ExampleTraceLog.config file and select Copy in the pop-up menu.

4. Right-click within the right side of the Windows Explorer window (but not on one of the files or 
subdirectories) and select Paste in the pop-up menu.

5. Rename the copied file (typically Copy of ExampleTraceLog.config) to TraceLog.config.

6. Close Windows Explorer.

7. Start the Mac-Lab/CardioLab application.

Enable Detailed Logging - INW Server

1. Using Windows Explorer, browse to D:\GEMMS\Prucka\Setup.

2. Right-click the ExampleTraceLog.config file and select Copy in the pop-up menu.

3. Right-click within the right side of the Windows Explorer window (but not on one of the files or 
subdirectories) and select Paste in the pop-up menu.

4. Rename the copied file (typically ExampleTraceLog - Copy.config) to 
NetMsgSenderLog.config.

5. Close Windows Explorer.

6. In the Services list, select NetMsgSender services and select Restart.

7. In the Services list, select NetStudyPuller services and select Restart.

When detailed logging is enabled, the following additional files are available:

File Name Origin or Location Usage Description
Server/

Workstation

abl_drv.log
abl_ui.log

D:\GEData\Logs Logs status/details from the ablation drivers and the ablation user interface Workstation

img.log D:\GEData\Logs Logs status/details for image capture and display Workstation

RealTime.log D:\GEData\Logs Logs status/details for real-time signal display Workstation
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Once troubleshooting is complete, detailed logging should be disabled as follows:

Disable Detailed Logging - Acquisition System or Review Workstation

1. Close the Mac-Lab/CardioLab application.

2. Using Windows Explorer, browse to D:\GEMMS\Prucka\Setup.

3. Delete the TraceLog.config file.

4. Close Windows Explorer.

5. Start the Mac-Lab/CardioLab application.

Disable Detailed Logging - INW Server

1. Using Windows Explorer, browse to D:\GEMMS\Prucka\Setup.

2. Delete the NetMsgSenderLog.config file.

3. Close Windows Explorer.

4. In the Services list, select NetMsgSender services and select Restart.

5. In the Services list, select NetStudyPuller services and select Restart.

Install/Update Logs

Messages are written to Windows Event Log during installation or upgrade of Mac-Lab/CardioLab 
software. These event logs can be accessed through the Event Viewer and appear in the 
Application Event Log with the source GEMS and the category Setup.

Maintenance Log Files

Text log files are created during the maintenance operations performed on the Mac-Lab/CardioLab 
systems. These maintenance activities include Database Maintenance, Backup, Archive, Running 
Scheduled Jobs and so on. These log files contain information regarding the actions performed 
during maintenance, result (success/failure) of the maintenance and error information (if any). 
These files are created in the folder D:\GEMMS\Prucka\Database\Maintenance\Log and include 
the following:

 GEMS_backup_clabdb.log

 GEMS_backup_masterdb.log

 GEMS_DBMAINT_PROCS.log

 GEMS_db_maint_reindexdb_clab.log

StudyManager.log D:\GEData\Logs Logs status/details for study management (for example, copy, move, import/
restore, or delete)

Both

TraceLog.log D:\GEData\Logs Logs trace messages across multiple components Both

File Name Origin or Location Usage Description
Server/

Workstation
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Troubleshooting
 GEMS_db_maint_recompile_clab.log

 GEMS_db_maint_checks_master.log

 scheduled_jobs_on_’ + @subscriber + ‘.log

 Gems_backupclab.log

 Gems_restoreclab.log

 Listjobs.log

 GEMMS_tmparchive.log

 GEMMS_tmppurge.log

 sp_attach_cb.log

Details of purpose and information contained in these files can be found in the following table.

Corrupted or Missing Operator’s Manual Files

To repair corrupted or missing Operator’s manual files, run the UserManualUpdate.wsf from the 
root of the DVD ML-CL APPLICATION INSTALL 6.9.5 (PN 2062800-001 non-US or PN 2062800-
101 US-only). A message stating User manuals updated will open when the manuals are 
repaired.

If a Windows repair message opens automatically, then complete the steps in the Mac-Lab/
CardioLab/Centricity Cardiology Disaster Recovery Service Manual (PN 2063076-015) to reimage 
the system.

Log File Locations for Mac-Lab/CardioLab System

The following log files may exist on Acquisition systems, Review Workstations and Centricity 
Cardiology INW servers:

File Name Origin Usage Description
Server/

Workstation

Database 
Maintenance.log

GEMS_SQLJOBS.bat Logs the status and details about the database maintenance 
operation.

Server

GEMS_sqljobs. 
log

GEMS_SQLJOBS.bat Logs the status and details about SQL Jobs during the database 
maintenance operation.

Server

GEMS_db_maint
_backup.log

GEMS_WS_DBMAINT.bat Logs the status/details about backup operation performed during the 
database maintenance.

Workstation

GEMS_db 
_maint_ 
REINDEX.log

GEMS_WS_DBMAINT.bat Logs the status/details about re-index operation performed during the 
database maintenance.

Workstation

GEMS_db_maint
_checks.log

GEMS_WS_DBMAINT.bat Logs the status/details about maintenance checks operation 
performed during the database maintenance.

Workstation

GEMS_db_maint
_updatestats.log

GEMS_WS_DBMAINT.bat Logs the status/details about update stats operation performed during 
the database maintenance.

Workstation

GEMS_db_maint
_recompile.log

GEMS_WS_DBMAINT.bat Logs the status/details about recompile operation performed during 
the database maintenance.

Workstation
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 D:\GEMMS\Prucka\Setup\GEMS_CLAB_INSTALL.log

 D:\GEMMS\Prucka\Setup\GEMS_DROP_DATABASE.log

 D:\GEMMS\Prucka\Database\Maintenance\Log\GEMS_DBMAINT_PROCS.log

 D:\GEMMS\Prucka\Bin\Gems_backupclab.log

 D:\GEMMS\Prucka\Bin\Gems_restoreclab.log

 D:\GEMMS\Prucka\Bin\Audit.log

 C:\DFCtest\merge.log

 C:\clabdbsizecheck.log

 D:\GEMMS\Prucka\Bin\CMD_RESULT.log

 D:\GEMMS\Prucka\setup\GEMS_Droplinkedserver.log

 D:\GEMMS\Prucka\setup\GEMS_Dropreplblaster.log

 D:\GEMMS\Prucka\setup\GEMS_Replcheck.log

 D:\GEMMS\Prucka\SETUP\GEMS_CLAB_Export.Log

 D:\GEMMS\Prucka\Setup\GEMS_CLAB_INSTALL.Log

 D:\GEMMS\Prucka\Setup\GEMS_archiveuser.log

 D:\GEMMS\Prucka\Bin\build.log

 D:\GEMMS\Prucka\Bin\DashErr.log

 D:\GEMMS\Prucka\Bin\TramErr.log

 C:\STATS.LOG

 C:\QUERY.LOG

 C:\SQL.LOG

 D:\GEMMS\Pruckaa\Bin\GEMMS_tmparchive.log

 D:\GEMMS\Prucka\Bin\GEMMS_tmppurge.log

 D:\GEMMS\Prucka\Bin\log\GEMS_db_maint_checks.log

 GEMS_db_maint_backup.log

 GEMS_db_maint_REINDEX.log

 GEMS_db_maint_updatestats.log

 D:\GEMMS\Prucka\log\GEMS_db_maint_recompile.log

 D:\GEMMS\Prucka\DICOM\merge.log

 D:\GEMMS\Prucka\Ntos\logs\GEMS_Policy.log

 D:\GEMMS\Prucka\Database\maintenance\log\Listjobs.log

 D:\Upgrade60\migrate_acq.log

 D:\Upgrade60\migrate_rev.log

 D:\Upgrade60\migrate_srv.log

 D:\GEMMS\Prucka\Database\maintenance\log\sp_attach_cb.log

 C:\windows\security\logs\resetup.log

 C:\windows\special\cardiosec.log

 D:\GEMMS\Prucka\setup\LMT_Update.log

 D:\GEMMS\Prucka\Setup\MLCL_Set_Language.log

 D:\GEMMS\Prucka\Setup\history.log

 D:\GEMMS\Prucka\Bin\GEMS_SWInstall.log

 D:\GEMMS\Prucka\Bin\GEMS_SW_D.log

 D:\GEMMS\Prucka\Setup\GEMS_clabsys.log
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 D:\GEMMS\Prucka\Setup\GEMS_clabuser.log

 D:\GEMMS\Prucka\Setup\GEMS_CmdExecNT.log

 D:\GEMMS\Prucka\Setup\GEMS_StartServices.log

 D:\GEMMS\Prucka\Setup\GEMS_CmdExecNT.log

 D:\GEMMS\Prucka\Setup\GEMS_CmdExecSQLAcq.log

 D:\GEMMS\Prucka\Setup\GEMS_CmdExecSQLRev.log

 D:\GEMMS\Prucka\Setup\GEMS_netshare.log

 D:\GEMMS\Prucka\Database\Maintenance\Log\DatabaseMaintenanace.log

 D:\GEMMS\Prucka\Database\Maintenance\Log\GEMS_sqljobs.log

 D:\GEMMS\Prucka\Database\Maintenance\Log\GEMS_backup_clabdb.log

 D:\GEMMS\Prucka\Database\Maintenance\Log\GEMS_backup_masterdb.log

 D:\GEMMS\Prucka\Database\Maintenance\Log\GEMS_db_maint_reindexdb_clab.log

 D:\GEMMS\Prucka\Database\Maintenance\Log\GEMS_db_maint_recompile_clab.log

 D:\GEMMS\Prucka\Database\Maintenance\Log\GEMS_db_maint_checks_master.log

 D:\GEMMS\Prucka\Database\Maintenance\Log\GEMS_SrvNameChanger.log

 D:\GEMMS\Prucka\Database\Maintenance\Log\GEMS_SrvNameChanger.log

 D:\GEMMS\Prucka\Database\Maintenance\Log\NameChanger.log

 D:\GEMMS\Prucka\Database\Maintenance\Log\GEMS_Acq_ReplRemove.log

 D:\GEMMS\Prucka\Database\Maintenance\Log\GEMS_ReplicationCheck.log

 D:\GEMMS\Prucka\Database\Maintenance\Log\GEMS_Server_ReplRemove.log

 D:\GEMMS\Prucka\Setup\MLCLInstallerDbg.log

 Navigate to D:\GEMMS\Prucka\ExportData

 Double-click DataExportConfig.exe.

 Check the audit.log file in the directory in the Audit Log tab.

 Domestic CVIS Only: Perform a check on the CVIS Interface Management Console to verify 
the HL7 messages were processed/ received.

 Navigate to Administrative > System Management > Audit Logs.

 Then select the respective tab page to find the log files.
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Chapter 5

Replacement Procedures
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Replacement Procedures
Overview

This chapter describes a Field Replaceable Unit (FRU), who is qualified to repair systems and 
their components, special tools and procedures to replace specific FRU’s. Not all FRU’s require a 
replacement procedure.
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Field Replaceable Units (FRU’s)

The general repair philosophy regarding Field Replaceable Units (FRU’s) for both hardware and 
software is to repair at a unit level. The product range has been structured to conform to standard 
FRU policies and to utilize as many common parts as possible.

Each applicable FRU assembly, sub-assembly, or component to be replaced will be identified. A 
replacement procedure will be developed and incorporated as each procedure is completed and 
then approved.

Qualified Personnel

Only GE Healthcare trained personnel should perform replacement procedures.

Special Tools

Only special tools required to perform a replacement procedure will be identified.

Damaged in Transit

Before the replacement procedure starts, inspect parts for damage during transit. If part(s) are 
damaged, order replacement part and return damaged part according to applicable procedures.

General Replacement Process

Lock Out / Tag Out (LOTO)

WARNING: SHOCK HAZARD

To reduce the risk of shock and equipment damage, use safe working practices 
when servicing electrical equipment.

Electrostatic Discharge (ESD)

Electrostatic discharge (ESD) can damage electronic components. Ensure you are properly 
grounded before opening any equipment.
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Replacement Procedures
Matrox M9140 Quad Video Board

Overview

The Matrox M9140 Quad Video Board (PN 2049434-001) is used in the HP z600 Acquisition 
systems. This board, located in slot 2, provides one connector with a proprietary connector cable. 

The proprietary connector cable, with four DVI/VGA output connectors, is shipped with the board 
and is used for video out on Monitor 1, Monitor 2 and Monitor 3. Currently, the fourth connector is 
not used.

Additional Replacement Parts

The Matrox M9140 Quad Video Board is shipped in a box with additional parts. The parts within 
the box include the following:

Shut Down the System

WARNING: SHOCK HAZARD

To reduce the risk of shock and equipment damage, use safe working practices 
when servicing electrical equipment.

1. Close all open windows.

1

2

3

4

5

6

Item Part Number Description Quantity

1 2049434-001 Board, Matrox Quad 1

2 N/A Cable, Proprietary 1

3 N/A Adapter, VGA to DVI 4
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2. Select Start > Shutdown.

3. Click Shutdown.

4. Power off the computer and all peripheral devices.

5. Disconnect the AC main power cords from the computer and from all peripheral devices.
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Remove and Install the Board

WARNING: SHOCK HAZARD

To reduce the risk of shock and equipment damage, use safe working practices 
when servicing electrical equipment.

1. Lift up on the tab near the top of the side panel.

2. Swing out the side panel and remove from the computer.

3. Disconnect three video cables (including adaptors) from the proprietary connector cable on 
the board.

4. Disconnect proprietary cable from the board.

5. Place computer on side (open side up).

6. Remove the metal cable retention bracket from the Matrox Quad video board.

7. On the back of the computer, press two green tabs and swing retainer away from the board 
end plates.

1
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Replacement Procedures
8. Carefully hold the board release tab toward the top of the computer and gently pull the board 
from the computer.

9. Slide the new board into the computer making sure it properly seats into the motherboard.

10. Follow the instructions included with the Matrox Quad Graphics card for securing the bracket 
to the card. After the bracket is installed, test to ensure the mating quad video cable can plug 
into the graphics card without any interference from the bracket. 

11. Using the two green tabs, swing the retainer toward the board end plates. Make sure the 
retainer is properly secured when the tabs “click” into their locked position.

12. Connect the new proprietary connector cable to the board.

13. Re-connect three video cables (including adaptors) to the proprietary connector cable on the 
board.

 Video 1 cable to connector labeled 1/5

 Video 2 cable to connector labeled 2/6

 Video 3 cable to connector labeled 4/8

 Connector labeled 3/7 not used

14. Re-install the side panel onto the computer.
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Replacement Procedures
Power On the System

WARNING: SHOCK HAZARD

To reduce the risk of shock and equipment damage, use safe working practices 
when servicing electrical equipment.

1. Connect the AC main power cords to the computer and all peripheral devices.

2. Power on all peripheral devices.

3. Power on the Acquisition computer.

Verify Board Functionality

1. Allow the system to auto-log to Windows as local MLCLLogonuser.

2. On the Windows screen, right-click and select Launch Matrox Power Disk.

3. Select Multi-Display Setting.

4. Under favorites, select Identify, Display and Outputs.

5. Verify that video 1,2 and 4 parameters are properly setup for monitors 1, 2 and 3.

 If properly setup, click OK.

 If not properly setup, refer to the Mac-Lab/CardioLab/Centricity Cardiology INW New 
Installation Instructions (PN 2063076-008).
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Matrox Helios Video Board - Optional

Overview

The Matrox Helios Video Board (PN 2052113-001) is used in the HP z600 CardioICE and 
CardioImage Acquisition systems only. This optional board, located in slot 3, provides two DVI 
connectors for capturing X-ray or other imaging systems.

Additional Replacement Parts

The Matrox Helios Video Board is shipped in a box with additional parts. The parts within the box 
include the following:

1

2

3

4

5

6

Item Part Number Description Quantity

1 2048060-001 Cable, DVI male to 5 BNC female 2

2 2004311-001 Cable, BNC to BNC, Coax, 50 ft 4
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Shut Down the System

WARNING: SHOCK HAZARD

To reduce the risk of shock and equipment damage, use safe working practices 
when servicing electrical equipment.

1. Close all open windows.

2. Select Start > Shutdown.

3. Click Shutdown.

4. Power off the computer and all peripheral devices.

5. Disconnect the AC main power cords from the Acquisition system and from all peripheral 
devices.

Remove and Install the Board

WARNING: SHOCK HAZARD

To reduce the risk of shock and equipment damage, use safe working practices 
when servicing electrical equipment.

1. Lift up on the tab near the top of the side panel.

2. Swing out the side panel and remove from the computer.

3. Disconnect the DVI connector for each image adapter cable from the board.

4. Place computer on side (open side up).
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5. On the back of the computer, press two green tabs and swing retainer away from the board 
end plates.

6. Gently pull the board from the computer.

7. Slide the new board into the computer making sure it properly seats into the motherboard.

8. Re-connect the DVI connector for each image adapter cable to the board.

NOTE: Typically with IMAGE INA connector, red cable with BNC captures X-ray and blue cable 
with BNC captures another imaging system. With IMAGE INB connector, red cable with 
BNC and blue cable with BNC captures additional imaging systems.

9. Using the two green tabs, swing the retainer toward the board end plates. Make sure the 
retainer is properly secured when the tabs “click” into their locked position.

10. Re-install the side panel onto the computer.

Power On the System

WARNING: SHOCK HAZARD

To reduce the risk of shock and equipment damage, use safe working practices 
when servicing electrical equipment.

1. Connect the AC main power cords to the computer and all peripheral devices.

2. Power on all peripheral devices.

3. Power on the Acquisition system.

1
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Initialize Board and Driver

If the board and driver are not properly initialized, the Cannot create odyssey.ini in 
OdysseyiniSet() error message will appear during each boot. This message will not appear after 
the board and driver have been initialized.

NOTE: SECURITY BREACH

Never leave a system logged in as mlcltechuser. When done, always log out and leave 
the system at the custom shell.

NOTE: To go to the Windows logon screen, press Ctrl +Action +Del and then hold down the 
Shift key during the Windows boot process.

1. Ensure to be logged on to Windows as local mlcltechuser.

2. A Warning! Returning to previous version of software will require a manual restoration 
of firmware for this acquisition module. message may appear. If the message appears, 
click Yes.

NOTE: Click No and the current software will not work.

3. If the firmware is upgraded, a prompt to shut down the system will appear. Shut down the 
system and log on as local mlcltechuser. 

4. Launch the OdcCfg program by selecting Start > Programs > Matrox Odyssey 
NativeLibrary > OdcCfg.

5. Verify that the OdcCfg tool displays and that there are no errors reported.

6. Close the OdcCfg tool without making any changes.

Verify Board Functionality

Capture X-ray (and each applicable modality) and view image in the Image Window. Refer to Mac-
Lab/SpecialsLab Operator’s manual (PN 2063076-001 non-US or PN 2063076-301 US-only) or 
CardioLab Operator’s Manual (PN 2063076-002 non-US or PN 2063076-302 US-only).
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Matrox Solios Video Board - Optional

Overview

The Matrox Solios eA Board (PN 2031725-001) is used in the HP z600 computer. This optional 
board, located in slot 4 of the HP z600, provides two DVI connectors (only one is used) for video 
in from Vivid (Ultrasound).

Additional Replacement Parts

A DVI male to 15-pin female adaptor (2030703-001) is required to interface the Vivid cable to the 
Matrox Solios eA Board. The adaptor is not shipped with the board and should be ordered 
separately.

Shut Down the System

WARNING: SHOCK HAZARD

To reduce the risk of shock and equipment damage, use safe working practices 
when servicing electrical equipment.

1. Close all open windows.

2. Select Start > Shutdown.

3. Click Shutdown.

4. Power off the computer and all peripheral devices.

5. Disconnect the AC main power cords from the computer and from all peripheral devices.

1

2

3

4

5

6
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Remove and Install the Board

WARNING: SHOCK HAZARD

To reduce the risk of shock and equipment damage, use safe working practices 
when servicing electrical equipment.

1. Lift up on the tab near the top of the side panel.

2. Swing out the side panel and remove from the computer.

3. Disconnect the DVI adaptor and VGA cable connected to the Vivid from the board.

4. Place computer on side (open side up).

5. On the back of the computer, press two green tabs and swing retainer away from the board 
end plates.

6. Gently pull the board from the computer.

7. Slide the new board into the computer making sure it properly seats into the motherboard.

1
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8. Using the two green tabs, swing the retainer toward the board end plates. Make sure the 
retainer is properly secured when the tabs “click” into their locked position.

9. Re-connect the DVI adaptor and VGA cable connected to the Vivid to the board.

10. Re-install the side panel onto the computer.

Power On the System

WARNING: SHOCK HAZARD

To reduce the risk of shock and equipment damage, use safe working practices 
when servicing electrical equipment.

1. Connect the AC main power cords to the computer and all peripheral devices.

2. Power on all peripheral devices.

3. Power on the Acquisition computer.

Verify Board Functionality

Capture an image from the Vivid and view image in the Cardio ICE window on Monitor 3. Refer to 
Mac-Lab/SpecialsLab Operator’s manual (PN 2063076-001 non-US or PN 2063076-301 US-only) 
or CardioLab Operator’s Manual (PN 2063076-002 non-US or PN 2063076-302 US-only).
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Replacement Procedures
Matrox Odyssey eA Board - Optional

Overview

The Matrox Odyssey eA Board (PN 2049435-001) is used in the HP z600 Acquisition system only. 
This board, located in slot 4, provides two DVI connectors for capturing X-ray or other imaging 
systems.

Additional Replacement Parts

The Matrox Odyssey eA Video Board is shipped in its own box. However, there is a Mac-Lab/
CardioLab Imaging Cabling Accessories Kit (PN 2017899-002 (RoHS) or 2017899-001 (non-
RoHS)) available that contains cables applicable to the board. The parts shipped within the kit 
include the following:

Shut Down the System

WARNING: SHOCK HAZARD

To reduce the risk of shock and equipment damage, use safe working practices 
when servicing electrical equipment.

1. Close all open windows.

2. Select Start > Shutdown.

3. Click Shutdown.

4. Power off the computer and all peripheral devices.

5. Disconnect the AC main power cords from the computer and from all peripheral devices.

1 

2 

3 

4 

5 

6 

Item Part Number
Non-RoHS Part 

Number
Description Quantity

1 2018060-002 2018060-001 Cable, DVI male to 5 BNC female 2

2 2004311-001 Cable, BNC to BNC, Coax, 50 ft 4
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Remove and Install the Board

WARNING: SHOCK HAZARD

To reduce the risk of shock and equipment damage, use safe working practices 
when servicing electrical equipment.

1. Lift up on the tab near the top of the side panel.

2. Swing out the side panel and remove from the computer.

NOTE: There can be one or two adapter cables, each contains a DVI connector (connects to the 
board) and five leads with BNC connectors (only red and blue are used to capture image 
systems).

3. Disconnect DVI connector of each image adaptor cable from the board.

4. Place computer on side (open side up).
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Replacement Procedures
5. Squeeze in two tabs, gently push in, then pull and lift off the clamp.

6. Gently pull the board from the computer.

7. Slide the new board into the computer making sure it properly seats into the motherboard.

8. Re-connect the ribbon cable to the board.

9. Using the two green tabs, swing the retainer toward the board end plates. Make sure the 
retainer is properly secured when the tabs “click” into their locked position.

10. Re-connect DVI connector of each image adaptor cable to the board.

NOTE: Typically with IMAGE INA connector, red cable with BNC captures X-ray and blue cable 
with BNC captures another imaging system. With IMAGE INB connector, red cable with 
BNC and blue cable with BNC captures additional imaging systems

11. Re-install the side panel onto the computer.

Power On the System

WARNING: SHOCK HAZARD

To reduce the risk of shock and equipment damage, use safe working practices 
when servicing electrical equipment.

1. Connect the AC main power cords to the computer and all peripheral devices.

2. Power on all peripheral devices.

3. Power on the Acquisition computer.

Item Description Quantity

1 Tabs 1

2 Clamp 1

1

2

2

5-18 Mac-Lab/CardioLab/Centricity Cardiology INW Service Manual 2063076-010H EN 



Replacement Procedures
Initialize Board and Driver

If the board and driver are not properly initialized, the Cannot create odyssey.ini in 
OdysseyiniSet() error message will appear during each boot. This message will not appear after 
the board and driver have been initialized.

NOTE: SECURITY BREACH

Never leave a system logged in as mlcltechuser. When done, always log out and leave 
the system at the custom shell.

NOTE: To go to the Windows logon screen, press Ctrl +Action +Del and then hold down the 
Shift key during the Windows boot process.

1. Ensure to be logged on to Windows as local mlcltechuser.

2. A Warning! Returning to previous version of software will require a manual restoration 
of firmware for this acquisition module. message may appear. If the message appears, 
click Yes.

NOTE: Click No and the current software will not work.

3. If the firmware is upgraded, a prompt to shut down the system will appear. Shut down the 
system and log on as local mlcltechuser. 

4. Launch the OdcCfg program by selecting Start > Programs > Matrox Odyssey 
NativeLibrary > OdcCfg.

5. Verify that the OdcCfg tool displays and that there are no errors reported.

6. Close the OdcCfg tool without making any changes.

Verify Board Functionality

Capture X-ray (and each applicable modality) and view image in the Image Window. Refer to Mac-
Lab/SpecialsLab Operator’s manual (PN 2063076-001 non-US or PN 2063076-301 US-only) or 
CardioLab Operator’s Manual (PN 2063076-002 non-US or PN 2063076-302 US-only).
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SD Card Drive

Overview

The SD Card Drive (PN 2050067-001) is used in the HP z600 Acquisition system only. Do not 
install a SD Card Drive into a Review Workstation. Patient data must be reviewed from the network 
on a Review Workstation.

Parts in SD Drive Replacement Kit

The SD Card Drive is shipped within a kit (PN 2056207-002 (RoHS) or 2056207-001 (Non-RoHS)) 
without SD media that includes the following:

Shut Down the System

WARNING: SHOCK HAZARD

To reduce the risk of shock and equipment damage, use safe working practices 
when servicing electrical equipment.

1. Close all open windows.

2. Select Start > Shutdown.

3. Click Shutdown.

4. Power off the computer and all peripheral devices.

5. Disconnect the AC main power cords from the computer and from all peripheral devices.

Item Part Number
Non-RoHS Part 

Number
Description Quantity

1 2050067-001 Assembly, SD Card Drive, ML/CL 1

2 2055753-002 2055753-001 Cable, USB to 5-Pin Header, 24-inch 1
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Remove and Install the SD Card Drive

WARNING: SHOCK HAZARD

To reduce the risk of shock and equipment damage, use safe working practices 
when servicing electrical equipment.

1. Lift up on the tab near the top of the side panel.

2. Swing out the side panel and remove from the computer.

3. Place computer on side (open side up).

4. Lift up on power supply handle to release power supply from motherboard.

5. Using the power supply handle, lift power supply out from the guide rails in the Acquisition 
computer.

6. Disconnect SD card drive cable from the motherboard.

7. Lift tab and remove the old SD card drive and cable from the Acquisition computer.
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8. Connect USB connector of the new SD card drive cable to the SD drive.

9. Install an SD card in the rear slot of the drive.

10. Guide the cable and SD card drive into the bay until the drive clicks into place within the 
Acquisition computer.

CAUTION: CABLE CONNECTION 

Pin 1 (arrow on the motherboard pointing to pin 1) of SD card drive must line 
up with pin 1 on the motherboard (red wire).

Plugging the connector in backwards could result in damage to the SD card 
drive reader.

11. Connect the 5-pin connector of the new SD card drive cable to the motherboard.

12. Slide the power supply down into the guide rails within the Acquisition computer.

13. With the power supply up against the mounting posts in the guide rails, push down on power 
supply handle to engage the power supply to the connector.

14. Re-install the side panel onto the computer.

Power On the System

WARNING: SHOCK HAZARD

To reduce the risk of shock and equipment damage, use safe working practices 
when servicing electrical equipment.

1. Connect the AC main power cords to the computer and all peripheral devices.
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2. Power on all peripheral devices.

3. Power on the Acquisition computer.

Verify the SD Card Drive Functionality

1. Insert SD card in the SD card drive.

2. On the desktop, double-click My Computer.

3. Select drive E. A list of files should appear.

4. Select File > Close.
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DVD-RAM Drive

Overview

The DVD-RAM Drive is used in the older HP z600 computer. Do not install a DVD-RAM Drive into 
a Review Workstation. Patient data must be reviewed from the network on a Review Workstation.

Parts in DVD Replacement Kit

The DVD Drive is shipped within a kit that includes the following:

Shut Down the System

WARNING: SHOCK HAZARD

To reduce the risk of shock and equipment damage, use safe working practices 
when servicing electrical equipment.

1. Close all open windows.

2. Select Start > Shutdown.

3. Click Shutdown.

4. Power off the computer and all peripheral devices.

5. Disconnect the AC main power cords from the computer and from all peripheral devices.

Item Part Number Description Quantity

1 2028599-002 DVD Drive, Panasonic SW-9578 1

2 2042503-001* DVD-RAM Drive CD, Panasonic 1

* Required for xw8400 systems only.
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Remove and Install the DVD-RAM Drive

WARNING: SHOCK HAZARD

To reduce the risk of shock and equipment damage, use safe working practices 
when servicing electrical equipment.

1. Place a jumper in the “Master” position of the six pin connector on the new DVD-RAM drive.

2. Remove the side panel from the Mac-Lab/CardioLab Acquisition computer.

3. Unplug the power cable and IDE-to-SATA converter from the DVD-RAM drive.

4. Remove the screw that secures the DVD-RAM drive to the computer bay.

5. Lift tab and remove the old DVD-RAM drive from the Mac-Lab/CardioLab Acquisition 
computer.

6. Slide the new DVD-RAM drive into the open bay of the Mac-Lab/CardioLab Acquisition 
computer.

7. Re-install the screw that secures the DVD-RAM drive to the computer bay.

8. Re-install the power cable and IDE-to-SATA converter to the DVD-RAM drive.
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9. Re-install the side panel onto the Mac-Lab/CardioLab Acquisition computer.

Power On the System

WARNING: SHOCK HAZARD

To reduce the risk of shock and equipment damage, use safe working practices 
when servicing electrical equipment.

1. Connect the AC main power cords to the computer and all peripheral devices.

2. Power on all peripheral devices.

3. Power on HP Acquisition computer. If prompted during the Power-On Self-Test (POST) to 
save the configuration changes, press F1.

4. At the Mac-Lab/CardioLab Custom Shell screen, press Ctrl + Action + Del.

5. Click Logoff.

6. Click Logoff.

7. Immediately hold down the Shift key.

NOTE: SECURITY BREACH

Never leave a system logged in as mlcltechuser. When done, always log out and leave 
the system at the custom shell.

8. Log on to Windows as local mlcltechuser.

9. Log on to the Mac-Lab/CardioLab Custom Shell as local mlcltechuser.
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Verify Drive Order

1. Right-click My Computer and select Manage.

2. In the left pane, select Storage > Disk Management.

3. In the right pane, verify each drive is assigned to the correct drive letter.

 C: Primary Hard Drive

 D: Data Hard Drive

 E: SD Drive

 F: DVD-RAM Drive (if installed)

 G: Internal SD Drive

4. If a drive does not have the correct letter, perform the following steps for each drive not 
assigned the correct letter.

a. In the right pane, right-click the drive and select Change drives letter and paths.

b. Click Change.

c. Select the new drive letter in the drop-down menu and click OK.

d. Click Yes to the confirmation message.

5. Close the Computer Management window.

Verify DVD-RAM Recording Enabled

NOTE: SECURITY BREACH

Never leave a system logged in as mlcltechuser. When done, always log out and leave 
the system at the custom shell.

1. Verify that you are logged on to the Acquisition system Operating System as local 
mlcltechuser and the Mac-Lab/CardioLab custom shell as mlcltechuser.

2. Double-click My Computer.

3. Right-click the DVD drive (F:) and choose Properties.

4. Select the Recording tab.

5. Verify Enable CD recording on this drive is unchecked

6. Click OK.

7. Close the My Computer window.

Verify the DVD Drive

1. Press Ctrl + Action + Del.

2. Click Logoff.

3. Click Logoff. Allow the system to auto-log on to Windows as mlcllogonuser.
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4. Log on to the Mac-Lab/CardioLab Custom Shell as domain mlcluser.

NOTE: If error message “Unable to create local study path. Please verify that your optical disk is 
properly inserted.” appears, remove disk, shake the disk so the center hole of the inner 
media is aligned with the center of the disk and insert the disk.

5. Insert a DVD-RAM disk into the DVD drive.

6. On the desktop, double-click Mac-Lab/CardioLab.

7. In the Main menu of the Patient Navigator screen, select Administration > System 
Settings. If prompted for an administrative account, use mlcladmuser.

8. Browse to the File Paths section.

9. Verify there is a folder named F:\Studies in the Backup study path field under Local 
Storage. If there is not:

a. In the Local Storage section, click Browse.

b. Expand and select the F: drive.

c. Select the Studies folder (or create a new folder if not present).

d. Click OK.

10. Close the System Settings window.

11. In the Patient Navigator window, verify the catalog is set to System or Network.

12. Select the study to be backed up.

13. Select Study > Create Backups or click the Create Backup icon. A Please wait while study 
data is copied. message appears.

14. Click OK to close the message screen.

15. Select the Backup catalog from the catalog drop down and verify the study backed up is 
listed.

16. In the Patient Navigator window, set the catalog to System or Network or Optical, per the 
customer’s preference.

17. Close the Mac-Lab/CardioLab application.

18. Remove the DVD Driver CD and store per facility requirements.

19. Log off the system and allow the system to auto-logon the Mac-Lab/CardioLab Custom Shell 
window.
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DVD Drive

The DVD drive is used in the HP z600 Acquisition system only. To replace the DVD, refer to the 
applicable link for the HP service documentation. See OEM Component Support Locations on 
page 3-65.

Hard Drive

The hard drive is used in the HP z600 Acquisition systems. To replace the hard drive, refer to the 
applicable link for the HP service documentation. See OEM Component Support Locations on 
page 3-65.

NOTE: Patient data is contained on the hard drive. Return the hard drive to the proper facility to 
remove the patient data.

NOTE: For two hard drives failure and replacement, refer to Replace Both Hard Drives on page 
4-11.

NOTE: For a single hard drive failure and replacement, refer to Acquisition Hard Drive Failure on 
page 4-8.

Memory

The memory is used in both the HP z600 and HP xw8400 Acquisition systems. To replace the 
memory card, refer to the applicable link for the HP service documentation. See OEM Component 
Support Locations on page 3-65.

GE Part Number Description OEM Part number

2054838-001 16X SPS Supermulti DVD Drive SATA 615646-001

GE Part Number Description OEM Part number

2061991-001 v6.9.5 HP z600: HD 250GB 7200RPM SATA SEAGATE ST250DM000

2054836-001 v6.9 HP z600: 250GB SATA HDD, 7200 RPM, 3.5 IN 508028-001

2050338-002 v6.8.1 HP z600: FRU WD 600GB SATA HDD, 10K RPM, 
3.5

453139-001

GE Part Number Description OEM Part number

2050333-002 FRU HP 2GB DDR3-1333, 240-PIN, ECC DIMM FX699AA
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Fans

There are multiple fans used in the HP z600 Acquisition systems. To replace one of the fans, refer 
to the applicable link for the HP service documentation. See OEM Component Support Locations 
on page 3-65.

Power Supply

The power supply is used in the HP z600 Acquisition systems. To replace the power supply, refer 
to the applicable link for the HP service documentation. See OEM Component Support Locations 
on page 3-65.

GE Part Number Description OEM Part number

2050335-001 HP z600: Memory Module Fan Kit 534472-001

2050334-001 HP z600: Rear System Fan Kit 534471-001

GE Part Number Description HP Part number

2050336-001 HP z600: Power Supply, 650-Watt, PFC 508548-001e
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Barcode Scanner

Overview

The barcode scanner is used with both the HP z600 and GE Client Workstation computers.

Parts in Barcode Scanner Replacement Kit

The Barcode Scanner is shipped within a kit that includes the following:

Shut Down the System

WARNING: SHOCK HAZARD

To reduce the risk of shock and equipment damage, use safe working practices 
when servicing electrical equipment.

1. Close all open windows.

2. Select Start > Shutdown.

3. Click Shutdown.

4. Power off the computer.

Remove and Install the Barcode Scanner

WARNING: SHOCK HAZARD

To reduce the risk of shock and equipment damage, use safe working practices 
when servicing electrical equipment.

1. Disconnect the barcode cable from the USB port on the computer.

2. Connect the new barcode cable with barcode scanner to the USB port on the computer.

Item Part Number Description Quantity

1 2038835-001 Barcode Scanner 3800G USB 1

2 N/A Cable, Barcode Scanner to Motherboard 1

3 2050508-001 Instructions, ML/CL Barcode Scanner Configuration 1
2063076-010H EN Mac-Lab/CardioLab/Centricity Cardiology INW Service Manual 5-31



Replacement Procedures
Power On the System

WARNING: SHOCK HAZARD

To reduce the risk of shock and equipment damage, use safe working practices 
when servicing electrical equipment.

Power on the Acquisition computer.

Configure the Barcode Scanner

Update the configuration on the barcode scanner by scanning the following configuration barcode:

Verify Barcode Functionality

1. Log onto Acquisition system and onto the Mac-Lab/CardioLab Custom Shell as local 
mlcluser.

2. Launch the Mac-Lab/CardioLab application.

3. Start a new study.

4. Press the Barcode key on the keyboard.

5. Scan the barcode of a supply or medication item.

NOTE: Makes sure the barcode was pre-entered into the master list. Otherwise, the scanner will 
recognize the item.

6. Enter the desired quantity.

7. Close the study.
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Uninterruptible Power Supply

Overview

The Uninterruptible Power Supply (PN 2034259-001, 2034260-001, 2034261-001) is a standalone 
assembly. The Uninterruptible Power Supply maintains power to the Acquisition system during a 
facility power outage. Monitors and other peripherals will not remain on during a power outage.

When the UPS battery is low, it will beep. If this happens, do not attempt to replace the battery. 
Contact a GE Healthcare representative.

Parts in 100V Uninterruptible Power Supply Replacement Kit

The 100V Uninterruptible Power Supply is shipped within a kit (PN 2034259-001) that includes the 
following:

For Japanese applications only, NEMA to IEC Cable (PN 405535-013)

Parts in 120V Uninterruptible Power Supply Replacement Kit

The 120V Uninterruptible Power Supply is shipped within a kit (PN 2034260-001) that includes the 
following:

Parts in 240V Uninterruptible Power Supply Replacement Kit

The 240V Uninterruptible Power Supply is shipped within a kit (PN 2034261-001) that includes the 
following:

Item Part Number
Non-RoHS Part 

Number
Description Quantity

1 2034079-002 2034079-001 UPS Powercom, 100V, 50/60 Hz, 1500 VA, BNT 1

2 2003927-001 IEC to IEC Power Cable (8 ft) 1

3 4535-102 Cable Clamp 1

4 2003825-006 Black Blanking Panel for IEB 1

Item Part Number
Non-RoHS Part 

Number
Description Quantity

1 2034077-002 2034077-001 UPS Powercom, 120V, 50/60 Hz, 1500 VA, BNT 1

2 2003927-001 IEC to IEC Power Cable (8 ft) 1

3 4535-102 Cable Clamp 1

4 80274-006 Power Cord, 125V (6 ft) 1

5 2003825-006 Black Blanking Panel for IEB 1

Item Part Number
Non-RoHS Part 

Number
Description Quantity

1 2034078-002 2034078-001 UPS Powercom, 230V, 50/60 Hz, 1500 VA, BNT 1

2 2003927-001 IEC to IEC Power Cable (8 ft) 1
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3 4535-102 Cable Clamp 1

4 2003825-006 Black Blanking Panel for IEB 1

Item Part Number
Non-RoHS Part 

Number
Description Quantity
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Required Tools

Shut Down the System

WARNING: SHOCK HAZARD

To reduce the risk of shock and equipment damage, use safe working practices 
when servicing electrical equipment.

1. Close all open windows.

2. Select Start > Shutdown.

3. Click Shutdown.

4. Power off the Acquisition system and all peripheral devices.

5. Power off the IEB.

6. Power off the UPS.

7. Disconnect the AC main power cord from the UPS.

Remove and Install the Uninterruptible Power Supply

WARNING: SHOCK HAZARD

To reduce the risk of shock and equipment damage, use safe working practices 
when servicing electrical equipment.

1. Disconnect all input and output power cables from the UPS.

2. Remove the failed Uninterruptible Power Supply from the control room.

3. Place the new Uninterruptible Power Supply in a level location (same location the failed UPS 
was removed). 

NOTE: The power cables that were included in the kit will not be needed for this procedure.

Item Part Number Description Quantity

1 N/A 9/32” Nutdriver or Wrench 1

2 N/A #2 Phillips Screwdriver 1
2063076-010H EN Mac-Lab/CardioLab/Centricity Cardiology INW Service Manual 5-35



Replacement Procedures
4. Reconnect the AC main power cord to the Uninterruptible Power Supply.

5. Reconnect the UPS power cord (PN 2003927-001) coming from the IEB power receptacle 
labeled UPS Power to Comp to the Uninterruptible Power Supply.

6. Verify one end of the cable listed below is connected to the HP computer and reconnect the 
other end to the UPS output power receptacle.

 100V Systems: Nema to IEC Cable (PN 405535-013)

 120V Systems: Nema to IEC Cable (PN 80274-006)

 240V Systems: IEC to IEC (PN 2003927-001)
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Power On the System

WARNING: SHOCK HAZARD

To reduce the risk of shock and equipment damage, use safe working practices 
when servicing electrical equipment.

1. Power on the IEB.

2. Power on the Uninterruptible Power Supply.

3. Power on the Acquisition system and all peripheral devices.

4. Log on Acquisition system to the Mac-Lab/CardioLab Custom Shell as local mlcluser.

Verify Uninterruptible Power Supply Functionality

1. Turn off the main power switch on the back of the IEB for 10 seconds.

2. During the 10 seconds, verify power to the Acquisition system is not interrupted and that the 
power LED on the Acquisition system is still green.

3. During the 10 seconds, verify the Uninterruptible Power Supply is emitting an audible beep.

4. After the 10 seconds, turn on main power switch on the back of the IEB.

5. Verify the Uninterruptible Power Supply is no longer emitting an audible beep.

6. Verify the Acquisition system was not interrupted and is still logged on as Mac-Lab/CardioLab 
Custom Shell. 

NOTE: If the verification steps do not execute successfully, contact Tech Support.
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INW Server – G8

The Centricity Cardiology INW Server shipped with new Mac-Lab/CardioLab systems is 
Generation G8 (G8). To replace the INW Server or any of its components, refer to the applicable 
link for the HP service documentation. See OEM Component Support Locations on page 3-65. 

 G8 - Part Description GE Part Number HP Part number

FRU HP 450GB SAS HDD 2.5 IN. 10K DP 6G-HTC 2070439-001 597609-002

FRU HP 900GB SAS HDD 2.5 IN. 10K 6G SMARTDRIVE 2070440-001 652589-B21

FRU HP SATA DVD-ROM DRIVE, HH JB BZL 2070567-001 624591-001 

FRU HP 8GB (1X8GB) DUAL RANK X4 PC3L-10600 
(DDR3-1333) REG CAS-9 LP MEMORY KIT

2070568-001 647897-B21

FRU HP 460W COMMON SLOT PLATINUM PLUS HOT 
PLUG POWER SUPPLY KIT

2070570-001 656362-B21

FRU HP ML350P GEN8 FAN ASSEMBLY 2070573-001 667254-001

FRU HP 2GB P-SERIES SMART ARRAY FLASH 
BACKED WRITE CACHE

2070577-001 631681-B21
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INW Server - G6

The Centricity Cardiology INW Server, Generation 6 (G6), is no longer shipped with new Mac-Lab/
CardioLab systems and is no longer available as a complete assembly. However, existing INW 
Server, Generation 6 (G6) can be upgraded for v6.9.5 Mac-Lab/CardioLab systems. To replace the 
INW Server or any of its components, refer to the applicable link for the HP service documentation. 
See OEM Component Support Locations on page 3-65.

 v6.9 INW Server - G6 - Part Description GE Part Number HP Part number

HP Hard Drive 300GB 10K 6G 2.5 2049045-001 507127-B21

HP IDE DVD-ROM 16X 2050330-001 447464-001

HP ML370 G6 Fan Assembly 2050331-001 519559-001

HP Quad Port Gigabit Server Adapter 2050659-001 491838-001

HP 2GB DIMM PC3-10600R 2056076-001 500202-061

HP Smart Array P410 512MB BBWC 2056077-001 462975-001

HP Server Power Supply 460W Hot Plug 2050327-001 536404-001

v6.8.1 INW Server - G6 - Part Description GE Part Number HP Part number

HP Smart Array P410 512MB BBWC 2050329-001 462864-B21

HP Hard Drive 146GB 10K 6G 2.5 SAS DP 2048609-001 507125-B21

HP 2GB 1333MHz PC3-10600R DDR3 DIMM 2050332-001 501533-001
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INW Server - G5

The Centricity Cardiology INW Server, Generation 5 (G5), is no longer shipped with new Mac-Lab/
CardioLab systems and is no longer available as a complete assembly. However, existing INW 
Server, Generation 5 (G5) can be upgraded for v6.9.5 Mac-Lab/CardioLab systems. To replace the 
INW Server or any of its components, refer to the applicable link for the HP service documentation. 
See OEM Component Support Locations on page 3-65.

INW Server G5 - Part Description GE Part Number HP Part number

HP ML370 DVD-RW 2036800-025 384069-001

HP FBDIMM PC2-5300F Fully-Buffered 2036798-017 416471-001

HP Smart Array P400 Controller Cache MOD 2036800-038 405832-001

HP 72GB 10K SAS 2.5 Hot Plug Hard Drive 2034798-001 375861-B21

HP 146GB 10K SAS 2.5 Hot Plug Hard Drive 2034806-001 432320-001

HP ML370 Hot Plug Power Supply 1000-W 2036800-014 403781-001

HP ML370 Hot Plug Fan 120-MM 2036800-015 409421-001

HP 2GB Server Memory Upgrade Kit G5 2053152-001 N/A
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Parts List
HP z600 Computer

Part Number Description

2079328-002 COMPUTER CL/ML ACQUISITION IT Z600 6.9.5

422310-001 MOUSEPAD GE HEALTHCARE

2049434-001 CARD VIDEO, MATROX M9140 QUAD PCIE 512MB

2003587-002
2003587-001

CABLE, MULTICONDUCTOR DB44 M-M 2.5 FT - RoHS
CABLE, MULTICONDUCTOR DB44 M-M 2.5 FT - Non-RoHS

2014935-003
2014935-002

PCB COMM PCI - RoHS
PCB COMM PCI - Non-RoHS

2009937-004
2009937-003

PCB TRAMNET TO ETHERNET ADAPTER - RoHS
PCB TRAMNET TO ETHERNET ADAPTER - Non-RoHS

2047766-001 BRACKET WITH NIC/COMM PCB MLCL COMPUTER

2057429-001 FRU GIGABIT ADPTR,PCIE,2 PORT

2036936-017
2057430-001

FRU SERIAL PORT C5 - RoHS
FRU SERIAL PORT C5 - Non-RoHS

2050067-001 ASSY, SD CARD DRIVE, MLCL

Part Number Description

2079328-004 COMPUTER CL/ML ACQUISITION XT Z600 6.9.5

422310-001 MOUSEPAD GE HEALTHCARE

2049434-001 CARD VIDEO, MATROX M9140 QUAD PCIE 512MB

2003587-002
2003587-001

CABLE, MULTICONDUCTOR DB44 M-M 2.5 FT - RoHS
CABLE, MULTICONDUCTOR DB44 M-M 2.5 FT - Non-RoHS

2014935-003
2014935-002

PCB COMM PCI - RoHS
PCB COMM PCI - Non-RoHS

2009937-004
2009937-003

PCB TRAMNET TO ETHERNET ADAPTER - RoHS
PCB TRAMNET TO ETHERNET ADAPTER - Non-RoHS

2052113-001 CARD VIDEO, MATROX HELIOS

2017899-002

2017899-001

KIT, MLCL IMAGE CABLING ACCESSORIES - RoHS
CABLE DVI-I MALE TO 5 BNC FEMALES (2018060-002 (RoHS)
CABLE BNCM TO BNCM, MIN RG-59 COAX, 50 FT (2003411-002 (RoHS) 

KIT, MLCL IMAGE CABLING ACCESSORIES - Non-RoHS
CABLE DVI-I MALE TO 5 BNC FEMALES 2018060-001 (Non-RoHS)) 
CABLE BNCM TO BNCM, MIN RG-59 COAX, 50 FT or 2003411-001 (Non-RoHS)) 

2047766-001 BRACKET WITH NIC/COMM PCB MLCL COMPUTER

2057429-001 FRU GIGABIT ADPTR,PCIE,2 PORT 

2057430-001 FRU SERIAL PORT C5 

2050067-001 ASSY, SD CARD DRIVE, MLCL
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Additional HP Z600 Replacement Parts

Part Number Description

2079328-005 COMPUTER CL/ML ACQUISITION XTI Z600 6.9.5

422310-001 MOUSEPAD GE HEALTHCARE

2049434-001 CARD VIDEO, MATROX M9140 QUAD PCIE 512MB

2003587-002
2003587-001

CABLE, MULTICONDUCTOR DB44 M-M 2.5 FT - RoHS
CABLE, MULTICONDUCTOR DB44 M-M 2.5 FT - Non-RoHS

2014935-003
2014935-002

PCB COMM PCI - RoHS
PCB COMM PCI - Non-RoHS

2009937-004
2009937-003

PCB TRAMNET TO ETHERNET ADAPTER - RoHS
PCB TRAMNET TO ETHERNET ADAPTER - Non-RoHS

2052113-001 CARD VIDEO, MATROX HELIOS

2017899-002

2017899-001

KIT, MLCL IMAGE CABLING ACCESSORIES - RoHS
CABLE DVI-I MALE TO 5 BNC FEMALES (2018060-002 (RoHS)
CABLE BNCM TO BNCM, MIN RG-59 COAX, 50 FT (2003411-002 (RoHS) 

KIT, MLCL IMAGE CABLING ACCESSORIES - Non-RoHS
CABLE DVI-I MALE TO 5 BNC FEMALES 2018060-001 (Non-RoHS)) 
CABLE BNCM TO BNCM, MIN RG-59 COAX, 50 FT or 2003411-001 (Non-RoHS)) 

2031725-001 CARD, VIDEO, MATROX SOLIOS EA

2047766-001 BRACKET WITH NIC/COMM PCB MLCL COMPUTER

2057429-001 FRU GIGABIT ADPTR, PCIE, 2 PORT

2057430-001 FRU SERIAL PORT C5 

2050067-001 ASSY, SD CARD DRIVE, MLCL

Part Number Description

2061991-001 FRU 250GB SATA AF HDD, 3.5

2053463-001 DRIVE PANASONIC (LKM-KB12) EXTERNAL BLU RAY

2056207-002
2056207-001

ASSY, FRU SD READER DRIVE & CABLE - RoHS
ASSY, FRU SD READER DRIVE & CABLE - Non-RoHS

2054838-001 FRU HP 16X SPS SUPERMULTI DVD DRIVE SATA 

2050333-002 FRU HP 2GB DDR3-1333, 240-PIN, ECC DIMM

2026539-001 OPTICAL USB SCROLL MOUSE ALL (HP #32617-005)

2050334-001 FRU HP REAR SYSTEM FAN KIT (HP #534471-001)

2038834-001 EQPMT, BARCODE SCANNER 3800G USB (replaces PS2 Version 2003417-001 EQPMT, BARCODE SCANNER)

2050335-001 FRU HP MEMORY MODULE FAN KIT (HP #534472-001)

2050336-001 FRU HP Z600 POWER SUPPLY 650-WATT, PFC (HP #508548-001)

2054833-001 FRU HP Z600 SYS BD 1333MHZ FSB C2 CHPSET (HP #591184-001)
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2053463-001 DRIVE PANASONIC EXTERNAL BLU RAY 

2054839-001 FRU HP Z600 FRONT PANEL ASSEMBLY

Keyboards

2045812-001 LABEL KEYBOARD CUSTOMER SUPPORT ML/CL

CARDIOLAB Keyboards from Language Kits

2054858-002 KEYBOARD BLACK CLAB PRE-ASM ENGLISH

2054858-008 KEYBOARD BLACK CLAB PRE-ASM FRENCH

2054858-009 KEYBOARD BLACK CLAB PRE-ASM GERMAN

2054858-010 KEYBOARD BLACK CLAB PRE-ASM SPANISH

2054858-011 KEYBOARD BLACK CLAB PRE-ASM ITALIAN

2054858-016 KEYBOARD BLACK CLAB PRE-ASM SWEDISH

2054858-019 KEYBOARD BLACK CLAB PRE-ASM CHINESE

2054858-022 KEYBOARD BLACK CLAB PRE-ASM DANISH 

2054858-025 KEYBOARD BLACK CLAB PRE-ASM  DUTCH

2054858-028 KEYBOARD BLACK CLAB PRE-ASM  NORWEGIAN

COMBOLAB Keyboards from Language Kits

2054858-003 KEYBOARD BLACK MAC-LAB/CLAB PRE-ASM ENGLISH

2054858-004 KEYBOARD BLACK MAC-LAB/CLAB PRE-ASM FRENCH

2054858-005 KEYBOARD BLACK MAC-LAB/CLAB PRE-ASM GERMAN

2054858-006 KEYBOARD BLACK MAC-LAB/CLAB PRE-ASM SPANISH

2054858-007 KEYBOARD BLACK MAC-LAB/CLAB PRE-ASM ITALIAN

2054858-018 KEYBOARD BLACK MAC-LAB/CLAB PRE-ASM SWEDISH

2054858-021 KEYBOARD BLACK MAC-LAB/CLAB PRE-ASM CHINESE

2054858-024 KEYBOARD BLACK MAC-LAB/CLAB PRE-ASM DANISH

2054858-027 KEYBOARD BLACK MAC-LAB/CLAB PRE-ASM DUTCH

2054858-030 KEYBOARD BLACK MAC-LAB/CLAB PRE-ASM NORWEGIAN

MAC-LAB Keyboards from Language Kits

2054858-001 KEYBOARD BLACK MAC-LAB PRE-ASM ENGLISH

2054858-012 KEYBOARD BLACK MAC-LAB PRE-ASM FRENCH

2054858-013 KEYBOARD BLACK MAC-LAB PRE-ASM GERMAN

2054858-014 KEYBOARD BLACK MAC-LAB PRE-ASM SPANISH

2054858-015 KEYBOARD BLACK MAC-LAB PRE-ASM ITALIAN

2054858-017 KEYBOARD BLACK MAC-LAB PRE-ASM SWEDISH

2054858-020 KEYBOARD BLACK MAC-LAB PRE-ASM CHINESE

Part Number Description
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2054858-023 KEYBOARD BLACK MAC-LAB PRE-ASM DANISH 

2054858-026 KEYBOARD BLACK MAC-LAB PRE-ASM DUTCH

2054858-029 KEYBOARD BLACK MAC-LAB PRE-ASM NORWEGIAN

Part Number Description
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Integrated Electronics Box (IEB)

Replacement Parts

Part Number Description

2079326-001 IEB 110V MAC-LAB

2079326-002 IEB 110V CARDIOLAB

2079326-003 IEB 110V SPECIALSLAB

2079326-004 IEB 110V COMBOLAB

2079326-005 IEB 240V MAC-LAB

2079326-006 IEB 240V CARDIOLAB

2079326-007 IEB 240V SPECIALSLAB

2079326-008 IEB 240V COMBOLAB 

2079326-009 IEB 100V MAC-LAB

2079326-010 IEB 100V CARDIOLAB

2079326-011 IEB 100V SPECIALSLAB

2079326-012 IEB 100V COMBOLAB

Part Number Description

Common Parts

2003680-002 ASSY DB CONNECT FOR IEB

2003681-004 ASSY VID/MUX FOR IEB

2013535-001 PWR SPLY SW 90-265VAC 50-60HZ 16.5/-5/5V

700775-002 PWR CORD 125V 20A 2.5M

2003410-001 CABLE BNCM TO BNCM, MIN RG-59 COAX, 30FT

2003927-001 POWER CORD IEC (M)-IEC (F) 8FOOT

2003928-001 CABLE, VIDEO, DB15MHD-DB15MHD; 5FT

2081540-001 CABLE, VIDEO, DB15MHD-DB15MHD, 6FT

2003825-006 BRACKET, BLANKING PANEL FOR IEB

2011055-001 IEB SHELF ASSY 100V and 120V. Use this replacement part for repair of an RAU power supply (PN 2003264-001) 
and/or Vid/mux power supply (PN 2003266-001)

2006323-001 CABLE POWER, IEC C19 TO UNTERMINATED

100V Parts

2006323-001 CABLE POWER, IEC C19 TO UNTERMINATED
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405535-013 PWR SPLY CRD ST-ST PSE 10A 125V 6.25FT

240V Part

2011055-002 IEB SHELF ASSY 240V. Use this replacement part for repair of an RAU power supply and/or Vid/mux power supply.

2006323-001 CABLE POWER, IEC C19 TO UNTERMINATED

Part Number Description
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Uninterrupted Power Source (UPS)

Part Number Description

2034260-001 KIT 120V IEB UPS REPLACEMENT EXTERNAL — includes 2034077-002 (RoHS) or 2034077-001 (non-RoHS) 
UPS POWERCOM, 120V, 50/60 Hz, 1500VA, BNT (replaces:

2033849-001 UPS POWERCOM, 120V, 1000VA

2031037-001 UPS POWERCOM, 115V, 800VA

2023532-001 BTRY UPS, 115V, MI800)

2034261-001 KIT 240V IEB UPS REPLACEMENT EXTERNAL — includes 2034078-002 (RoHS) or 2034078-001 (non-RoHS) 
UPS POWERCOM, 240V, 50/60 Hz, 1500VA, BNT (replaces:

2033850-001 UPS POWERCOM, 240V, 1000VA

2031038-001 UPS POWERCOM, 230V, 800VA

2023533-001 BTRY UPS, 230V, MI800)

2034259-001 KIT 100V IEB UPS REPLACEMENT EXTERNAL — includes 2034079-002 (RoHS) or 2034079-001 (non-RoHS) 
UPS POWERCOM, 100V, 50/60 Hz, 1500VA, BNT (replaces:

2033851-001 UPS POWERCOM, 100V, 1000VA

2031039-001 UPS POWERCOM, 100V, 800VA

2023534-001 BTRY UPS, 100V, MI800)
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Review Workstation

Part Number Description

2063576-001 COMPUTER CL/ML GE CLIENT WORKSTATION 6.9.5

Keyboards

2045812-001 LABEL KEYBOARD CUSTOMER SUPPORT ML/CL

CARDIOLAB Keyboards from Language Kits

2054858-002 KEYBOARD BLACK CLAB PRE-ASM ENGLISH

2054858-008 KEYBOARD BLACK CLAB PRE-ASM FRENCH

2054858-009 KEYBOARD BLACK CLAB PRE-ASM GERMAN

2054858-010 KEYBOARD BLACK CLAB PRE-ASM SPANISH

2054858-011 KEYBOARD BLACK CLAB PRE-ASM ITALIAN

2054858-016 KEYBOARD BLACK CLAB PRE-ASM SWEDISH

2054858-019 KEYBOARD BLACK CLAB PRE-ASM CHINESE

2054858-022 KEYBOARD BLACK CLAB PRE-ASM DANISH 

2054858-025 KEYBOARD BLACK CLAB PRE-ASM  DUTCH

2054858-028 KEYBOARD BLACK CLAB PRE-ASM  NORWEGIAN

COMBOLAB Keyboards from Language Kits

2054858-003 KEYBOARD BLACK MAC-LAB/CLAB PRE-ASM ENGLISH

2054858-004 KEYBOARD BLACK MAC-LAB/CLAB PRE-ASM FRENCH

2054858-005 KEYBOARD BLACK MAC-LAB/CLAB PRE-ASM GERMAN

2054858-006 KEYBOARD BLACK MAC-LAB/CLAB PRE-ASM SPANISH

2054858-007 KEYBOARD BLACK MAC-LAB/CLAB PRE-ASM ITALIAN

2054858-018 KEYBOARD BLACK MAC-LAB/CLAB PRE-ASM SWEDISH

2054858-021 KEYBOARD BLACK MAC-LAB/CLAB PRE-ASM CHINESE

2054858-024 KEYBOARD BLACK MAC-LAB/CLAB PRE-ASM DANISH

2054858-027 KEYBOARD BLACK MAC-LAB/CLAB PRE-ASM DUTCH

2054858-030 KEYBOARD BLACK MAC-LAB/CLAB PRE-ASM NORWEGIAN

MAC-LAB Keyboards from Language Kits

2054858-001 KEYBOARD BLACK MAC-LAB PRE-ASM ENGLISH

2054858-012 KEYBOARD BLACK MAC-LAB PRE-ASM FRENCH

2054858-013 KEYBOARD BLACK MAC-LAB PRE-ASM GERMAN

2054858-014 KEYBOARD BLACK MAC-LAB PRE-ASM SPANISH

2054858-015 KEYBOARD BLACK MAC-LAB PRE-ASM ITALIAN

2054858-017 KEYBOARD BLACK MAC-LAB PRE-ASM SWEDISH
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2054858-020 KEYBOARD BLACK MAC-LAB PRE-ASM CHINESE

2054858-023 KEYBOARD BLACK MAC-LAB PRE-ASM DANISH 

2054858-026 KEYBOARD BLACK MAC-LAB PRE-ASM DUTCH

2054858-029 KEYBOARD BLACK MAC-LAB PRE-ASM NORWEGIAN

Isolation Transformer

2004195-001 ISO Transformer, 120V/220V 50/60HZ 600VA

Part Number Description
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DASH Connection

Solar Connection

Part Number Description

2000453-001 KIT DOWNLOAD DASH

418335-002 CABLE ASSEMBLY RJ45 WHITE 10 FT

420915-013 DIDCA ASM PC INTERFACE AUTOPORT

Part Number Description

2003408-001 DB9M TO DB9F, 50FT, STRAIGHT THRU
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Centricity Cardiology INW G8 Server

Centricity Cardiology INW G6 Server

Part Number Description

2063574-001 SERVER CL/ML INW G8 HI 6.9.5

2063574-003 SERVER CL/ML INW G8 LO 6.9.5

Part Number Description

2070439-001 FRU HP 450GB SAS HDD 2.5 IN. 10K DP 6G-HTC

2070440-001 FRU HP 900GB SAS HDD 2.5 IN. 10K 6G SMARTDRIVE

2070567-001 FRU HP SATA DVD-ROM DRIVE, HH JB BZL

2070568-001 FRU HP 8GB (1X8GB) DUAL RANK X4 PC3L-10600 (DDR3-1333) REG CAS-9 LP MEMORY 
KIT

2070570-001 FRU HP 460W COMMON SLOT PLATINUM PLUS HOT PLUG POWER SUPPLY KIT

2070573-001 FRU HP ML350P GEN8 FAN ASSEMBLY 

2070577-001 FRU HP 2GB P-SERIES SMART ARRAY FLASH BACKED WRITE CACHE

Part Number Description

2053149-001 ASSY SERVER CL/ML INW G6 HI 6.9

2053149-003 ASSY SERVER CL/ML INW G6 LO 6.9

2055264-001 ASSY SERVER CL/ML INW G6 HI PURCH

2055264-003 ASSY SERVER CL/ML INW G6 LO

2048968-001 ASSY SERVER CL/ML INW G6 HI

2048968-003 ASSY SERVER CL/ML INW G6 LO

2049045-001 HARD DRIVE HP 300GB 10K 6G 2.5

Part Number Description

2050327-001 FRU HP SERVER PWR SUPPLY 460W, HOT PLUG

2050328-001 FRU HP SC11XE SCSI HOST BUS ADAPTER

2050329-001 FRU HP SMART ARRAY P410, 512MB, BBWC

2050330-001 FRU HP IDE DVD-ROM, 16X

2050331-001 FRU HP ML370 G6 FAN ASSEMBLY

2050332-001 FRU HP 2GB 1333MHz PC3-10600R,DDR3 DIMM
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2050328-001 FRU HP SC11XE SCSI HOST BUS ADAPTER

2050659-001 FRU HP QUAD PORT GIGABIT SERVER ADAPTER

Part Number Description
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Centricity Cardiology INW G5 Server

Part Number Description

2045708-001, 
2038168-001
2050580-001

CMPTR SERVER CL/ML INW G5 HI

2038168-002 CMPTR SERVER CL/ML INW G5 MID

2045708-003, 
2038168-003
2050580-003

CMPTR SERVER CL/ML INW G5 LO

2036800-038 HP SMARTARRAY P400 CNTRLLR CACHE MOD

2034798-001 HP 72GB 10K SAS 2.5 HOT PLUG HARDDRIVE

2034806-001 HP 146GB 10K SAS 2.5 HOT PLUG HARDDRIVE

2024244-002 TAPE DRIVE SONY AIT-3 SDX-700V/RB INTERNAL (HIGH/MID)

2024244-003 TAPE DRIVE AIT-2 TURBO SDX-550V INTERNAL (LOW)

2036798-017 MEMORY HP 2GB FULLY BUFFERED DIMM PC2-5300F (2x1GB MEMORY)

2036800-025 HP ML370 DVD-RW DRIVE

414582-222 POWER ADAPTER 230VAC/DC ME (FOR EUROPE)

414582-223 POWER ADAPTER 100VAC/DC JAP (FOR JAPAN)

414582-224 POWER ADAPTER 240VAC/DC AA (FOR ASIA/AUSTRALIA)

414582-225 POWER ADAPTER 240VAC/DC UK (FOR UNITED KINGDOM)

2080247-001
421572-028

CABLE ETHERNET - RoHS
CABLE ETHERNET - Non-RoHS

2018135-003 AIT-3 TAPE CARTRIDGES - Single

2018135-005 TAPE CARTRIDGE AIT-2 TURBO 80GB - Single

2019000-001 KYBD TRACKBALL INTEGRATED IU HP

2025078-001 Interface Adaptors

2025079-001 CAT5 Ethernet Patch Cable 10ft.

2036800-014 HP ML370 1000-W HOT-PLUG POWER SUPPLY

2036800-015 HP ML370 HOT-PLUG FAN, 120-MM
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PDM and PDM Base Station

PDM Models

Cables and Mounting Hardware

Part Number Description

2041390-058 PDM MLCL MASIMO SPO2

2041390-059 PDM MLCL NELLCOR SPO2

Part Number Description

2060229-001 ASSY PDM BASE STATION

2017098-009 CABLE ASSY EPORT PDM TO HOST - 12.5INCH

2017098-001 CABLE ASSY EPORT PDM TO HOST - 5FEET 

2017098-003 CABLE ASSY EPORT PDM TO HOST - 15FEET

2017098-007 CABLE ASSY EPORT PDM TO HOST - 45FEET

418335-008 CABLE ASSY RJ45 WHITE 100FT

2021969-001 MOUNT PRC W/L-BRACKET 

2042392-001 FLOOR STAND ML/CL BASE
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TRAMNet

Part Number Description

2018683-001
 2011129-001
 2016133-001
 2016134-001

Kit MLCL TRAMNet Cabling Accessories
CABLE ETHERNET PATCH - 1FT
ASSY CABLE TNET TO IEB D 9M/9F
ASSY CABLE IEB TO RAC 4A ADAPTOR

2019445-001 TRAM 451 CABLE KIT (AHA): includes ACQ CABLE, TRAMNET CABLES, AND MOUNTING KIT

2019446-001 TRAM 451N CABLE KIT (AHA): includes ACQ CABLE, TRAMNET CABLES, AND MOUNTING KIT

2019447-001 TRAM 451M CABLE KIT (AHA): includes ACQ CABLE, TRAMNET CABLES, AND MOUNTING KIT

2021597-001 TRAM 451N CABLE KIT (IEC)+ RAC4A + DTCBL+ MNT KIT

2021598-001 TRAM 451M CABLE KIT (IEC)+RAC4A + DTCBL+ MNT KIT

2021599-001 TRAM 451N CABLE KIT (IEC)

2021600-001 TRAM 451M CABLE KIT (IEC)

417335-003 ASM, ACQUISITION CABLE 70 FT (Standard)

417335-001 ASM, ACQUISITION CABLE 10FT

417335-002 ASM, ACQUISITION CABLE 51 FT

417335-004 ASM, ACQUISITION CABLE 100 FT

417335-005 ASM, ACQUISITION CABLE 125 FT 

417335-006 ASM, ACQUISITION CABLE 150 FT

417335-007 ASM, ACQUISITION CABLE 20 FT

2007759-002 KIT MACLAB EX RAU RAC4A FLOOR / RAIl MNTG

900031-007 ASSY TRAM RAC 4A W/PWR SPLY

2000633-001 CABLE ASSY CINCH MDC-7P15

412931-005 MAC-LAB 5LD STRTR KIT, RADIOTRANSLUCENT

416035-003 MAC-LAB 12LD STARTER KIT AHA

2025248-002 CABLE ASSY PATIENT CARDIAC OUTPUT 2.7m (replaces 2002973-004)

9446-909 BATH PROBE TR INJ TEMP 6 FT MEI

9446-910 CA TRAM INLINE INJ EDW 3 FT MEI

415265-003 KIT NBP ADULT STARTER

900079-006 SYNC CBL, TRAM 3 'Y' ADAPTER

2008991-001 ADPTR MINI DIN TO CONN RCPT 6P PHG 1B

2006644-001 CABLE ASSY PATIENT ADAPTER NELLCOR SPO2

407705-006 DURASENSOR ADULT DS-100A INDV

2017002-001 CABLE ASSY SPO2 MASIMO 3.6m (replaces 2016041-001)

2017002-002 CABLE ASSY SPO2 MASIMO 1.2m (replaces 2016041-002)
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Amplifier

2002800-001 MASIMO REUSABLE FINGER SENSOR ADULT

2002799-001 MASIMO REUSABLE FINGER SENSOR PED

2017006-003 CABLE ASSY ECG MLT-LNK 10 LEAD 3.6M IEC (replaces 416035-002)

403751-026 LD RT GRB/MNK IEC 60L 10/SET

414873-001 TUBE NBP CUFF

9461-601 BP CUFF DL TUBE ADULT - DURA-CUF

9446-911 CA TR INLINE INJ GOULD 3FT MEI

Part Number Description

Part Number Description

2003232-001 ASSY CLAB II PLUS 32 AMP 110-240V 50/60HZ

2079324-002
2003232-002

ASSY CLAB II PLUS 64 AMP 110-240V 50/60HZ - RoHS
ASSY CLAB II PLUS 64 AMP 110-240V 50/60HZ - Non-RoHS

2003232-003 ASSY CLAB II PLUS AMPLIFIER 96 CHANNEL

2079324-004
2003232-004

ASSY CLAB II PLUS AMPLIFIER 128 CHANNEL - RoHS
ASSY CLAB II PLUS AMPLIFIER 128 CHANNEL - Non-RoHS

2082432-001 KIT FRU PACING ENABLED RF FILTER BOX

2083472-001 CABLE STIM EXTENDER, 3FT DUAL TOUCHPROOF

2003419-001 CABLE, ECG, 10LEAD, SHIELDED 10FT

2003421-001 CABLE LEAD SET, ECG, SHIELDED, 36" WIRES

2003434-001 CABLE FIBER, ST TO FDDI, DUPLEX, 75FT

2007857-001 PRUCKA CATHETER INPUT MODULE LABELS

301-00202-08 CABLE CATHTR INPT MOD3 TPRF 8FT M CLBII+

301-00204-03 CABLE STIM INPT TCHPRF 3FT CLABII+

301-00205-08 CABLE AUX INPT RF RCRD UNIPLR CLABII+

301-00204-15 15 FT TOUCHPROOF STIMULATOR INPUT CABLE

301-00204-30 30 FT TOUCHPROOF STIMULATOR INPUT CABLE
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Vivid

Part Number Description

Vivid

2030703-001 ADPTR DVI DUAL LINK M TO 15P VGAF

2032340-002
2032340-001

CABLE VID 75OHM HD15M-HD15M 100FT - RoHS
CABLE VID 75OHM HD15M-HD15M 100FT - Non-RoHS

2003926-001 CONN, BNC “T”, MALE TO DOUBLE FEMALE

2031919-001 CABLE ECG ML/CL ICE 100FT

2032673-001 CABLE EXT ECG VIVID-I TO ML/CL 600MM

2049942-001 FERRITE CABLE CLAMP FAIR-RITE 0431173951

2046764-001 2412094-16, CABLE VIVID POWER USA 110V

2047945-001 S2423870 SAMSUNG DVD

2047947-001 S2423956 CBL KIT SAMSUNG DVD VIVID-I

2048571-001 S2423364 ICE-CordRS 

Trackball (top level assembly is 2046201-001)

2031212-001 ASSY REMOTE TRACKBALL VIVID-I

2031215-001 CABLE REMOTE TRACKBALL VIVID-I 100FT

2031218-001 CABLE RS485/USB ADPTR RMT TRCKBL VIVID-I

Vivid Mount

2030705-001 MOUNT BEDRAIL VIVID-I

Vivid Service Parts

2046761-001 S2423267, Internal Battery Pack (Black)

2376515-2 2376515-2, Hard Disk Module w/o SW

2046763-001 2414958-2, Hard Disk Duplication Jig

2409727 2409727, LAN Isolation Box + Cable Kit

2378947-2 2378947-2, AC Adaptor

2046764-001 2412094-16, Power Cable USA 110V
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MicroPace

RMOT

Part Number Description

MicroPace FRUs

2032778-002
2032778-001

FRU MICROPACE STIMULATOR - SGU, NO PS MFG - MP3008 - RoHS
FRU MICROPACE STIMULATOR - SGU, NO PS MFG - MP3008 - Non-RoHS

2032779-002
2032779-001

FRU MICROPACE ACC KIT, SGU PWR, CABLS, US MFG - MP3055-GE-US - RoHS
FRU MICROPACE ACC KIT, SGU PWR, CABLS, US MFG - MP3055-GE-US - Non-RoHS

2032780-002
2032780-001

FRU MICROPACE BONA LIGHT PC, PSU MFG - MP3093 - RoHS
FRU MICROPACE BONA LIGHT PC, PSU MFG - MP3093 - Non-RoHS

2032781-001 FRU MICROPACE DIAMOND TOUCH KEYBOARD MFG - MP3015

2032782-001 FRU MICROPACE NEC MONITOR MFG - MP3076

2031041-001 MICROPACE TOUCHSCREEN FOR STIMULATOR MFG - MP3113-GE

2032783-002
2032783-001

FRU MICROPACE 4CH SM-BOX, CABLES MFG - MP3091 - RoHS
FRU MICROPACE 4CH SM-BOX, CABLES MFG - MP3091 - Non-RoHS

2032784-001 FRU MICROPACE 2CH STIMULATOR CONNECT BOX MFG - MP3014

2032785-002
2032785-001

FRU MICROPACE UNIVERSAL ISOLATION XFMR MFG - MP3107 - RoHS
FRU MICROPACE UNIVERSAL ISOLATION XFMR MFG - MP3107 - Non-RoHS

2081106-001 FRU MICROPACE SGU POWER SUPPLY MP3074

2055762-001 9V LITHIUM BATTERY EMERGENCY SGU BATTERY MP3210

2055761-001 12V SEALED LEAD ACID BATTERY BACKUP SGU BATTERY MP3209

MicroPace Cables

2049323-001 CABLE STIM EXTENSION FOR MICROPACE, 13M MFG - MP3070-13

2049324-001 CABLE STIM EXTENSION FOR MICROPACE, 17M -MFG - MP3070-17

2037660-001 CABLE MUX CNTRL FOR MICROPACE, 15M MFG - MP3090

2037661-001 CABLE MUX CNTRL FOR MICROPACE, 27M MFG - MP3146

2037662-001 CABLE SERIAL RS232 EXT MICROPACE, 25M MFG - MP3084-25

StimLab FRUs

2050900-001 STIMLAB LOCAL TOUCH SCREEN PACKAGE MP3174

2050899-001 STIMLAB REMOTE TOUCH SCREEN PACKAGE MP3173

2050901-001 ROLL STAND PACKAGE MP3183

2054598-002 
2054598-001

STIMLAB COMPUTER CABINET PACKAGE - ROHS MP3171
STIMLAB COMPUTER CABINET PACKAGE MP3171

2050898-002
2050898-001

EQPMT STIMLAB CARDIAC STIMULATOR SGU PACKAGE - ROHS MP3172
EQPMT STIMLAB CARDIAC STIMULATOR SGU PACKAGE MP3172
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Parts List
Part Number Description

RMOT

2022144-004 MOUSE USB OPTICAL SCROLL LIGHTED

2026972-002 KIT RMOT, CAT5, 100FT W/ ISOLATOR

2003927-001 POWER CORD IEC (M) - IEC (F) 8FT

2004195-001 ISO Transformer, 120V/220V 50/60HZ 600VA
6-20 Mac-Lab/CardioLab/Centricity Cardiology INW Service Manual 2063076-010H EN 



Parts List
Speakers and Miscellaneous

Ablation

Analog Output

CARTO

Part Number Description

2018835-001

2003408-002

2042981-001

2042214-001

2035570-001

RF ABLATION DEVICE INTERFACE KIT

CABLE DB25M TO DB9F, 50 FT, SERIAL

OPTO ISOLATOR KIT, SERIAL DB25

CABLE ASSY SERIAL RF ABLATION INTERFACE

CABLE ASSY SERIAL CRYOCATH INTERFACE

Part Number Description

2007557-003
2018971-001

16CH ANALOG OUTPUT CPU INTERFACE OPTION - RoHS
16CH ANALOG OUTPUT CPU INTERFACE OPTION - Non-RoHS

2007557-003
2007557-002

2010476-002
2010476-001

2007579-001

417335-002

2011355-001

2003410-001

KIT ANALOG OUTPUT BOX W/CABLES - RoHS
KIT ANALOG OUTPUT BOX W/CABLES - Non-RoHS

BOX CARDIOLAB/MACLAB ANALOG OUTPUT - RoHS
BOX CARDIOLAB/MACLAB ANALOG OUTPUT - Non-RoHS

CABLE DB 37 MALE/FEMALE 15 FT

ASM, ACQUISITION CABLE 51'

CABLE PHONE-BNC M 10FT RG-174 COAX 20 PC

CABLE BNCM TO BNCM, MIN RG-59 COAX, 30FT

PDM Analog Output Cables

2062755-001 CABLE, PDM TO ANOUT BOX, 15FT 

2062755-002 CABLE, PDM TO ANOUT BOX, 50FT

2062755-003 CABLE, PDM TO ANOUT BOX, 75FT

2062755-004 CABLE, PDM TO ANOUT BOX, 100FT

Part Number Description

2018216-001 KIT, CARTO XP System CABLES

2015944-001 AMPLIFIER TO PIU QUICK CONNECT 10 FT

2018217-001 CABLE RJ45 CROSSOVER CAT5 25FT

2024507-001 IC TO PIU QUICK CONNECT 10FT
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Parts List
Speakers

CO2

Part Number Description

2017900-001 KIT, AUDIO CABLING ACCESSORIES

2011108-002 CABLE AUDIO 50 FT.

2018218-001 STEREO AUDIO SPLITTER 1M-2F

2018219-001 MONO AUDIO ISOLATOR

2018856-001 AUDIBLE INDICATORS 120V

2078970-001 POWERED SPEAKERS, 120V

2003625-001 CABLE, NEMA 5-15R TO IEC320P, 1FT

2018857-001 AUDIBLE INDICATORS 240V

2078970-001 POWERED SPEAKERS, 240V (replaces 2039004-001, 2036113-002, 2029281-002, 2049499-002 and 2026555-
002)

2003625-001 CABLE, NEMA 5-15R TO IEC320P, 1FT

Part Number Description

412340-002 SNSR CBL CO2 CAPNOSTAT 3 W/AGND

412554-003 LABEL MODULE CO2 CAPNOSTAT

412832-001 ASSEMBLY MODULE CO2 CAPNOSTAT

2032243-011

900553-001

2013427-001

2027759-001

412340-002

9504-016

ASSY SOLAR CAPNO MDL ADPTR CO2 MDL SNSR

ASSY MOD MS C02 CAPNOSTAT

OEM ASSY DASH CAPNOFLEX LF CO2

ASSY SOLAR CAPNOFLEX ADAPTER

SNSR CBL CO2 CAPNOSTAT 3 W/AGND

GAS SCAVENGER 10FT TGB W/CPLG 
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Parts List
Desks

International Power Cords

The following power cords can be used with the CardioLab II Plus Amplifier, Integrated Electronics 
Box (IEB), PDM Base Station and isolation transformer for the specified countries.

Part Number Description

2008203-001 MOBILE WORKSTAND CART

2018892-006 65 IN WORKSTATION DESK

2018892-005 47 IN WORKSTATION DESK

2018892-004 MOBILE CABINET

Part Number Description

401855-110 PWR SPLY CRD ST AUSTRALIAN 10A 250V 2.5M - AUSTRALIA and NEW ZEALAND

401855-101 WR SPLY CRD ST CONT EURO 10A 250V 2.5M - AUSTRIA, BELGIUM, FINLAND, FRANCE, GERMANY, GREECE, 
HUNGARY, LUXEMBOURG, NETHERLAND, POLAND, PORTUGAL, SPAIN, SWEDEN, NORWAY, TURKEY, RUSSIA, 
SLOVAKIA, CZECH REPUBLIC, ALBANIA, BULGARIA

401855-102 PWR SPLY CRD ST BRITISH 10A 250V 2.5M FSD - UNITED KINGDOM and IRELAND

401855-104 PWR SPLY CRD ST ISRAELI 10A 250V 2.5M

401855-103 PWR SPLY CRD ST ITALIAN 10A 250V 2.5M

401855-039 PWR SPLY CRD ST ARGENTINA 10A 250V 2.5M

401855-041 PWR SPLY CRD ST BRAZIL 10A 250V 2.5M

405535-101 PWR SPLY CRD ST HOSP GRD 15A 125V 2.5M - CANADA

401855-018 PWR CRD ST CHINA RA PLUG 10A 250V 2.5M

401855-109 PWR SPLY CRD ST DANISH 10A 250V 2.5M - DENMARK

401855-108 PWR SPLY CRD ST INDIA 10A 250V 2.5M

401855-037 PWR SPLY CRD ST S.AFRICA 10A 250V 2.5M

401855-107 PWR SPLY CRD ST SWISS 10A 250V 2.5M - SWITZERLAND

80274-006
405535-013 
(Japan)

CORD PWR 125V 6FT STR 
PWR SPLY CRD ST-ST PSE 10A 125V 6.25FT 

405535-102 PWR SPLY CRD ST PSE 15A 125V 2.5M – JAPAN

405535-005 PWR SPLY CRD ST HOSP GRD 10A 125V 6.25FT

401855-045 PWR SPLY CRD ST SOUTH KOREA 10A 250V 2.5

401855-046 PWR SPLY CRD ST SINGAPORE 10A 250V 2.5

401855-047 PWR SPLY CRD ST THAILAND 10A 250V 2.5
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Parts List
401855-048 PWR SPLY CRD ST TAIWAN 10A 125V 2.5

401855-049 PWR SPLY CRD ST TAIWAN 16A 125V 2.5

Part Number Description
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Parts List
Monitors and Printers

Part Number Description

2079070-002 MONITOR, EIZO S2133, LED 21 INCH, BOOM MOUNTABLE

2081124-001 MOUNTING KIT, MONITOR ON MAVIG GD60 SUSPENSION

2003442-003
2003442-001

CABLE VIDEO, DB15MHD-DB15MHD; 100FT - RoHS
CABLE VIDEO, DB15MHD-DB15MHD; 100FT - Non-RoHS

403689-010 CABLE ASSY, MON PWR, 100 FT

2004036-001 POWER CABLE

2031697-001 CABLE EPP DB25M/MDR36M 10 FT

2025965-002 CABLE USB 3.0M

9242-101 PAPER 20LB BOND WHITE 8 1/2x11

2046141-001 PRINTER LASER COLOR HP CP2025N 120V (replaces 2030606-001 RICOH CL3500N)

2046141-002 PRINTER LASER COLOR HP CP2025N 220V (replaces 2030606-002 RICOH CL3500N 220V)

2046677-002 PRINTER LASER HP P2035 220V

2068944-001 PRINTER HP LASERJET M401N 120V

2068944-002 PRINTER HP LASERJET M401N 220V

2068945-001 PRINTER HP LASERJET M451NW COLOR 120V

2068945-002 PRINTER HP LASERJET M451NW COLOR 220V
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Abbreviations
Electrical and Product Abbreviations

Abbreviation Description

AC Alternating Current

AE Application Entity

CNDT Conduit

CPU Central Processing Unit

CVIS Cardiovascular Information System

DC Direct Current

DICOM Digital Imaging and Communication in Medicine

DMS Data Management System

dV/dT Change in Voltage over Time

EMC Electromagnetic Compatibility

EMI Electromagnetic Interference

ESD Electrostatic Discharge

GB Gigabytes

Hz Hertz

IEB Integrated Electronics Box

IEC International Electrotechnical Commission

IMG Image

INW Invasive Network

kB Kilobytes

kV Kilovolts

LCD Liquid Crystal Display

LED Light Emitting Diode

LMT Lab Management Tools

MB Megabytes

MHz Mega Hertz

MWL Modality Work List

MPPS Modality Performed Procedure Step

ms Milliseconds

mV Millivolts

OS Operating System

OU Organizational Unit

PDM Patient Data Module
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Abbreviations
RF Radio frequency

RMOT Remote Operators Terminal

TRAM Transport Remote Acquisition Monitor

UI User Interface

UPS Uninterruptible Power Supply

V Volts

VPN Virtual Private Network

Abbreviation Description
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Abbreviations
Miscellaneous Abbreviations

Abbreviation Description

C Centigrade

cm Centimeters

cm2 Centimeters squared

CO Cardiac Output

CO2 Carbon Dioxide

F Fahrenheit

gm/dl Grams per deciliter

Grad Gradient

Ht Height

HH:MM:SS Hours:Minutes:Seconds

ID Identity

Info Information

kgs Kilograms

kPa Kilopascal

kT Boltzmann's Constant * temperature. This is used as part of the formula for 
calculating oxygen consumption (VO2). 

lbs Pounds

l/min Liters per minute

l/min/m2 Liters per minute per meter squared

mcg Micrograms

ml/dl Milliliters per deciliter

ml/min Milliliters/minute

ml/s Milliliters per second

mmHg Millimeters of mercury

mm/sec Millimeters per second

RAID Redundant Array of Independent Disks 

µA Microamperes

UL Underwriter's Laboratory
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Technical Specifications
Electrical Power

Fuse ratings:

 CardioLab II Plus Amplifier: T3AL, 250V

 PDM Base Station: T1AL, 250V

WARNING: ELECTRICAL HAZARD

Power equipment only as specified. Do not connect equipment to extension 
cords or multiple socket outlets.

CAUTION: SYSTEM FAILURE

To ensure an adequate system power supply, GE Healthcare recommends 
using a dedicated circuit to power the IEB.

Component Voltage (V)
Frequency 

(Hz)
Current (A)

Power Cord 
Length (Ft))

IEB* 100/120/230 50/60 15/15/7 8

CardioLab II Plus Amplifier – 32 and 64 
channel

100 – 240 50/60 0.5 – 0.25 6

CardioLab II Plus Amplifier – 96 and 128 
channel

100 – 240 50/60 0.75 – 0.38 6

PDM Base Station 100 – 240 50/60 0.5 – 0.3 6

TRAM-RAC 100 – 240 50/60 1 – 0.5 10

Isolation Transformer 115/230 50/60 5.3/2.7 6

Centricity Cardiology INW Server (G8) 100 – 240 50/60 7.1 – 3.5 6

* Power cord for US/Canada is NEMA 5-20P which requires 20A service
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Technical Specifications
Atmospheric Conditions

Intracardiac ECG

Input Specifications:
 Gain accuracy: +/- 10%

 Time base accuracy: +/- 10%

Physical Dimensions

Review this table to ensure the system purchased will fit in the intended location.

Temperature Relative Humidity Pressure Maximum Altitude

Operating  15°C – 30°C

59°F – 86°F

 30% to 70% 700 hPA to 1060 hPA 3000 m

9843 ft

Non-Operating -10°C – 50°C

14°F – 122°F

10% to 85% 700 hPA to 1060 hPA 
N/A

Component Width (in/cm) Depth (in/cm) Height (in/cm) Weight (lb/kg)

Workstation Desk – 47" 47/119 30/76 29.5/74.9 265/120

Workstation Desk – 65" 65/165 30/76 29.5/74.9 340/154

Mobile Workstand 32/81.2 27/68.5 62/157.5 80/36.3

Accessory Cart – 27" 27/68.5 28/71 30/76.2 300/136

Computer – HP Z600 6.5/16.5 17.5/44.5 17.3/44 37/17

Review Workstation 6/15.2 16/40.6 14/35.5 20/9.1

IEB 11/28 21/53 24.5/62 75/34

Isolation Transformer 10.5/26.7 6.5/16.5 3.5/8.89 13/6

NEC 20" LCD Monitor 17.7/45 9/22.8 17.2/43.68 22/10

EIZO 21” Monitor (with stand) 18.3/46.5 8/20.3 17.8 - 21.1 / 
45.3 - 53.5

18.8/8.5

HP Laser Jet Printer 16/40.6 17.9/45.5 12.7/32.3 50/22.67

PDM BASE STATION 11.3/28.6 13.0/33.1 3.3/8.4 5.5/2.5

PDM 5.75/14.77 10.1/25.7 3.1/7.9 2.4/1.1

TRAM-RAC 5.7/14.5 15.1/38.4 9.0/22.9 7.9/3.5

CardioLab II Plus Amplifier - 32/64 Channels 14/36 14/36 9.5/24 22/10
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Technical Specifications
CardioLab II Plus Amplifier - 96/128 Channels 14/36 14/36 14/36 25/11

Centricity Cardiology INW Server (G8) 19.0/48.26 28.83/73.22 8.58/21.8 67/30.4

Vivid GE Ultrasound System 14.2/36.07 12.4/31.5 2.3/5.9 11/5

HP M401 B/W Laserjet Printer 14.4/36.5 14.5/36.8 10.6/26.8 22.2/10.1

HP M451 Color Laserjet Printer 15.9/40.5 17.9/45.4 12.7/32.2 50.1/22.8

Component Width (in/cm) Depth (in/cm) Height (in/cm) Weight (lb/kg)
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Technical Specifications
Validated Third Party Software

The following third party software has been validated for use with the Mac-Lab/CardioLab system:

 MS Office 2007

 Adobe Reader X

 Operating System Updates: refer to the GE Security website: 
http://www.gehealthcare.com/usen/security/

 Anti-virus software: refer to the Mac-Lab/CardioLab Security Guide (PN 2063076-004)

 Enterprise backup software: refer to the Centricity Cardiology INW Operator’s Manual (PN 
2063076-003 non-US or PN 2063076-303 US-only)

 PedCath: refer to the Mac-Lab/CardioLab Security Guide (PN 2063076-004)

 Centricity Cardiology Workflow (CCW) v5

 Centricity Cardiology DMS: 4.1 and 4.2

 Centricity Carddas: 2.02, 2.03, 2.04, 2.12, 2.13, 2.2, 2.3, 2.5, 3.1, 3.5

 CA 1000 2.0

WARNING: SYSTEM INSTABILITY

Do not install or use unvalidated anti-virus software (including unvalidated 
versions). Doing so may result in system instability or failure. Use only 
validated anti-virus software in the appropriate language version.

Refer to the Mac-Lab/CardioLab Security Guide (PN 2063076-004) for the GE Healthcare policy 
on non-validated software applications.
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Electromagnetic Compatibility (EMC)
Introduction

Changes or modifications to this system not expressly approved by GE Healthcare can cause 
EMC issues with this or other equipment. This system is designed and tested to comply with 
applicable regulation regarding EMC and must be installed and put into service according to the 
EMC information stated in this document.

WARNING: EQUIPMENT FAILURE

The equipment or system should not be used adjacent to, or stacked with, 
other equipment. If adjacent or stacked use is necessary, the equipment or 
system must be tested to verify normal operation in the configuration in which 
it is being used. 

WARNING: The use of unspecified accessories, transducers and cables may result in 
increased emissions or decreased immunity of the system.

Electromagnetic Immunity Pass/Fail Criteria

During system immunity testing, temporary degradation of data display was allowed, as long as 
data integrity was restored with a system reboot after removal of the electromagnetic interference 
source.

Guidance and Manufacturer’s Declaration - 
Electromagnetic Emissions

Declaration - Electromagnetic Emissions

The Mac-Lab / CardioLab System is intended for use in the electromagnetic environment specified below. The customer or the user of the 
Mac-Lab / CardioLab System should assure that it is used in such an environment.

Emissions Tests Compliance Electromagnetic environment guidance

RF emissions CISPR 11 Group 1 The Mac-Lab / CardioLab System uses RF 
energy only for its internal function. Therefore, 
its RF emissions are very low and are not likely 
to cause any interference in nearby electronic 
equipment.

RF emissions CISPR 11 Class A The Mac-Lab / CardioLab System is suitable for 
use in all establishments other than domestic 
and those directly connected to the public low-
voltage power supply network that supplies 
buildings used for domestic purposes.

Harmonic emissions IEC 61000-3-2 Class A

Voltage fluctuations/Flicker emissions IEC 61000-3-3 Complies
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Electromagnetic Compatibility (EMC)
Guidance and Manufacturer’s Declaration - 
Electromagnetic Immunity

Declaration - Electromagnetic Immunity

The Mac-Lab / CardioLab System is intended for use in the electromagnetic environment specified below. The customer or the 
user of the Mac-Lab / CardioLab System should assure that it is used in such an environment.

Immunity Test
IEC 60601 
Test Level

Compliance 
Level

Electromagnetic Environment - Guidance

Electrostatic 
discharge (ESD) 
IEC 61000-4-2

± 6 kV contact 
± 8 kV air

± 6 kV contact 
± 8 kV air

Floors should be wood, concrete or ceramic tile. If floors are covered with 
synthetic material, the relative humidity should be at least 30%.

Electrical fast 
transient/burst 
IEC 61000-4-4

± 2kV for power 
supply lines, 
± -1kV for I/O 
cables

± 2kV for power 
supply lines, ± -
1kV for I/O cables

Mains power quality should be that of a typical commercial or hospital 
environment.

Surge 
IEC 61000-4-5

± 1kV differential 
mode ± 2kV 
common mode

± 1kV differential 
mode ± 2kV 
common mode

Mains power quality should be that of a typical commercial or hospital 
environment.

Voltage dips, 
short 
interruptions and 
voltage variations 
on power supply 
input lines IEC 
61000-4-11

<5% 100-120Vac
<5% 200-240Vac
(>95% dip) for 0.5 
cycle

40% 100-120Vac
40% 200-240Vac
(>60% dip) for 5 
cycles 

70% 100-120Vac
70% 200-240Vac
(>30% dip) for 25 
cycles

<5% 100-120Vac
<5% 200-240Vac
(>95% dip) for 5 
seconds

<5% 100-120Vac
<5% 200-240Vac
(>95% dip) for 0.5 
cycle

40% 100-120Vac
40% 200-240Vac
(>60% dip) for 5 
cycles

70% 100-120Vac
70% 200-240Vac
(>30% dip) for 25 
cycles

<5% 100-120Vac
<5% 200-240Vac
(>95% dip) for 5 
seconds

Mains power quality should be that of a typical commercial or hospital 
environment. If the user of the Mac-Lab / CardioLab System requires 
continued operation during power mains interruptions, it is recommended 
that the Mac-Lab / CardioLab System be powered from an Uninterruptible 
power supply or a battery.

Power frequency 
(50/60 Hz) 
magnetic field 
IEC 61000-4-8

3 A/m 3 A/m Power frequency magnetic fields should be at levels characteristic of a 
typical location typical commercial or hospital environment.
2063076-010H EN Mac-Lab/CardioLab/Centricity Cardiology INW Service Manual C-3



Electromagnetic Compatibility (EMC)
Portable and mobile RF communications equipment should be used no 
closer to any part of the Mac-Lab / CardioLab System, including cables, 
than the recommended separation distance calculated from the equation 
applicable to the frequency of the transmitter.

Recommended separation distance (d) 

Conducted RF
IEC 61000-4-6

3 Vrms
150KHz to 80 
MHz with 2 Hz 
modulation

3 Vrms
 

Radiated RF
IEC 61000-4-3

3V/m 
80 MHz to 
2.5 GHz

3 V/m

where P is the maximum output power rating of the transmitter in watts (W) 
according to the transmitter manufacturer and d is the recommended 
separation distance in meters (m). Field Strengths from fixed RF 

transmitters, as determined by a electromagnetic site survey1, should be 

less than the compliance level in each frequency range2. Interference may 
occur in the vicinity of equipment marked with the following symbol:

NOTE: At 80 MHz and 800 MHz, the higher frequency range applies.

These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and reflected from 
structures, objects and people.

1 Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land mobile radios, amateur radio, AM 
and FM radio broadcast and TV broadcast cannot be predicted theoretically with accuracy. To assess the electromagnetic environment due to 
fixed RF transmitters, an electromagnetic site survey should be considered. If the measured field strength in the location in which the Mac-Lab 
/ CardioLab System is used exceeds the applicable RF compliance level above the Mac-Lab / CardioLab System should be observed to verify 
normal operation. If abnormal performance is observed, additional measures may be necessary, such as re-orienting or relocating the Mac-Lab 
/ CardioLab System.

2 Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m

Declaration - Electromagnetic Immunity

The Mac-Lab / CardioLab System is intended for use in the electromagnetic environment specified below. The customer or the 
user of the Mac-Lab / CardioLab System should assure that it is used in such an environment.

Immunity Test
IEC 60601 
Test Level

Compliance 
Level

Electromagnetic Environment - Guidance

d 1.2 P=

d 1.2 P=

d 1.2 P=
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Electromagnetic Compatibility (EMC)
Recommended Separation Distances

Recommended Separation Distances Between 
Portable and Mobile RF Communications Equipment and the Mac-Lab/CardioLab system

The Mac-Lab/CardioLab system is intended for use in an electromagnetic environment in which radiated RF disturbances are 
controlled. The customer or the user of the Mac-Lab/CardioLab system can help prevent electromagnetic interference by 
maintaining a minimum distance between portable and mobile RF communications equipment (transmitters) and the Mac-Lab/
CardioLab system as recommended below, according to the maximum output power of the communications equipment.

Rated Maximum Output 
Power of Transmitter

W

Separation Distance According to Frequency of Transmitter 
m

150 kHz to 80 MHz 80 MHz to 800 MHz 800 MHz to 2.5 GHz

0.01 0.12 0.12 0.23

0.1 0.38 0.38 0.73

1 1.2 1.2 2.3

10 3.8 3.8 7.3

100 12 12 23

For transmitters rated at a maximum output power not listed above, the recommended separation distance d in meters (m) can be 
estimated using the equation applicable to the frequency of the transmitter, where P is the maximum output power rating of the 
transmitter in watts (W) according to the transmitter manufacturer.

NOTE: At 80 MHz and 800 MHz, separation distance for the higher frequency range applies.

These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and reflected from 
structures, objects and people.

d 1.2 P= d 1.2 P= d 2.3 P=
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Maintenance Record of Results
Introduction

This appendix lists the maintenance records for the Mac-Lab/CardioLab/Centricity cardiology INW 
system.
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Maintenance Record of Results
IEB Maintenance Record of Results

Maintenance Record

Record the IEB Maintenance Record results in the following table:

Equipment Table and Tester Information

Record the following IEB Equipment and Tester Information used during the planned maintenance 
procedure:

Tester Information:

Signature: _____________________________________________________

Print Name (Name, Initials): _______________________________________

IEB S/N:

Section Date Performed
Pass/
Fail

Performed By Recorded Results

Cleaning and Inspection

Exterior Cleaning

Visual Inspection

Functional Test

#11 Image Fills the Screen and the Colors are 
Correct

#12 Pressure Waveforms Present

#17 ECG Waveforms Present

#17 Intracardiac Waveforms Present

#20 Review Window is visible in the Remote Monitor

#24 Real-Time Window is visible in the Remote 
Monitor

Equipment Manufacturer Model Equipment ID - SN Calibration Due Date
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Maintenance Record of Results
Computer Maintenance Record of Results

Maintenance Record

Record the Computer Maintenance Record results in the following table:

Equipment Table and Tester Information

Record the following Computer Equipment and Tester Information used during the planned 
maintenance procedure:

Tester Information:

Signature: _____________________________________________________

Print Name (Name, Initials): _______________________________________

Computer S/N:

Computer MODEL:

Section Date Performed
Pass/
Fail

Performed By Recorded Results

Cleaning and Inspection

Exterior Cleaning

Visual Inspection

Functional Test

Boot Test

#3 Boot Operation - No Errors

#4 Fan Operation - No Errors

#5 Computer Display - No Errors

#6 Keyboard Function - No Errors

Equipment Manufacturer Model Equipment ID - SN Calibration Due Date
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Maintenance Record of Results
Server Maintenance Record of Results

Maintenance Record

Record the Server Maintenance Record results in the following table:

Equipment Table and Tester Information

Record the following Server Equipment and Tester Information used during the planned 
maintenance procedure:

Tester Information:

Signature: _____________________________________________________

Print Name (Name, Initials): _______________________________________

Server S/N:

Server MODEL:

Section Date Performed
Pass/
Fail

Performed By Recorded Results

Cleaning and Inspection

Exterior Cleaning

Visual Inspection

Diagnostic Test

ML370 (G5) ProLiant Server

#6 All Tests Passed

DL370 (G6) ProLiant Server

#3 No Errors Listed in the Array Diagnostic Report

ML350 (G8) ProLiant Server

#3 No Errors Listed in the Array Diagnostic Report

Equipment Manufacturer Model Equipment ID - SN Calibration Due Date
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Maintenance Record of Results
Vivid External Trackball Maintenance Record

Maintenance Record

Record the Vivid External Trackball Maintenance Record results in the following table:

Equipment Table and Tester Information

Record the following Vivid External Trackball Equipment and Tester Information used during the 
planned maintenance procedure:

Tester Information:

Signature: _____________________________________________________

Print Name (Name, Initials): _______________________________________

Vivid External Trackball S/N:

Section Date Performed
Pass/
Fail

Performed By Recorded Results

Cleaning and Inspection

Exterior Cleaning

Visual Inspection

Functional Test

Performance Check

#3 Buttons and TGC Sliders Move Freely

#6 Mouse Pointer Moves Smoothly

#7 Buttons Activate Properly

#9 Value for Sliders is 0 (+/-2)

#11 Value for Sliders is 63 (+/-2)

#13 Value for Sliders is 31 (+/-2)

#15 Rotary Works Properly

#16 The Button Backlights are Illuminated

Equipment Manufacturer Model Equipment ID - SN Calibration Due Date
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Maintenance Record of Results
HP Color LaserJet CP2025n Printer Maintenance 
Record of Results

Maintenance Record

Record the HP Color LaserJet CP2025n Printer Maintenance Record results in the following table:

Equipment Table and Tester Information

Record the following HP Color LaserJet CP2025n Printer Equipment and Tester Information used 
during the planned maintenance procedure:

Tester Information:

Signature: _____________________________________________________

Print Name (Name, Initials): _______________________________________

HP Color LaserJet CP2025n Printer S/N:

Section Date Performed
Pass/
Fail

Performed By Recorded Results

Cleaning and Inspection

Exterior Cleaning

Visual Inspection

Cleaning - Using Clean Mode

#6 Clean Printer Using Clean Mode - Produces No 
Errors

Cartridge Replacement

Ink Cartridges Replaced

Equipment Manufacturer Model Equipment ID - SN Calibration Due Date
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Maintenance Record of Results
HP Color LaserJet M451 Printer Maintenance Record 
of Results

Maintenance Record

Record the HP Color LaserJet M541 Printer Maintenance Record results in the following table:

Equipment Table and Tester Information

Record the following HP Color LaserJet M451 Printer Equipment and Tester Information used 
during the planned maintenance procedure:

Tester Information:

Signature: _____________________________________________________

Print Name (Name, Initials): _______________________________________

HP Color LaserJet M451 Printer S/N:

Section Date Performed
Pass/
Fail

Performed By Recorded Results

Cleaning and Inspection

Exterior Cleaning

Visual Inspection

Cleaning - Using Clean Mode

#6 Clean Printer Using Clean Mode - Produces No 
Errors

Cartridge Replacement

Ink Cartridges Replaced

Equipment Manufacturer Model Equipment ID - SN Calibration Due Date
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Maintenance Record of Results
HP LaserJet P2035n Printer Maintenance Record of 
Results

Maintenance Record

Record the HP LaserJet P2035n Printer Maintenance Record results in the following table:

Equipment Table and Tester Information

Record the following HP LaserJet P2035n Printer Equipment and Tester Information used during 
the planned maintenance procedure:

Tester Information:

Signature: _____________________________________________________

Print Name (Name, Initials): _______________________________________

HP LaserJet P2035n Printer S/N:

Section Date Performed
Pass/
Fail

Performed By Recorded Results

Cleaning and Inspection

Exterior Cleaning

Visual Inspection

Clean Print-Cartridge Area

Clean Paper Path Area

Cartridge Replacement

Ink Cartridges Replaced
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Maintenance Record of Results
HP LaserJet M401 Printer Maintenance Record of 
Results

Maintenance Record

Record the HP LaserJet M401 Printer Maintenance Record results in the following table:

Equipment Table and Tester Information

Record the following HP LaserJet M401 Printer Equipment and Tester Information used during the 
planned maintenance procedure:

Tester Information:

Signature: _____________________________________________________

Print Name (Name, Initials): _______________________________________

HP LaserJet M401 Printer S/N:

Section Date Performed
Pass/
Fail

Performed By Recorded Results

Cleaning and Inspection

Exterior Cleaning

Visual Inspection

Print Cleaning Page

Cartridge Replacement

Ink Cartridges Replaced

Equipment Manufacturer Model Equipment ID - SN Calibration Due Date
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Maintenance Record of Results
Uninterruptible Power Supply (UPS) Maintenance 
Record of Results

Maintenance Record

Record the Uninterruptible Power Supply (UPS) maintenance results in the following table:

Equipment Table and Tester Information

Record the following Uninterruptible Power Supply Equipment and Tester Information used during 
the planned maintenance procedure:

Tester Information:

Signature: _____________________________________________________

Print Name (Name, Initials): _______________________________________

Uninterruptible Power Supply (UPS) S/N:

Uninterruptible Power Supply (UPS) MODEL:

Section Date Performed
Pass/
Fail

Performed By Recorded Results

Cleaning and Inspection

Exterior Cleaning

Visual Inspection

Functional Test

UPS Functional Test

#3 Green LED Turns On

#5 Voltage > 20V

#7 All Systems Turn On and Boot Properly

Battery Test

#4 Acquisition is Powered for 10 Seconds Under 
Battery Power
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Maintenance Record of Results
PDM and PDM Base Station Maintenance Record of 
Results

Maintenance Record – PDM

Record the PDM maintenance results in the following table:

Maintenance Record – PDM Base Station

Record the PDM Base Station maintenance results in the following table:

Equipment Table and Tester Information

Record the following Uninterruptible Power Supply Equipment and Tester Information used during 
the planned maintenance procedure:

Tester Information:

Signature: _____________________________________________________

Print Name (Name, Initials): _______________________________________

PDM S/N:

PDM MODEL:

Section Date Performed
Pass/
Fail

Performed By Recorded Results

Cleaning and Inspection

Exterior Cleaning

Visual Inspection

PDM Base Station S/N:

PDM Base Station MODEL:

Section Date Performed
Pass/
Fail

Performed By Recorded Results

Cleaning and Inspection

Exterior Cleaning

Visual Inspection

Equipment Manufacturer Model Equipment ID - SN Calibration Due Date
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Maintenance Record of Results
Mobile Workstand Maintenance Record of Results

Maintenance Record

Record the IEB Maintenance Record results in the following table:

Equipment Table and Tester Information

Record the following IEB Equipment and Tester Information used during the planned maintenance 
procedure:

Tester Information:

Signature: _____________________________________________________

Print Name (Name, Initials): _______________________________________

IEB S/N:

Section Date Performed
Pass/
Fail

Performed By Recorded Results

Cleaning and Inspection

Exterior Cleaning

Visual Inspection

Functional Test

#1 Adjust tilt and tension

#2 Adjust swivel or pivot tension

Equipment Manufacturer Model Equipment ID - SN Calibration Due Date
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Maintenance Record of Results
Electrical Safety Test Results Record

Record the results of the Electrical Safety Test Procedures in the following tables. Print as many as 
necessary to record all system test information. Refer to the TRAM service manual for TRAM 
record sheets.

 

System: __________________________________________

Tester name: ________________________________ Date: _____________________

Reason for test:________________________________________________________________________________________________

Serial numbers IEB Computer Amplifier

Test Equipment information:

Additional Information:

System Visual Inspection results:

Device Under Test (IEB, amp, etc.): ______________________________________________________

Protective Earthing

Measured Resistance: _____________________________ Pass/Fail: 

Earth Leakage

Measured Current (step 5): _____________________________ Pass/Fail: 

Measured Current (step 7): _____________________________ Pass/Fail: 
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Maintenance Record of Results
Enclosure Leakage

Measuring end point: ___________________________________

Measured Current (step 6): _____________________________ Pass/Fail: 

Measured Current (step 8): _____________________________ Pass/Fail: 

Measured Current (step 10): _____________________________ Pass/Fail: 

Measured Current (step 12): _____________________________ Pass/Fail: 

Measuring end point: ___________________________________

Measured Current (step 6): _____________________________ Pass/Fail: 

Measured Current (step 8): _____________________________ Pass/Fail: 

Measured Current (step 10): _____________________________ Pass/Fail: 

Measured Current (step 12): _____________________________ Pass/Fail: 

Measuring end point: ___________________________________

Measured Current (step 6): _____________________________ Pass/Fail: 

Measured Current (step 8): _____________________________ Pass/Fail: 

Measured Current (step 10): _____________________________ Pass/Fail: 

Measured Current (step 12): _____________________________ Pass/Fail: 
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Maintenance Record of Results
Patient (Source) Leakage Current

Measured Current (step 6): _____________________________ Pass/Fail: 

Measured Current (step 8): _____________________________ Pass/Fail: 

Measured Current (step 10): _____________________________ Pass/Fail: 

Measured Current (step 12): _____________________________ Pass/Fail: 

Patient (Sink) Leakage Current

Measured Current (step 7): _____________________________ Pass/Fail: 

Measured Current (step 9): _____________________________ Pass/Fail: 
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PDM Battery and Accessories
PDM Battery

Battery Overview

The Patient Data Module (PDM) uses one rechargeable lithium-ion battery (PN 2016989-002) that 
supplies power when used with a transport monitor or whenever AC power is interrupted.

WARNING: EXPLOSION OR FIRE

Using non-recommended batteries could result in injury/burns to the patients 
or users.

Only use batteries recommended or manufactured by GE. The warranty can be 
voided if non-recommended batteries are used.

Storage Recommendations

Store the battery outside of the device at a temperature between 20 C and 25 C (68 F to 77 F). 
Storing the battery inside the PDM is not recommended.

Battery Maintenance

Charging the Battery

Charge the PDM battery by inserting it into the PDM and connecting the PDM to an AC-powered 
host.

Waking Up the Battery

When the battery is stored for a long period of time without being charged, it eventually loses all of 
its charge and falls asleep. When the battery is asleep, none of the LEDs on the battery will 
illuminate when the battery's test button is pressed. You must wake up the battery before you can 
use it again.

1. Connect the PDM with its battery installed to a patient monitor connected to an AC-derived 
power source. The patient monitor sends a trickle charge to the PDM battery until the battery 
has enough of a charge to “wake up.”

2. Wait for the PDM to boot-up.

Testing the Battery

1. Press the TEST button on the PDM battery to check the approximate percentage of charge 
remaining in the battery.
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PDM Battery and Accessories
2. Observe how many LEDs are illuminated, noting the following:

 4 LEDs illuminated = 75% – 100% of full charge capacity remaining

 3 LEDs illuminated = 50% – 74.9% of full charge capacity remaining

 2 LEDs illuminated = 25% – 49.9% of full charge capacity remaining

 1 LED illuminated = 10% – 24.9% of full charge capacity remaining

 1 LED flashing = < 10% of full charge capacity remaining

Replacing the Battery

Safety

WARNING: EXPLOSION OR FIRE

Using non-recommended batteries could result in injury/burns to the patients 
or users.

Only use batteries recommended or manufactured by GE. The warranty can be 
voided if non-recommended batteries are used.

Replace the Battery

1. Open the battery door by gently pulling on the battery door pull tab.
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PDM Battery and Accessories
2. Pull the battery tray out of the PDM using the battery tray strap and remove the battery from 
the battery tray.

3. Insert the new battery with the test button facing up and the arrow pointing into the PDM.

4. Press the battery door closed until it seals the battery compartment.

5. Press the Power button on the PDM.

6. Verify that the power indicator illuminates amber while the PDM boots up, then illuminates 
green.

Recycling the Battery

When the battery no longer holds a charge, it should be replaced. Remove the old battery and 
follow your local recycling guidelines.

WARNING: EXPLOSION HAZARD

Do not incinerate the battery or store at high temperatures. Serious injury or 
death could result.
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PDM Battery and Accessories
Rechargeable Battery Collection Sites

In the United States and Canada, the Rechargeable Battery Recycling Corporation (RBRC) can 
help you locate your nearest rechargeable battery collection site. You can contact RBRC by 
telephone or by accessing their Internet website.

 Telephone: 1-800-8-BATTERY (800-822-88379) 

 Internet address: www.rbrc.org
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PDM Battery and Accessories
PDM Cables and Accessories

The following table lists PDM cables and accessories.

WARNING: SHOCK HAZARD

Defibrillator protection is only guaranteed when approved accessories are 
used. Do not use unspecified accessories.

Category Description Maximum Lengths

ECG Cables

Care cable, ECG 3-lead Multi-Link w/grabber 3.6 m / 12 ft

Care cable, ECG 3/5-lead Multi-Link 3.6 m / 12 ft

Care cable, ECG 3-lead Multi-Link din, neonatal 3.6 m / 12 ft

Care cable, ECG 6-lead Multi-Link 3.6 m / 12 ft

Care cable, ECG 12-lead Multi-Link 3.6 m / 12 ft

Care cable, ECG 3/5-lead ESU Multi-Link 3.6 m / 12 ft

ECG Multi-link Lead wires

Lead wire set, 5-lead, Multi-Link-group, grabber 130 cm / 51 in

Lead wire set, 3-lead, Multi-Link-group, grabber 130 cm / 51 in

Lead wire set, 5-lead, Multi-Link, grabber 130 cm / 51 in

Lead wire set, 5-lead, Multi-Link, grabber V2-V6 130 cm / 51 in

Lead wire set, 5-lead, Multi-Link, grabber C2-C6 130 cm / 51 in

Lead wire set, Multi-Link individual grabber 130 cm / 51 in

Lead wire set, Multi-Link individual snap 130 cm / 51 in

Lead wire set, 5-lead, Multi-Link, snap 130 cm / 51 in

Lead wire set, 5-lead, Multi-Link-group, snap 130 cm / 51 in

Lead wire set, 3-lead, Multi-Link-group, snap 130 cm / 51 in

Lead wire set, Multi-Link, neonatal, mini-clip/DIN 61 cm / 24 in

Lead wire set, 6-lead, Multi-Link, snap 130 cm / 51 in

Lead wire set, 6-lead, Multi-Link, grabber 130 cm / 51 in

ECG Accessories

Multi-Link 5-Lead DIN Converter N/A

Multi-Link 3-Lead DIN Converter N/A
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PDM Battery and Accessories
Invasive BP Cables and Transducers

Reusable transducer, SP844 (includes both cable and sensor) N/A

Disposable BP Transducers for B Braun N/A

BD-Spectramed Single InvBP Transducer Adapter Cable 3.6 m / 12 ft

BD-Spectramed Dual InvBP Transducer Adapter Cable, 3.6 m / 12 ft

Utah Single InvBP Transducer Adapter Cable 3.6 m / 12 ft

Utah Dual InvBP Transducer Adapter Cable 3.6 m / 12 ft

Abbott-Hospira Single InvBP Transducer Adapter Cable, 1.2 m/4 ft. (for 
Transpac III/IV)

3.6 m / 12 ft

Abbott-Hospira Dual InvBP Transducer Adapter Cable, 1.2 m/4 ft. (for 
Transpac III/IV)

3.6 m / 12 ft

Cable, dual IBP adapter 30 cm / 12 in

Edwards Lifesciences Single InvBP Transducer Adapter Cable, 1.2 m/4 ft. (for 
TruWave)

3.6 m / 12 ft

Edwards Lifesciences Dual InvBP Transducer Adapter Cable, 1.2 m/4 ft. (for 
TruWave)

3.6 m / 12 ft

Dual IBP Adapter Cable 30 cm / 12 in

Cardiac Output Cables and Probes

Injectate bath probe 1.8 m / 6 ft

Edwards CO Set In-line injectate probe 0.9 m / 3 ft

BD-Spectramed CritiKit In-line injectate probe 0.9 m / 3 ft

Abbott Thermoset In-line injectate probe 2.4 m /8 ft

Cardiac Output Cable 3.6 m / 12 ft

Temperature Cables and Probes

Esophageal stethoscope with temp probe N/A

Foley catheter with temperature probe N/A

General purpose temperature probe N/A

Skin temperature probe N/A

Tympanic temp probe, with foam N/A

Tympanic temp probe, without foam N/A

General purpose probe, 400 Series, pediatric.

Application: esophagus, rectum
N/A

General purpose probe, 400 Series, adult.

Application: esophagus, rectum
N/A

Skin Temperature probe, 400 Series, adult/pediatric.

Application: finger, toe, axillary (armpit) using tape or posey wrap
N/A

Category Description Maximum Lengths
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PDM Battery and Accessories
Heat shields for reusable skin temperature probes N/A

Dual temperature Care cable. Accepts YSI 400 or 700 Series probes N/A

Single temperature Care cable. Accepts YSI 400 Series probes N/A

Single temperature Care cable. Accepts YSI 400 Series disposable probes N/A

400 Series probe interconnect cable for use with disposable temperature 
probes

N/A

400 Series temperature interconnect cable, extension cable for disposable 
temperature probes

N/A

Masimo SpO2 cables and sensors

Finger Sensor, Adult, LNOP-ADT N/A

Finger Sensor, Adult, LNOP DC-195 N/A

Finger Sensor, Adult, LNOP-DCI N/A

Finger Sensor, Pediatric, LNOP-DCIP N/A

Multisite Sensor, Neonatal/Pediatric/Infant, LNOP-YI N/A

Ear Sensor, Adult, LNOP-TC-I N/A

Integrated Finger Sensor with cable, Adult, LNOP DC-12 N/A

Finger Sensor, Adult, LNOP-ADT (Long) N/A

Finger Sensor, Pediatric, LNOP-PDT N/A

Finger Sensor with transparent tape, Adult, LNOP-Adtx N/A

Finger Sensor with transparent tape, Pediatric, LNOPPdtx N/A

Foot/Toe/Thumb Sensor, Neonatal, LNOP-NEO N/A

Foot/Palm SofTouch Sensor, Neonatal Pre-Term, LNOPNeoPt-L N/A

Foot/Palm Sensor, Neonatal/Adult, LNOP-Neo-L N/A

Foot/Palm SofTouch Sensor Neonatal Preterm, NeoPt-L N/A

Thumb/Toe Newborn Sensor, Infant, LNOP Newborn Infant N/A

Foot Newborn Sensor, Neonatal, LNOP Newborn Neonatal N/A

Thumb/Toe Blue Sensor, Neonatal/Infant/Pediatric, LNOP Blue N/A

Finger Sensor, Adult, LNCS DC-I N/A

Finger Sensor, Pediatric, LNCS DC-IP N/A

Ear Sensor, Adult, LNCS TC-I N/A

Finger Sensor, Adult, LNCS-Adtx N/A

Finger Sensor, Pediatric, LNCS-Pdtx N/A

Toe Sensor, Infant, LNCS-Inf N/A

Foot Sensor, Neonatal/Pediatric, LNCS-Neo N/A

Foot Sensor, Neonatal Preterm, LNCS-NeoPt N/A

Category Description Maximum Lengths
E-8 Mac-Lab/CardioLab/Centricity Cardiology INW Service Manual 2063076-010H EN 



PDM Battery and Accessories
Masimo Sensor LNCS Y1 Multisite Reusable N/A

Masimo Sensor LNCS TF-I Reusable Forehead N/A

Masimo Sensor LNOP DC-195 Reusable Finger Sensor N/A

Masimo Sensor LNOPTF-I Reusable Forehead Sensor N/A

Masimo Sensor LNOP NEO-Bridge Neonate Adhesive Sensor N/A

Interconnect Cable for Masimo LNOP N/A

Interconnect Cable for Masimo LNCS, LNC-10 N/A

Nellcor OxiMax SpO2 cables and sensors

Finger Sensor, Adult, DS100A, N/A

Nellcor OxiMax MaxFast Forehead Sensor N/A

Nellcor OxiMax Adhesive Sensor, Nasal N/A

Toe Oxiband Sensor, Pediatric/Infant, OXI-P/I, N/A

Nellcor SoftCare Nonadhesive Sensor, Preterm Infant N/A

Nellcor SoftCare Nonadhesive Sensor, Neonate N/A

Nellcor SoftCare Nonadhesive Sensor, Adult N/A

Nellcor OxiCliq Adhesive Sensor - Adult N/A

Nellcor OxiCliq Adhesive Sensor - Neonatal/Adult N/A

Nellcor OxiCliq Adhesive Sensor - Infant N/A

Nellcor OxiCliq Adhesive Sensor - Pediatric N/A

Interconnect Cable for Nellcor OxiMax N/A

Nellcor OxiMax Adhesive Sensor, Adult Long N/A

Finger Sensor, Adult, DS100A N/A

Finger Oxiband Sensor, Neonatal/Adult, OXI-A/N N/A

Multisite Sensor, Neonatal/Pediatric/Adult, D-YS N/A

Ear-Clip, Pediatric/Adult, D-YSE N/A

Nellcor PediCheck D-YSPD Pediatric Spot Check Sensor N/A

Finger Sensor, Adult, MAX-A N/A

Finger Sensor, Pediatric, MAX-P N/A

Toe Sensor, Infant, MAX-I N/A

Toe/Foot Sensor, Neonatal/Adult, MAX-N N/A

Accessories

Cable Assy Sync DS1 to Unterm 15 4.6 m / 15 ft

Cable Assy Sync DS1 to Physio / Zoll 4.6 m / 15 ft

Cable Assy Sync DS1 to Datascope 95 9.5 m / 31 ft

Category Description Maximum Lengths
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Cable Assy Sync DS1 to Heartstream 5.5 m / 18 ft

Cable Assy Sync DS1 to HP/Philips 5.5 m / 18 ft

Kit Termination Sync DS1 Male Plug N/A

Cable Assy Sync DS1 to Arrow/Kontron 9.2 m / 30 ft

Splitter Sync DS1 Male to 3 DS1 FEM N/A

ePort cable 7.6 m / 25 ft.

Category Description Maximum Lengths
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EU Battery Directive
EU Battery Directive 2006/66/EC

The Mac-Lab/CardioLab product conforms to the EU Battery Directive 2006/66/EC.

The Uninterruptible Power Supply (UPS) supplied with the IEB of the Mac-Lab/CardioLab contains 
lead/acid storage batteries. These batteries are a permanent part of the UPS assembly and are 
not intended to be removed or changed. Attempting to remove or change these batteries may 
result in an unsafe condition.

http://www.gehealthcare.com/euen/weee-recycling/index.html 

http://www.epa.gov/mercury/about.htm

http://www.cdc.gov/niosh/npg/npgd0383.html

http://www.epa.gov/lead/

http://www.cdc.gov/niosh/npg/npgd0368.html

http://www.cdc.gov/niosh/npg/npgd0087.html

http://www.epa.gov/waste/hazard/wastemin/minimize/factshts/cadmium.pdf 

The separate collection symbol is affixed to a battery, or its packaging, to advise you that the 
battery must be recycled or disposed of in accordance with local or country laws. The letters 
below the separate collection symbol indicate whether certain elements (Pb=Lead, 
Cd=Cadmium, Hg=Mercury) are contained in the battery. To minimize potential effects on the 
environment and human health, it is important that all marked batteries that you remove from the 
product are properly recycled or disposed. Information on the potential effects on the 
environment and human health of the substances used in batteries is available at the urls below:
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